Teamcenter 10.1

Change Manager Guide
This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

Siemens and the Siemens logo are registered trademarks of Siemens AG. Teamcenter is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proprietary and restricted rights notice</td>
<td>2</td>
</tr>
<tr>
<td>Before you begin</td>
<td>7</td>
</tr>
<tr>
<td>What is Change Manager?</td>
<td>9</td>
</tr>
<tr>
<td>Change management in Teamcenter</td>
<td>11</td>
</tr>
<tr>
<td>Change Manager state model and CMII</td>
<td>13</td>
</tr>
<tr>
<td><strong>What is a change?</strong></td>
<td>15</td>
</tr>
<tr>
<td>Relationship between change objects</td>
<td>17</td>
</tr>
<tr>
<td>Change object properties</td>
<td>18</td>
</tr>
<tr>
<td><strong>What kind of changes can you create?</strong></td>
<td>25</td>
</tr>
<tr>
<td><strong>What can you do in Change Manager?</strong></td>
<td>27</td>
</tr>
<tr>
<td>Understanding the change management process</td>
<td>29</td>
</tr>
<tr>
<td>Problem report (PR) process example</td>
<td>31</td>
</tr>
<tr>
<td>Enterprise change request (ECR) fast track process example</td>
<td>31</td>
</tr>
<tr>
<td>Enterprise change request (ECR) standard track process example</td>
<td>32</td>
</tr>
<tr>
<td>Enterprise change notice (ECN) process example</td>
<td>34</td>
</tr>
<tr>
<td><strong>What are change states?</strong></td>
<td>37</td>
</tr>
<tr>
<td>Change states values</td>
<td>39</td>
</tr>
<tr>
<td>Example of the state changes of a problem report</td>
<td>40</td>
</tr>
<tr>
<td>Example of the state changes in a fast track enterprise change request (ECR)</td>
<td>41</td>
</tr>
<tr>
<td>Example of the state changes in a standard track enterprise change request (ECR)</td>
<td>43</td>
</tr>
<tr>
<td>Example of the state changes in an enterprise change notice</td>
<td>44</td>
</tr>
<tr>
<td>Change Manager interface</td>
<td>47</td>
</tr>
<tr>
<td>Change Manager tabs</td>
<td>48</td>
</tr>
<tr>
<td>Change Manager menus</td>
<td>48</td>
</tr>
<tr>
<td>Change Manager buttons</td>
<td>49</td>
</tr>
<tr>
<td>Rich client perspectives and views</td>
<td>50</td>
</tr>
<tr>
<td><strong>Identifying changes</strong></td>
<td>1-1</td>
</tr>
<tr>
<td>Ways to identify changes</td>
<td>1-1</td>
</tr>
<tr>
<td>Create a problem report</td>
<td>1-2</td>
</tr>
<tr>
<td>Create an enterprise change request</td>
<td>1-2</td>
</tr>
<tr>
<td>Create a deviation request</td>
<td>1-3</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Create an enterprise change notice</td>
<td>1-4</td>
</tr>
<tr>
<td>Relate change objects to other change objects</td>
<td>1-5</td>
</tr>
<tr>
<td><strong>Searching for change objects</strong></td>
<td>2-1</td>
</tr>
<tr>
<td>Types of searches</td>
<td>2-1</td>
</tr>
<tr>
<td>Create a search in Change Manager</td>
<td>2-1</td>
</tr>
<tr>
<td>Run a search</td>
<td>2-2</td>
</tr>
<tr>
<td>Display searches in the Change Home view</td>
<td>2-2</td>
</tr>
<tr>
<td>Delete a search</td>
<td>2-2</td>
</tr>
<tr>
<td><strong>Reviewing changes</strong></td>
<td>3-1</td>
</tr>
<tr>
<td>About reviewing a change</td>
<td>3-1</td>
</tr>
<tr>
<td>Review a change</td>
<td>3-1</td>
</tr>
<tr>
<td><strong>Developing and implementing changes</strong></td>
<td>4-1</td>
</tr>
<tr>
<td>Managing items related to a change object</td>
<td>4-1</td>
</tr>
<tr>
<td>Update a change</td>
<td>4-9</td>
</tr>
<tr>
<td>Create a BOM change</td>
<td>4-10</td>
</tr>
<tr>
<td>Managing unincorporated changes</td>
<td>4-12</td>
</tr>
<tr>
<td>Replacing part instances using Mass Update</td>
<td>4-30</td>
</tr>
<tr>
<td><strong>Scheduling implementation activities</strong></td>
<td>5-1</td>
</tr>
<tr>
<td>About scheduling implementation activities</td>
<td>5-1</td>
</tr>
<tr>
<td>Example of a schedule work breakdown</td>
<td>5-3</td>
</tr>
<tr>
<td>Work Breakdown Schedule Manager view</td>
<td>5-4</td>
</tr>
<tr>
<td>Create a work breakdown using Schedule Manager</td>
<td>5-6</td>
</tr>
<tr>
<td>Roll up objects associated with a change object</td>
<td>5-7</td>
</tr>
<tr>
<td>Display a schedule work breakdown</td>
<td>5-8</td>
</tr>
<tr>
<td>Managing change items associated with a schedule task</td>
<td>5-9</td>
</tr>
<tr>
<td><strong>Managing a change</strong></td>
<td>6-1</td>
</tr>
<tr>
<td>About managing a change</td>
<td>6-1</td>
</tr>
<tr>
<td>Initiate a workflow process</td>
<td>6-1</td>
</tr>
<tr>
<td>View the status of a workflow in Change Manager</td>
<td>6-3</td>
</tr>
<tr>
<td>View workflow assignments and their status</td>
<td>6-4</td>
</tr>
<tr>
<td>About classifying changes</td>
<td>6-5</td>
</tr>
<tr>
<td>Managing the participants of a change</td>
<td>6-6</td>
</tr>
<tr>
<td>About setting change states</td>
<td>6-12</td>
</tr>
<tr>
<td>About setting change effectivities</td>
<td>6-12</td>
</tr>
<tr>
<td><strong>Administering the change management process</strong></td>
<td>7-1</td>
</tr>
<tr>
<td>About administering the change management process</td>
<td>7-1</td>
</tr>
<tr>
<td>Migrating to Change Manager</td>
<td>7-1</td>
</tr>
<tr>
<td>Setting Change Manager preferences</td>
<td>7-2</td>
</tr>
<tr>
<td>Setting up users</td>
<td>7-2</td>
</tr>
<tr>
<td>Defining custom change management objects</td>
<td>7-5</td>
</tr>
<tr>
<td>Configuring conditions to control the actions of participants</td>
<td>7-6</td>
</tr>
<tr>
<td>Managing the change process through a workflow</td>
<td>7-13</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td>A-1</td>
</tr>
</tbody>
</table>
Before you begin

Prerequisites
You need a license level that enables authoring for all Change Manager functionality. If you do not have a higher level license, you are limited to the following functionality:

- Creating a problem report (PR).
- Checking in a PR and submitting it to a workflow process.
- Adding business objects to the PR Problem Items and Reference Items folders.
- Searching for and viewing change objects: PRs, enterprise change requests (ECRs), enterprise change notices (ECNs) and deviation requests (DRs).
- Receiving and acting on workflow assignments and tasks.

Schedule Manager must be available and licensed to use the work breakdown structure functionality. You also need the Workflow to Scheduling Integration installed and configured to initiate workflows from a schedule.

For more information, see the Schedule Manager Guide.

Workflow Designer must be available to process a change. You update the status (such as moving the Disposition attribute from Investigate to Approve) in a workflow process.

Note The Teamcenter change management process does not support displaying substitutes on separate BOM lines in Structure Manager. Turn off the substitutes display (set PSEShowSubstitutesPref to 0) when working with change-management related features.

Enable Change Manager

During installation:

- Select Change Management in the Select Features panel under Extensions→Enterprise Knowledge Foundation in Teamcenter Environment Manager.

- Select Change and Schedule Management Interface under Extensions→Enterprise Knowledge Foundation (Optional – If you want to view a parent change from a schedule task.)
Before you begin

If Change Manager does not appear in the rich client, edit the **HiddenPerspectives** preference and remove the **ChangeManager** value.

If you have trouble accessing Change Manager, see your system administrator; it may be a licensing issue.

**Note** You can log on to Teamcenter only once. If you try to log on to more than one workstation at a time, you see an error message.

**Configure Change Manager**

The following basic configurations are required to use Change Manager:

- To customize Change Manager business rules and objects, install the Change Management Business Modeler IDE templates (during installation, select **Change Management** in the **Business Modeler IDE Templates** panel in Teamcenter Environment Manager).

- If desired, enable the Change Manager menu commands in the thin client by setting the **WEB_Enable_Create_Change** preference to **true**.

- Set Change Manager preferences as explained in the **Preferences and Environment Variables Reference**.

- Define your users, including groups, roles, and access rules.

- Create your own workflow processes.

For more information about configuring Change Manager, see **About administering the change management process**.

**Start Change Manager**

In the navigation pane, click **Change Manager**.

---

8 Change Manager Guide
What is Change Manager?

Change Manager helps you track changes to a product throughout its life cycle. You propose a change to a product and then manage the entire cycle of review, approval, and implementation of the change. It enables your organization to ensure the quality of every change made to a product by providing mechanisms for problem identification, change authorization, coordination and planning, cost and benefit analysis, and record keeping. You can articulate the work required to:

- Implement a change.
- Assess its impact on any managed business items, such as parts or documents.
- Notify lifecycle participants about proposed and authorized changes.
- Track progress and completion of work.
- Compare before and after product configurations.

The following illustrates the key elements of Change Manager, and how these elements relate to major steps of the change process:

The three change object types shown in the figure implement the key elements of Change Manager: the problem report (PR), the enterprise change request (ECR), and the enterprise change notice (ECN). Each of these objects are Item types in the business model, and, therefore, are revisionable objects. Each object type encapsulates the data for a phase of the change process. For example, a PR contains the data that defines the problem, the ECR contains the analysis of the impact of the problem, and the ECN contains the data for the implementation of the solution. Implemented By and Implements relationships associate the change objects with each other. Each object type can be optionally associated with a
What is Change Manager?

workflow that defines the sequence of tasks and moves each object through a set of states to bring the problem to a resolution.

Anyone who uses Teamcenter can create a PR to identify and formally track an issue with your product information. Others who are involved in the change process can review and confirm the problem and provide input into what business objects must be updated to resolve the issue. Members of a change review or change implementation board can review and approve or disapprove the changes.

Change Manager can be easily configured to use your change process.

- Use Change Manager with Workflow Designer to track the evolution of changes through your organization according to a controlled, repeatable process. Workflow Viewer is accessible directly from within Change Manager.

  For more information about using workflow with Change Manager, see *About managing the change process through a workflow*.

  For more information about defining processes, see the *Workflow Designer Guide*.

- Use Change Manager with Schedule Manager to create work breakdown structures that you can use to plan and schedule the changes you are making to your product.

  For more information about work breakdown tasks, see *About scheduling implementation activities*.

  You will also need the *Workflow to Scheduling Integration* option installed and configured.

  For more information, see the *Schedule Manager Guide*.

For more information about migrating from Change Viewer to Change Manager, see *Migrating to Change Manager*.
**Change management in Teamcenter**

Teamcenter provides functionality that enables you to initiate, administer, review, approve, and execute product changes. By automating your change process, you can minimize change-related rework and coordinate tasks to be performed by individuals across your organization. Because Teamcenter change management leverages product structure definitions, you can evaluate the impact of changes, track the status and completion of tasks, and maintain a comprehensive history of product changes throughout the lifecycle. Change management in Teamcenter is also tightly integrated with Schedule Manager and Workflow so you can schedule implementation activities and guide a change through its phases.

In addition, if you have changes or issues that do not need to be addressed through an extensive, standardized change management process, such as the one that Change Manager supports, or you have highly visual information, you can use Issue Manager. Issue Manager automatically provides access to Siemens PLM Software design review and issue resolution tools, including NX, Lifecycle Visualization, and the Lifecycle Viewer.

You can use Issue Manager in both the rich client and the thin client. Use both clients to create, review, and manage issues, but use the rich client to administer your issue management process.

For more information about Issue Manager, see the *Issue Manager Guide*. 
Change Manager state model and CMII

Change Manager provides a change management foundation as well as a preconfigured change management state model that enforces default business rules. It is a formal change process that lets you manage a consistent, controlled closed-loop process to continuously improve your products.

The preconfigured model in Change Manager is based on the industry-independent best practices of the CMII closed-loop change model.

- CMII is the root of many Change Manager features, including the fast track classification, change states, participants, and overall work processes.

- To enable greater flexibility to meet diverse customer needs, Change Manager does not fully conform to CMII nor is it CMII certified.

For more information about CMII and to view a picture of the model, see:

http://www.icmhq.com

For more information about the initial configuration of Change Manager, see *What are change states?*. 
What is a change?

Change objects capture the necessary change information either as part of their properties or through establishing relations with other objects as shown.

- **Participants**
  The users involved with identifying, managing, and resolving the change. Participants can be assigned at the start of the change or they can be assigned throughout the change process, depending on the requirements of your company. The participants can also be automatically assigned to workflow tasks. Participants are modeled as separate objects and are not properties of the change object. Participants can be a single user or a group, such as a board.

Here is an example of participants who are assigned.

For more information about participants, see *About the participants in the change process*.

- **Change states**
What is a change?

Change states define the degree of completion and the latest business decision regarding a specific change. They are set during workflow, and used to control the change. The states, while set on an individual change object, apply to the overall change process. For example, the Executing change state references the change notice (ECN) when changes are being made using the solution items.

Here is an example of the change states. The bold text shows the defaults.

For more information about change states, see What are change states?

- Related items, changes, and schedules

During the change process, you elaborate a change object by relating other objects to it. For example, you may need to add reference documents to a PR or specify which item revisions are impacted by the change. When you implement a change, new item revisions must be related as solution items. You can also relate schedules to change requests (ECRs) for planning the solution or to change notices (ECNs) for implementing the solution.

Change Manager shows these related items in change folders that it automatically creates for you. The change folders, for example, Impacted Items, Solutions Items, and Plan Items, define the type of relation the item has to the change object. Business rules (modeled as Business Modeler IDE conditions) control the data that can be related under the different folders, by participant type, and what change state.

Here is an example of the folders of the change objects and the types of change objects they are related to:

For more information about the types of change objects, see What kind of changes can you create?

For more information about relating items to change folders, see Relating items to a change and the properties required.
Relationship between change objects

During the change process, Change Manager allows other business objects (such as items, schedules, assemblies) to be related to change objects (PRs, ECRs, or ECNs) or change objects to be related to each other through relationships. Relationships are represented graphically as folders, often referred to as pseudo-folders. The folders help you keep track of all business objects related to the change.

The following figure illustrates the relationship between these objects in the preconfigured Change Manager model.

Each change object shows these relationships in the **Implements** and **Implemented By** folders.
What is a change?

Issues identified in one or more PRs can be implemented by a single ECR. Similarly, issues identified in one or more ECRs can be implemented by a single ECN. Likewise, a single ECR can be split and implemented by two or more ECNs, as shown. Using Change Manager, you can create very complex structures of changes to satisfy specific change requirements, providing you with the flexibility you need.

Change object properties

Change object properties store change data during the change process. A user either enters the data or Change Manager automatically creates it during the change process. The values of some of these properties are used to drive workflow decisions, while others are provided for user reference or instruction. Here, we see a subset of the change properties available on different types of change objects. Some properties, such as the State, are common to all change objects.

The following lists the default properties for a change object. To view properties, use the Viewer tab.

Properties common to all change objects

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Provides the change object identification number.</td>
</tr>
<tr>
<td>Name</td>
<td>Provides a name for the change object.</td>
</tr>
<tr>
<td>Synopsis</td>
<td>Provides a name for the change.</td>
</tr>
</tbody>
</table>
### What is a change?

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Provides a description of the problem.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the change. Can only be changed through a workflow process.</td>
</tr>
<tr>
<td></td>
<td>• Closure</td>
</tr>
<tr>
<td></td>
<td>• Maturity</td>
</tr>
<tr>
<td></td>
<td>• Disposition</td>
</tr>
</tbody>
</table>

| Participants        | Lists those involved in the change management process.                                               |
|                     | **Note** These are not properties, but relations to participant objects.                             |
|                     | • Requestor                                                                                         |
|                     | • Analyst                                                                                           |
|                     | • Change Specialist 1                                                                               |
|                     | • Change Review Board (ECR only)                                                                     |
|                     | • Change Implementation Board (ECN only)                                                            |

### Properties of problem reports

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment Description</td>
<td>Describes the environment as it was when the problem occurred. For example, if the car door was open and the car was moving in reverse.</td>
<td>CMEnvironment Description</td>
<td>None</td>
</tr>
<tr>
<td>Sequence of events</td>
<td>Describes what happened before the problem occurred. Provides a guide for reproducing the problem.</td>
<td>CMSSequence OfEvents</td>
<td>None</td>
</tr>
</tbody>
</table>

---

PLM00140 G

*Change Manager Guide* 19
What is a change?

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical review priority</td>
<td>Guides the analyst to the problems to address first. The values, based on CMII, are 1 to 4, with 1 being the highest priority. Your administrator may have replaced this list of values (LOV) with your company’s own.</td>
<td>CMTechReviewPriority</td>
<td>CM Tech Rev Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>Verification</td>
<td>Describes how the problem was verified. For example, it was reproduced.</td>
<td>CMVerification</td>
<td>None</td>
</tr>
<tr>
<td>Ramification</td>
<td>Describes what will or might happen if the problem is not resolved. For example, increased incidence of customer injury.</td>
<td>CMRamification</td>
<td>None</td>
</tr>
<tr>
<td>Severity rating</td>
<td>Indicates the severity of the problem. For example, customer injury rates a 1 (high) while a user manual typographical error rates a 4 (low). The values, based on CMII, are 1 through 4, with 1 being highest severity. Your administrator can replace this list of values (LOV) with your company’s own.</td>
<td>CMSSeverityRating</td>
<td>CM Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
</tbody>
</table>
Properties of enterprise change requests

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>Provides a short description of the reason for the change. The values are based on CMII. Your administrator can replace them with different types of changes (for example, safety or performance) that your company processes on a regular basis.</td>
<td>CMReason</td>
<td>CM CR Reason</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To Fix</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To Prevent</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To Improve</td>
</tr>
<tr>
<td>Proposed solution</td>
<td>Describes the recommended technical solution in enough detail to enable a cost-benefit decision. The analyst enters this information. For standard track changes, a simple description in this text box is not enough, so the analyst may attach other documents (for example, BOM markups, a preliminary implementation plan (schedule), or any other item needed to describe the proposed solution). In this case, those items should be briefly described here. This property is part of the technical recommendation.</td>
<td>CMPProposed Solution</td>
<td>None</td>
</tr>
</tbody>
</table>
# What is a change?

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is fast track?</td>
<td>Indicates if the ECR should be processed as a fast track change. For more information about this property, see <em>Understanding the change management process</em>.</td>
<td>CMIsFastTrack</td>
<td>CMII CR Fast Track • Yes • No</td>
</tr>
<tr>
<td>Technical review priority</td>
<td>Guides the change review board and the technical review board (if involved) to the problems to be addressed first. The priorities can be copied from the PR, or the change specialist can set the value. The LOV values are based on CMII.</td>
<td>CMTechReviewPriority</td>
<td>CM Priority • 1 • 2 • 3 • 4</td>
</tr>
<tr>
<td>Recurring cost</td>
<td>Provides an estimate of the incremental costs of the changed product.</td>
<td>CMRecurringCost</td>
<td>None</td>
</tr>
<tr>
<td>Nonrecurring cost</td>
<td>Provides an estimate of the total costs to implement the change.</td>
<td>CMNonrecurringCost</td>
<td>None</td>
</tr>
<tr>
<td>Technical recommendation</td>
<td>Forms part of the technical recommendation, along with the CMTechResults Attached, CMTechReview, and CMProposed Solution properties.</td>
<td>CMTechnicalRecommendation</td>
<td>CM Tech Recommendation • Problem Confirmed • Problem Not Confirmed • Another Problem</td>
</tr>
</tbody>
</table>
### What is a change?

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test results attached?</td>
<td>Answers the question of whether the analyst has attached documentation of the test results. This property is part of the technical recommendation.</td>
<td>CMTTestResultsAttached</td>
<td>CM YesNo</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• No</td>
</tr>
<tr>
<td>Technical recommendation date</td>
<td>Specifies the date of the recommendation.</td>
<td>CMTechRecommDate</td>
<td>None</td>
</tr>
<tr>
<td>Timing factors</td>
<td>Provides an opinion or guidance from the change review board or analyst to the change implementation board about setting the effectivity and the implementation timing.</td>
<td>CMTimingFactors</td>
<td>None</td>
</tr>
</tbody>
</table>

### Properties of enterprise change notices

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation priority</td>
<td>Guides the analyst about the relative priority of implementing the change.</td>
<td>CMImplPriority</td>
<td>CM Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• 4</td>
</tr>
</tbody>
</table>
### What is a change?

<table>
<thead>
<tr>
<th>The property</th>
<th>Does the following</th>
<th>Property name</th>
<th>LOV name and values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special instruction</td>
<td>Captures any special instructions the change Implementation board has for the analyst and the change implementation team itself.</td>
<td>CMSpecial Instruction</td>
<td>None</td>
</tr>
<tr>
<td>Is customer approval required?</td>
<td>Indicates if one or more customers must approve the change.</td>
<td>CMSpecial Instruction</td>
<td>None</td>
</tr>
<tr>
<td>Status of customer approval</td>
<td>Indicates whether or not the customers approved or disapproved the change.</td>
<td>CMStatusOf CustApproval</td>
<td>CM CN Approval</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Disapproved</td>
</tr>
<tr>
<td>Date of customer approval</td>
<td>Indicates the date of the customers' approval or disapproval.</td>
<td>CMDateOf CustApproval</td>
<td>None</td>
</tr>
</tbody>
</table>
What kind of changes can you create?

The change management solution is supported using the following change objects:

<table>
<thead>
<tr>
<th>Change object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem report (PR)</td>
<td>Initiates a change. A PR captures information about a problem or an enhancement. It includes the information necessary to confirm and reproduce any problems observed or to document the specifics of a request for an enhancement. Additional attributes document the perceived severity of the problem and set the priority for addressing the issue relative to other PRs. The processing of a PR sometimes leads to the creation of an enterprise change request (ECR). Creating a PR is an optional step in the change process. Depending on the conventions at your site, you may first identify a problem or enhancement with an ECR, not a PR. A PR may be addressed by one or more ECRs.</td>
</tr>
<tr>
<td>Enterprise change request (ECR)</td>
<td>Initiates a proposal that recommends a change and captures business decisions associated with the change. An ECR proposes a solution to the problem with cost estimates and benefits of making the change. The actual solution (for example, a new item revision) is implemented in the change notice (ECN). An ECR is typically a response to a PR unless the PR stage is skipped. A single ECR may logically group and address issues identified in multiple PRs. An ECR may be addressed by one or more ECNs.</td>
</tr>
</tbody>
</table>
**What kind of changes can you create?**

<table>
<thead>
<tr>
<th>Change object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise change notice (ECN)</td>
<td>Implements a change. It provides a detailed work plan to resolve one or more ECRs or a portion of one ECR. An ECN identifies all items and documents affected by a change and authorizes the actions that address a change.</td>
</tr>
<tr>
<td>Deviation request</td>
<td>Seeks consent to deviate from a solution in production to resolve a set of problems to initiate improvements. Typically, there are two types of deviation requests:</td>
</tr>
</tbody>
</table>
|                                | • Request for deviation  
  Seeks consent to deviate from a part solution.  |
|                                | • Request for waiver  
  Seeks consent to accept a non-conforming part.  |

For more information about the relationship between the change objects, see *Relationship between change objects*. 
What can you do in Change Manager?

Identify a problem

If you are requesting a change or reviewing a recommended solution or plan as a member of change review board:

- **Create a problem report** to identify a problem or enhancement, provide a preliminary assessment, and show the steps necessary to reproduce the problem.

- **Create an enterprise change request (ECR)** to address the problem report.

- **Create a new enterprise change notice (ECN)** to address the approved change request or associate the change request with an existing change notice.

Review a solution

- **Review ECRs and ECNs** and make a business decision to approve or reject.

Manage the change process

If you are the change specialist managing the implementation of the change:

- **Initiate a workflow** to guide a change through the phases of a change process.

- **Assign participants** as the analyst and reviewers.

- **Assign effectivity** to specify when an ECN takes effect.

- Close ECRs and ECNs.

Develop or implement a solution

If you are the analyst determining how to implement a solution or if you are implementing the solution:

- **Define change properties**.

- **Relate problem and reference items**.

- **Create a work breakdown** using Schedule Manager.

- Implement the change by creating and revising affected items.
What can you do in Change Manager?

**Administer the change management process**

If you are administering Change Manager, you can

- Install and set up Change Manager.
- Set Change Manager options.
- Set up users and the organization and roles.
- Define custom change management objects.
- Control the actions of participants through conditions.
- Create workflows.
Understanding the change management process

You can manage your changes in the way that works best for your company’s processes. You should define a change process that is flexible enough to impose the appropriate level of rigor and control based on the level of risk, cost, and the business items impacted by the change. You can classify a change as fast track or standard track. In a fast track process, the change does not go through a formal review process, while a standard track follows a more rigorous process, and may include a schedule to manage the required tasks. The following example shows a typical standard track process.

Note: Workflow processes must be created to support change management. Siemens PLM Software does not provide change workflows—you must create your own.

For more information about creating workflows, see About managing the change process through a workflow.

1. Author a problem report (PR).

   A requestor creates a problem report to identify a problem or enhancement, provide a preliminary assessment, and show the steps necessary to reproduce the problem.

2. Approve a problem report.
Understanding the change management process

A change specialist assigns a priority to the problem report and assigns it to an analyst for technical review. The specialist or analyst recommends a disposition, such as Approved.

3. Create an enterprise change request (ECR).

A requestor (who may be the analyst associated with the problem report) creates an ECR to address the problem report.

At this stage, the analyst develops a solution or several alternative solutions. The analyst does this by creating markups on documents, Word documents, presentations, and so on. No decision has been made at this stage about whether to proceed or what new items or item revisions may be required.

Sometimes the PR may propose a solution if the problem is simple to fix. However, the solution would still be formally documented in the ECR. Typically, though, the requestor is unlikely to be in a position to know what the solution should be and may likely have no idea at all.

**Note** The change request can address more than one PR.

4. Evaluate the impacts.

The change specialist assigns the ECR to an analyst. The analyst identifies the items impacted by the change, prepares supporting documentation, and prepares a high-level proposal for the actions required to implement the change.

5. Make a business decision.

A change specialist submits the ECR to a change review board who decides if the change will be made. The change review board can approve the change request, reject it, or require additional investigation. If this is a fast track change, the review board is the owner of the change and the process moves to the execute change step.

At this stage, a decision is made about whether to revise or create new items, according to the form, fit and function and interoperability.

6. Derive an enterprise change notice (ECN).

The requestor (who may be the analyst of the ECR) either derives a new change notice to address the approved change request or associates the ECR with an existing ECN. The ECN addresses the implementation details of the change. It may address multiple change requests. The requestor can delegate responsibility for elaborating the details of the implementation plan.

**Note** An ECN is always derived to implement a solution, even for an ECN that went through a fast track process. However, the workflow for the fast track ECN is very short, with a minimal number of steps. It is necessary to create an ECN so the analyst can add solution items, which is not possible in the ECR, whose purpose is only to define a proposed solution.

7. Prepare an implementation plan.

The analyst develops a detailed plan to address the set of approved ECRs addressed by the ECN.

At this stage the agreed solution is implemented in the new/revised items.
8. Approve the ECN.
   For a standard track process, the change implementation board reviews and
   approves the plan to address the change. For a fast track process, the approval is
   informal and may just require the change specialist managing the change.

9. Assign an effectivity.
   A change specialist can assign effectivities to the ECN. The effectivities specify
   the timing of when the change takes effect.

10. Execute the change.
    The analyst implements and tracks the detailed plan for addressing the change.
    A change specialist tracks the implementation progress at a high level.

11. Close the change.
    The analyst closes the associated levels of the implementation plan. When all
    the actions associated with each level of the implementation plan are complete, a
    change specialist closes the change.

**Problem report (PR) process example**

The following example shows a simple process for managing a PR. For an example
of a Teamcenter workflow that supports a PR process, see *Problem report workflow
example*.

After you create a PR, assign a specialist, and submit it to a workflow, you:

- **Validate the Problem Report**
  The assigned specialist reviews the PR properties.

- **Assign Analyst**
  The assigned specialist assigns an analyst.

- **Analyze PR / Approve/Reject**
  The assigned analyst reviews the PR and approves or rejects the problem.

**Enterprise change request (ECR) fast track process example**

The following fast track example shows a process for managing an ECR through
fast track.

For an example of a Teamcenter workflow that supports an ECR process for both fast
and standard tracks, see *Enterprise change request workflow example*. 
Understanding the change management process

After you create an ECR, assign a specialist and submit it to a workflow, you:

- **Classify/Assign Analyst**
  
The assigned specialist classifies the ECR as fast track, determines if more planning is required, and assigns an analyst.

  **Note** Change Manager conditions control who can assign the analyst. The default condition allows the current change analyst to assign a new analyst or allows the change specialist to assign an analyst.

- **Complete Planning**
  
  At this stage, the analyst develops a solution or several alternative solutions. The analyst does this by creating markups on documents, Word documents, presentations, and so on. No decision has been made at this stage about whether to proceed or what new items or item revisions may be required.

  If more planning is required, the assigned analyst completes it. The ECR returns to the specialist to determine if planning is complete.

- **Derive Change**
  
  The assigned change specialist derives an ECN to implement the solution.

- **ECN Process**
  
  The assigned specialist begins a fast track ECN process so the change can be executed, and the solution items added.

**Enterprise change request (ECR) standard track process example**

The following standard track example shows a process for managing an ECR through standard track.

For an example of a Teamcenter workflow that supports an ECR process for both fast and standard tracks, see *Enterprise change request workflow example.*
After you create an ECR, assign a specialist, and submit it to a workflow, you:

- **Classify/Assign Analyst**
  
The assigned specialist classifies the ECR as standard track, determines if more planning is required, and assigns an analyst.

- **Complete Planning**
  
  At this stage, the analyst develops a solution or several alternative solutions.
  
The analyst does this by creating markups on documents, Word documents, presentations, and so on. No decision has been made at this stage about whether to proceed or what new Items or item revisions are required.
  
  If more planning is required, the assigned analyst completes it. The ECR returns to the specialist to determine if planning is complete.

- **CRB Review**
  
  If the planning is complete, the assigned change review board reviews the change and signs off as approved or rejected with comments.

- **Record Business Decision**
  
  The assigned specialist reviews CRB signoffs and comments and records the business decision.
• **Disposition**
  If approval criteria are met, the ECR is approved. The ECN process is executed.
  If the ECR is deferred, it is placed on hold.
  If the ECR is rejected, it is closed.
  If the ECR is not ready, it is sent for rework and returns to the CRB review step.

**Enterprise change notice (ECN) process example**

The following example shows a process for managing an ECN for implementing an ECR that goes through the standard track process.

You can also develop an ECN process for an ECR that goes through a *fast track* process. That ECN would not include a formal review by the change implementation board. It would also be implemented by the same analyst assigned to the ECR.

For an example of a Teamcenter workflow that supports an ECN process for a fast track ECR, see *Enterprise change notice fast track workflow example*.

After you create an ECN, assign a specialist, and submit it to a workflow, you:

• **Classify/Assign Analyst**
  The assigned specialist determines if more planning is required and assigns an analyst.
  The analyst develops a solution or several alternative solutions. The analyst does this by creating markups on documents, Word documents, presentations, and so on.
  No decision has been made at this stage about whether to proceed or what new items or item revisions may be required.

• **Complete Planning**
  If more planning is required, the assigned analyst completes the planning. The ECN returns to the specialist to determine if planning is complete.

• **Change Implementation Board Review**
If the planning is complete, the assigned change implementation board reviews the change and signs off as approved or rejected with comments.

- **Record Implementation Decision**
  The assigned specialist reviews change implementation board signoffs and comments and records the implementation decision.

- **Disposition**
  If approval criteria are met, the ECN is approved.
  If the ECN is deferred, it is placed on hold.
  If the ECN is rejected, it is closed.
  If the ECN is not ready, it is sent for rework and returns to the CIB review step.

  [Note] The Disposition state applies to all change objects.

- **Execute Change**
  If the ECN is approved, the assigned resources (for example, designers) implement the change according to the plan. They edit the models according to the engineer's directions as documented in the ECR. The design changes are approved as part of the process.

- **Close Change**
  The assigned specialist reviews the changes. If all tasks are complete, the ECN is closed.
What are change states?

Change states encapsulate the following:

- The degree of completion or its maturity (for example, **Elaborating** or **Reviewing**)
- The business decision during change processing or its disposition

Three change object properties define these states: **Maturity**, **Disposition**, and **Closure**.

Using the default Change Manager configuration and an appropriate set of workflows, the change state model behaves according to the model shown in the following figure. In this model, any new change object (PR, ECR, or ECN) is assigned the following:

- A **Closure** state of **Open**
- A **Maturity** state of **Elaborating**
- A **Disposition** state of **None**

**Maturity** is a substate of the **Closure** state **Open**, and **Disposition** is as a substate of the **Maturity** state **Reviewing**.
What are change states?

A change object with a **Closure** state of **Open** moves through various maturity and disposition states during which decisions about the change are made. The **Closure** state remains **Open** until the change object has progressed through all phases of the change process, at which point the closure state is set to its final state of **Closed**. During this process, the change object can also be temporarily placed in one of the intermediate closure states of **Hold** or **Cancelled**. Each object has its own change states, so each change object associated with a change must be closed individually by the change process.

At each stage of the change process, the **EPM-set-property** workflow handler changes the values of these three properties according to business rules to advance the change object to its next state.

You can configure Teamcenter using the Business Modeler IDE to have your own set of states, add additional ones, and have different values for the states. For example, you can have 10 values for the **Closure** state and you can change the name of the **Disposition** state to **Decision**. You can choose to follow the initial Teamcenter model or design your own. If you choose to follow the initial Teamcenter model, Change Manager provides the necessary elements for you to build upon.
Change states values

There are three key change states for change objects in the Change Manager initial configuration. Each type of change object (PR, ECR, ECN) has its own change states and must be closed individually through the process.

**Note** Although these states are defined on each object (PR, ECR, and ECN), the values apply to the overall change process. Therefore, the *Closure* state would not be set to *Closed* until the change has been completed, at which stage the closure and other states needs to be set on the PR and ECR, as appropriate.

- **Closure** defines the status of the change object. Change objects start with an open state and remain there until the change is complete unless a decision is made to defer or cancel the change. The *Closure* change state can be one of the following:
  o *Open* (default value on newly created change objects)
  o *Closed*
  o *On hold*
  o *Cancelled*

- **Maturity** defines the degree of completion of the overall change process.

  The elaborating state is the investigation phase. The reviewing state can be informal where one user approves the change or formal where a review board must approve. Reviewers can decide the change is not ready and send it back to the planning phase or approve the change. Once approved, the change moves to the executing state and the actual changes begin with the creation of new items and item revisions. Finally, when all the necessary data has been created and approved, the change is considered complete.

  The *Maturity* change state can be one of the following:
  o *Elaborating* (default value on newly created change objects)
  o *Reviewing*
  o *Executing*
  o *Complete*
What are change states?

- **Disposition** represents a technical, business, or implementation decision by a person or review board about a change object’s approval.

When a change object is created, the Disposition value is set to **None** (no disposition), which is the default. During review, the value should be set to **Investigate** and once a decision has been made, the value set to **Approved**, **Disapproved**, or possibly **Deferred**.

The Disposition change state can be one of the following:

- None (default value on newly created change objects)
- Investigate
- Approved
- Disapproved
- Deferred

**Note**

- The **EPM-set-property** workflow handler is used to change the state property values.

- Change state settings affect the user’s ability to add data to change objects (for example, to the **Impacted** and **Solution Items** folders).

For more information about actions allowed with change state settings, see *Relating items to a change and the properties required*.

Example of the state changes of a problem report

The following example shows how the default state properties change as the problem report progresses through the steps in the workflow. The change states in your organization may vary.

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
</tr>
<tr>
<td>Validate the Problem Report</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
</tr>
<tr>
<td>Assign Analyst</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
</tr>
<tr>
<td>Analyze PR</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
</tr>
<tr>
<td>Approve/Reject</td>
<td>Open</td>
<td>Reviewing</td>
<td>None</td>
</tr>
</tbody>
</table>
**What are change states?**

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
</tr>
</thead>
<tbody>
<tr>
<td>End</td>
<td>Open</td>
<td>Reviewing</td>
<td>One of these:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Approved</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Disapproved</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Deferred</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Investigate</td>
</tr>
</tbody>
</table>

The state property settings restrict permissions to add items to the problem report's folders. For example, the closure, maturity, and disposition property settings must be **Open, Elaborating, and None** for a Requestor to add an item revision to the problem report's **Problem Items** folder.

**Note**  The **EPM-set-property** workflow handler is used to change the state properties. State property values cannot be set by users.

**Example of the state changes in a fast track enterprise change request (ECR)**

The following example shows how the state properties change as the ECR progresses through the steps in the workflow. The change states in your organization may vary.

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Classify/Assign Analyst</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Complete Planning</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Execute Change</td>
<td>Open</td>
<td>Executing</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td>Close Change</td>
<td>Open</td>
<td>Executing</td>
<td>Approved</td>
<td>Pending</td>
</tr>
</tbody>
</table>
What are change states?

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>End</td>
<td>One of these:</td>
<td>One of these:</td>
<td>One of these:</td>
<td>Released</td>
</tr>
<tr>
<td></td>
<td>• Closed</td>
<td>• Complete</td>
<td>• Approved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
<td>• Elaborating</td>
<td>• Disapproved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On hold</td>
<td>• Executing</td>
<td>• Deferred</td>
<td></td>
</tr>
</tbody>
</table>
The state property settings restrict permissions to add items to the enterprise change request’s folders. For example, the closure, maturity, and disposition property settings must be **Open, Executing, and Approved** for an **Analyst** to add an item revision to the change request’s **Solution Items** folder.

**Note** The EPM-set-property workflow handler is used to change the state properties. State property values cannot be set by users.

## Example of the state changes in a standard track enterprise change request (ECR)

The following example shows how the state properties change as the ECR progresses through the workflow steps. The change states in your organization may vary.

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Classify/Assign</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Analyst</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete Planning</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>CRB review</td>
<td>Open</td>
<td>Reviewing</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Record Business</td>
<td>Open</td>
<td>Reviewing</td>
<td>One of these:</td>
<td>Pending</td>
</tr>
<tr>
<td>Decision</td>
<td></td>
<td></td>
<td>• Approved</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Disapproved</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Deferred</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Investigate</td>
<td></td>
</tr>
<tr>
<td>Rework</td>
<td>Open</td>
<td>Elaborating</td>
<td>Investigate</td>
<td>Pending</td>
</tr>
</tbody>
</table>

*PLM00140 G  Change Manager Guide  43*
What are change states?

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>End</td>
<td>One of these:</td>
<td>One of these:</td>
<td>One of these:</td>
<td>Pending</td>
</tr>
<tr>
<td></td>
<td>• Open</td>
<td>• Reviewing</td>
<td>• Approved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
<td>• Elaborating</td>
<td>• Disapproved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On hold</td>
<td>• Executing</td>
<td>• Deferred</td>
<td></td>
</tr>
</tbody>
</table>

The state property settings restrict permissions to add items to the enterprise change request’s folders. For example, the closure, maturity, and disposition property settings must be Open, Elaborating, and None for a Requestor to add a problem report to a change request. The PR state settings have restrictions as well (Open, Reviewing, Approved).

**Note** The EPM-set-property workflow handler is used to change the state properties. State property values cannot be set by users.

Example of the state changes in an enterprise change notice

The following is an example of how state properties change as the enterprise change notice progresses through the steps in the workflow. The change states in your organization may vary.

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Classify/Assign</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Analyst</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td>Open</td>
<td>Elaborating</td>
<td>None</td>
<td>Pending</td>
</tr>
<tr>
<td>Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIB Review</td>
<td>Open</td>
<td>Reviewing</td>
<td>None</td>
<td>Pending</td>
</tr>
</tbody>
</table>

The diagram illustrates the workflow steps and state transitions.
### What are change states?

<table>
<thead>
<tr>
<th>Step</th>
<th>Closure</th>
<th>Maturity</th>
<th>Disposition</th>
<th>Release state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Implementation</td>
<td>Open</td>
<td>Reviewing</td>
<td>One of these:</td>
<td>Pending</td>
</tr>
<tr>
<td>Decision</td>
<td></td>
<td></td>
<td>• Approved</td>
<td></td>
</tr>
<tr>
<td>Set Effectivity</td>
<td>Open</td>
<td>Reviewing</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td>Rework</td>
<td>Open</td>
<td>Elaborating</td>
<td>Investigate</td>
<td>Pending</td>
</tr>
<tr>
<td>Execute Change</td>
<td>Open</td>
<td>Executing</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td>Close Change</td>
<td>Open</td>
<td>Executing</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td>End</td>
<td>One of these:</td>
<td>One of these:</td>
<td>One of these:</td>
<td>Released</td>
</tr>
<tr>
<td></td>
<td>• Closed</td>
<td>• Complete</td>
<td>• Approved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
<td>• Elaborating</td>
<td>• Disapproved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On hold</td>
<td>• Reviewing</td>
<td>• Deferred</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Executing</td>
<td></td>
</tr>
</tbody>
</table>

The state property settings restrict permissions to add items to the enterprise change notice’s folders. For example, the closure, maturity, and disposition property settings must be **Open, Elaborating, and None** for a **Requestor** to add a change request (ECR) to a change notice (ECN). The ECR state settings have restrictions as well (**Open, Reviewing, Approved**).

To relate a revision to an ECN, the closure, maturity, and disposition property settings must be **Open, Reviewing, and Approved** as well as the releases state must be something other than null or **Released** (for example, **Pending**).

**Note** The **EPM-set-property** workflow handler is used to change the state properties. State property values cannot be set by users.
Change Manager interface

1. **Open Change view**  
   Displays change folders and any attached forms or other objects.

2. **Open Task view**  
   Displays change folders associated with a Schedule Manager task used for work breakdown planning.  
   For more information, see *About scheduling implementation activities*.

3. **Change Home view**  
   Contains saved searches for change objects defined by system administrators and users.  
   The default search is **My Open Changes**.

4. **Change Manager perspective**  
   Contains views to display change properties, related items, BOM changes, change effectivity, and work breakdown tasks.  
   For more information, see *Change Manager tabs*. 
Change Manager Interface

Change Manager tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Displays the property information of the selected object.</td>
</tr>
<tr>
<td></td>
<td>For general information about the Summary view, see the My Teamcenter Guide.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays the children of the selected component in the Change tree.</td>
</tr>
<tr>
<td></td>
<td>For general information about the Details view, see the My Teamcenter Guide.</td>
</tr>
<tr>
<td>Viewer</td>
<td>Displays the registered viewer for the selected component in the Change tree.</td>
</tr>
<tr>
<td></td>
<td>When a change revision is selected, the Viewer tab displays a user-defined list of change properties and also displays change forms in a tabular format.</td>
</tr>
<tr>
<td></td>
<td>For more information about the Viewer view, see the My Teamcenter Guide.</td>
</tr>
<tr>
<td>Impact Analysis</td>
<td>Provides graphical where-used and where-referenced search capabilities.</td>
</tr>
<tr>
<td></td>
<td>For more information about the Impact Analysis view, see the My Teamcenter Guide.</td>
</tr>
<tr>
<td>BOM Changes</td>
<td>Displays changes to the structure of the selected object, based on the displayed change.</td>
</tr>
<tr>
<td>Change Effectivity</td>
<td>Displays the end item effectivity information for the selected impacted/solution items in an enterprise change notice. End item effectivity information is created, modified, and displayed in this view. Clicking the Create button opens the Create Effectivity dialog box. Use this dialog box to search for end items and to set unit and date effectivities.</td>
</tr>
<tr>
<td></td>
<td>For more information about effectivity, see About setting change effectivities and Assign effectivity.</td>
</tr>
<tr>
<td>Work Breakdown</td>
<td>Displays the structure of the schedule and task breakdown in Schedule Manager and allows you to modify it or create a new one. Schedule Manager must be installed to see this view.</td>
</tr>
</tbody>
</table>
Menu command | Description
--- | ---
File→New→Change | Displays the New Change dialog box and allows the creation of a change object. For more information about creating change objects, see Ways to identify changes.

Tools→Assign Participants | Assigns users, group members, or role members to perform certain tasks during the change process. For more information about participants, see About the participants in the change process.

For more information about the standard Teamcenter rich client menus, see the My Teamcenter Guide.

### Change Manager buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Manage saved searches 📚 | Displays the Manage Saved Searches dialog box and allows the creation, modification, or deletion of searches to find change objects. This button is found in the Change Home view.

Add Form 📊 | Displays the BOM line item form dialog box and allows you to associate a form with a structure change. You can use the boxes in the form to document the purpose of the change or other change information. This button is found in the Change Manager BOM Change view. For more information about BOM lines, see the Structure Manager Guide.

Delete Form 🗑️ | Removes the selected BOM change form for the solution item. This button is found in the Change Manager BOM Change view. For more information about BOM lines, see the Structure Manager Guide.
### Change Manager interface

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollup</td>
<td>Displays the Roll Up view with a static display of all business and change items contained in the change folders of the selected change object and any of the associated tasks in the work breakdowns. The set of relation folders displayed is the same as in the Open Change view. This is a virtual rollup of objects to provide consolidated visibility of the related items anywhere in the work breakdown of the change. Once the change is complete, you can make the rolled-up objects permanent by sending them to the top-level change object. This button is found in the Open Change view. For more information about rollups, see Roll up objects associated with a change object.</td>
</tr>
<tr>
<td>Open in Structure Manager with Supersedure Window</td>
<td>Displays the Supersedure view in Structure Manager with the selected item revision from the Solution Items folder. This button is found in the Open Change view. For more information about supersedures, see the Structure Manager Guide.</td>
</tr>
<tr>
<td>Open Schedule</td>
<td>Displays the Schedule Manager view. This button is found in the Open Change view. For more information about Schedule Manager, see the Schedule Manager Guide.</td>
</tr>
<tr>
<td>View Task folders</td>
<td>Displays the Open Task view. This button is found in the Schedule Manager view.</td>
</tr>
</tbody>
</table>

### Rich client perspectives and views

Within the Teamcenter rich client user interface, application functionality is provided in perspectives and views. Some applications use perspectives and views to arrange how functionality is presented. Other applications use a single perspective and view to present information.

**Note** Your administrator can use the HiddenPerspectives preference to prevent the display of some Teamcenter perspectives in the rich client. For information about editing preference values, see the Preferences and Environment Variables Reference.

If your site has online help installed, you can access application and view help from the rich client Help menu or by pressing F1. For more information about rich client perspectives and views, see the Rich Client Interface Guide.
# Chapter

## 1 Identifying changes

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ways to identify changes</td>
<td>1-1</td>
</tr>
<tr>
<td>Create a problem report</td>
<td>1-2</td>
</tr>
<tr>
<td>Create an enterprise change request</td>
<td>1-2</td>
</tr>
<tr>
<td>Create a deviation request</td>
<td>1-3</td>
</tr>
<tr>
<td>Create an enterprise change notice</td>
<td>1-4</td>
</tr>
<tr>
<td>Relate change objects to other change objects</td>
<td>1-5</td>
</tr>
</tbody>
</table>
Chapter

1 Identifying changes

Ways to identify changes

Any user can create a problem report (PR) identifying a problem. Your administrator can use groups and roles along with conditions in the Business Modeler IDE to configure which change objects users can create. Check with your administrator to see how your change management solution is configured.

You need a license level that enables authoring to create anything besides a PR. If you do not have a higher level license, you are limited to creating PRs only.

For more information about configuring Change Manager, see the About administering the change management process.

You can create a change object three different ways:

- Independently

- In the context of an impacted or problem item revision

- Derived from another change object; only ECRs, deviation requests, and ECNs can be created this way

If you derive a change object from another, you can copy the relationships (such as reference items and problem items) and the object’s synopsis (name) and description. You can change the synopsis and description.

- You can configure which change object you can derive from another using the CM_change_derivations preference.

- You can configure which relations to propagate when you derive a change object from another using the following preferences.

<table>
<thead>
<tr>
<th>When deriving a change object from a</th>
<th>Set the relations propagated using</th>
</tr>
</thead>
<tbody>
<tr>
<td>PR</td>
<td>CM_ProblemReportRevision_Relations_To_Propagate</td>
</tr>
<tr>
<td>Deviation request</td>
<td>CM_Cm0DevRqstRevision_Relations_To_Propagate</td>
</tr>
<tr>
<td>ECR</td>
<td>CM_ChangeRequestRevision_Relations_To_Propagate</td>
</tr>
</tbody>
</table>
Chapter 1  Identifying changes

Create a problem report

For information about the permissions required to create a problem report (PR) and the different contexts in which to create it, see Ways to identify changes.

1. Do one of the following:
   • Select the folder to contain the PR, and choose File→New→Change.
   • Right-click an item revision and choose New Change in context.

The dialog box appears. If you created it in the context of a part, the part that you selected in Step 1 appears in the bottom portion of the dialog box.

2. In the New Change dialog box, select Problem Report and click Next.

3. Type a name in the Synopsis box and a description of the problem in the Description box.

   You can also type a problem report ID and revision in the PR Number and Revision boxes. If you do not provide an ID and revision number, Teamcenter provides them automatically.

4. Click Finish.

   If you created the problem report by right-clicking the item revision and choosing New Change in context, the item revision is automatically copied to the problem report Problem Items folder.

Create an enterprise change request

For information about the permissions required to create an enterprise change request (ECR) and the different contexts in which to create it, see Ways to identify changes.

1. Create the change request in one of the following ways:
   • Select the folder to contain the ECR, and choose File→New→Change.
   • Right-click an item revision and choose New Change in context.
   • Select one or more problem report revisions, right-click, and choose Derive Change.

   The problem report revisions must have their properties set to:

<table>
<thead>
<tr>
<th>Property</th>
<th>Must be</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maturity</td>
<td>Reviewing</td>
</tr>
<tr>
<td>Disposition</td>
<td>Approved</td>
</tr>
<tr>
<td>Closure</td>
<td>Open</td>
</tr>
</tbody>
</table>

   You can configure which change object you can derive from the problem report revision using the CM_change_derivations preference.

2. In the dialog box, select Change Request and click Next.
3. If this is a new change, type a name in the **Synopsis** box and a description of the change request in the **Description** box.

If this is a derived change, the boxes contain the name and description from the problem report revision. You can edit these boxes.

You can also type a change request ID and revision in the **ECR No.** and **Revision** boxes. If you do not provide an ID and revision number, Teamcenter provides them automatically.

If you derived this change request from a single problem report, the **Propagate relations** check box is available. If you want to copy the relationships (such as reference items and problem items) from the problem report to the change request, select the check box.

**Note** Propagate relations is available only when a change request is derived from a single problem report. When more than one problem report exists, this relationship must be created manually.

You can configure which relations to propagate when you derive a change object from a problem report with the **CM_ProblemReportRevision_Relations_To_Propagate** preference.

4. Click **Finish**.

If you created the change request by right-clicking the item revision and choosing **New Change in context**, the item revision is automatically copied into the change request **Problem Items** folder.

---

**Create a deviation request**

For information about the permissions required to create a deviation request and the different contexts in which to create it, see *Ways to identify changes*.

1. Create the deviation request in one of the following ways:

   - Select the folder to contain the ECN and choose **File→New→Change**.
   
    - Right-click an item revision and choose **New Change in context**.
   
   - Select one or more problem report revisions, right-click, and choose **Derive Change**.

   The problem report revisions must have their properties set to:

<table>
<thead>
<tr>
<th>Property</th>
<th>Must be</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maturity</td>
<td>Reviewing</td>
</tr>
<tr>
<td>Disposition</td>
<td>Approved</td>
</tr>
<tr>
<td>Closure</td>
<td>Open</td>
</tr>
</tbody>
</table>

   You can configure which change object you can derive from the problem report revision with the **CM_change_derivations** preference.

2. In the dialog box, select **Deviation Request** and click **Next**.
3. If this is a new change, type a name in the **Synopsis** box and a description of the deviation request in the **Description** box. If this is a derived change, the boxes contain the name and description from the problem report revision. You can edit these boxes.

You can also type a deviation request ID and revision in the **EDR No.** and **Revision** boxes. If you do not provide an ID and revision number, Teamcenter provides them automatically.

Enter the change in the **Change Type** box. You can enter **RFD** for a request for deviation or **RFW** for a request for waiver.

If this deviation is recurring, select the **Is deviation recurring?** check box and type the reason in the **Rationale** box.

If you derived this deviation request from a single problem report, the **Propagate relations** check box is available. If you want to copy the relationships (such as reference items and problem items) from the problem report to the deviation request, select the check box.

You can configure which relations to propagate when you derive a change object from a problem report with the **CM_ProblemReportRevision_Relations_To_Propagate** preference.

4. Click **Finish**.

If you created the deviation request by right-clicking the item revision and choosing **New Change in context**, the item revision is automatically copied into the deviation request **Problem Items** folder.

---

### Create an enterprise change notice

For information about the permissions required to create an enterprise change notice (ECN) and the different contexts in which to create it, see *Ways to identify changes*.

1. Create the change notice in one of the following ways:

   - Choose **File→New→Change**.
   - Select an item revision, right-click, and choose **New Change in context**.
   - Select one or more change request revisions, right-click, and choose **Derive Change**.

   The change request revisions must have their properties set to:

<table>
<thead>
<tr>
<th>Property</th>
<th>Must be</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maturity</td>
<td>Reviewing</td>
</tr>
<tr>
<td>Disposition</td>
<td>Approved</td>
</tr>
<tr>
<td>Closure</td>
<td>Open</td>
</tr>
</tbody>
</table>

   You can configure which change object you can derive from the change request revision with the **CM_change_derivations** preference.

2. In the dialog box, select **Change Notice** and click **Next**.
3. Type a name in the Synopsis box and a description of the change notice in the Description box.

You can also type a change notice ID and revision in the ECN Number and Revision boxes. If you do not provide an ID and revision number, Teamcenter provides them automatically.

If this is a derived change, the boxes contain the name and description from the change request revision. You can edit these boxes.

If you derived this change notice from a single ECR, the Propagate relations check box is available. If you want to copy the relationships (such as reference items and problem items) from the change request to the change notice, select the check box.

You can configure which relations to propagate when you derive a change object from an ECR using the CM_ChangeRequestRevision_Relations_To_Propagate preference.

4. Click Finish.

If you created the change notice by right-clicking the item revision and choosing New Change in context, the item revision is automatically copied into the change notice Problem Items folder.

**Relate change objects to other change objects**

You can associate problem reports (PRs) with the enterprise change requests (ECRs) that addresses them and ECRs with the enterprise change notices (ECNs) change notices (CNs) that address them by adding them to the Implements folder.

- To associate a PR with an ECR, add the PR to the ECR’s Implements folder.

You can add or delete PRs if you are an assigned participant and the ECR and PR property settings are as follows.

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>ECR</td>
</tr>
<tr>
<td></td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>PR</td>
</tr>
<tr>
<td></td>
<td>Open/Approved/Reviewing</td>
</tr>
<tr>
<td>Change Specialist</td>
<td>ECR</td>
</tr>
<tr>
<td></td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Open/Investigate/Reviewing</td>
</tr>
<tr>
<td></td>
<td>PR</td>
</tr>
<tr>
<td></td>
<td>Open/Approved/Reviewing</td>
</tr>
</tbody>
</table>
Chapter 1  Identifying changes

- To associate an ECR with an ECN, add the ECR to the ECN’s implements folder. You can add or delete ECRs if you are an assigned participant and the ECN and ECR property settings are as follows.

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>ECN</td>
</tr>
<tr>
<td></td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>ECR</td>
</tr>
<tr>
<td></td>
<td>Open/Approved/Reviewing</td>
</tr>
<tr>
<td>Change Specialist</td>
<td>ECN</td>
</tr>
<tr>
<td></td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Open/Investigate/Reviewing</td>
</tr>
<tr>
<td></td>
<td>ECR</td>
</tr>
<tr>
<td></td>
<td>Open/Approved/Reviewing</td>
</tr>
</tbody>
</table>

**Note**
- You can associate more than one PR with an ECR and one PR with several ECRs.
- You can associate more than one ECR with an ECN and one ECR with several ECNs.
Chapter

2 Searching for change objects

Types of searches .................................................. 2-1
Create a search in Change Manager .......................... 2-1
Run a search ........................................................... 2-2
Display searches in the Change Home view ............. 2-2
Delete a search ..................................................... 2-2
Chapter

2 Searching for change objects

Types of searches

There are two kinds of searches that you can use:

- **System-defined searches**

  Searches created by a Teamcenter administrator shared by all users at a site. They are populated by saved queries and do not require users to provide search criteria. They appear as folders in the Change Home view. Teamcenter administrators can create, modify, or delete these searches.

  The My Open Changes system-defined search is standard with Teamcenter and appears as a folder in the Change Home view.

  To execute the search, expand the folder.

- **User-defined searches**

  Searches created by individual users for their personal use that are unique to them. They are populated by the searches in the user’s My Saved Searches list. They appear as folders in the Change Home view.

  A search name cannot contain a forward slash (/).

Create a search in Change Manager

1. In the Change Home view, click Manage saved searches 📁.

2. In the Manage Saved Searches dialog box, click Add.

3. The default type is **User-defined**. If you are an administrator, you can select **System-defined** from the list if you want the search available to all users.

4. Leave the Show check box selected.
5. Click the **Assigned search** list to select the search that is assigned to the folder. The list contains your user-defined saved searches.

   **Note** If you add a search that requires the user to provide additional information, an error is displayed when that search folder is opened by a user.

   For more information about saved searches, see the *Rich Client Interface Guide*.

   **Note** The system-defined searches displayed are searches that query change item revisions and require no user interaction. You can use any of the system-defined searches.

6. The **Search name** defaults to the name of the search you selected in the **Assigned search** list. Optionally, you can change it.

   **Note** A search name cannot contain a forward slash (/).

7. Click **OK**.

### Run a search

To run a search, do one of the following:

- If the search folder in the **Change Home** view is closed, open it.
- If the search folder in the **Change Home** view is already open, right-click the search folder and choose **Refresh**.

### Display searches in the Change Home view

1. In the **Change Home** view, click **Manage saved searches**.

2. To hide a search, clear the search’s **Show** check box in the **Manage Saved Searches** dialog box.

3. To display a hidden search, select the search’s **Show** check box.

4. Click **OK**.

### Delete a search

1. Right-click the search folder in the **Change Home** view and choose **Delete**.

   You can delete your user-defined searches. You can delete system-defined searches only if you are an administrator.

2. In the **Delete search folder** dialog box, click **OK**.
Chapter

3  Reviewing changes

About reviewing a change .................................................. 3-1
Review a change ................................................................. 3-1
Chapter

3 Reviewing changes

About reviewing a change

All the tasks to review and implement changes are typically controlled by workflows that flexibly guide the change through the change process: authoring, review and approval, execution, and closure. When you are requested to review a change, you receive a Perform Signoff task in your Tasks to Perform folder.

For more information about the tasks that you perform in a workflow, see the Getting Started with Workflow.

Review a change

1. Select the perform-signoffs task in your Tasks to Perform folder.

2. Click the Viewer tab, and select the Task View option.
   
   The system displays the Perform Signoff pane listing process information.

   • **Responsible Party**
     
     When the Responsible Party entry displays as an active link, you can reassign the parent task by clicking the link and selecting a new group, role, and user.
     
     Reassigning the task transfers ownership of the parent task to the selected user, making that user the Responsible Party for the task. It does not, however, transfer your signoff responsibility.

   • **Instructions**
     
     When the Instructions link is displayed, there are instructions for the task. You can view the instructions by clicking the link.

   • **Attachments**
     
     When there are attachments to the workflow process, you can view them by clicking the Attachments link.
     
     The system displays the Attachments dialog box. Target and reference attachments are listed beneath the signoff task in the task tree.

   • **All Comments**
     
     If the All Comments entry is present and is as an active link, comments are written for the task. You can view the comments by clicking the link.
Chapter 3  
Reviewing changes

3. (Optional) If you are a privileged user because you are the process owner, the responsible party, or a member of the administration group, you can delegate your signoff responsibility for the perform-signoffs subtask to another user.

   Note If you are selected to a signoff team based on your inclusion under a signoff profile, you can only delegate the perform-signoffs subtask to another user who can match your signoff profile group and role. Otherwise, you can delegate the perform-signoffs subtask to any other user.

   a. Click your linked name in the User-Group/Role column.
      The system displays the Delegate Signoff dialog box.

   b. Select a new user from the Group, Role, and User lists.

   c. Click OK.
      Teamcenter assigns the task to the specified user and the task is placed in their Tasks to Perform folder.

4. Sign off the task:

   a. Click the link in the Decision column to display the Signoff Decision dialog box.

   b. Select an option.
      • If perform-signoffs is a subtask of an Acknowledge task, select Acknowledged or Not Acknowledged.
      • If perform-signoffs task is a subtask of a Review task, select Approve, Reject, or No Decision.

   Note The Not Acknowledged and No Decision options do not apply to the quorum count. If your decision is necessary to meet quorum requirements, this subtask cannot complete until you select either Acknowledged or Approve.

   c. (Optional) Type comments in the Comments box.

   d. Click OK.
      If user authentication is required to complete the task, type your password in the Password box, and click OK.

   Note This authorization is determined by the creator of the process template. If your site employs Security Services, you must use the Security Services password rather than your Teamcenter password.

The task is complete and the Viewer tab now displays No View Data Available.
Chapter

4 Developing and implementing changes

Managing items related to a change object ........................................... 4-1
  Relating items to a change and the properties required ......................... 4-1
  About viewing relationships using the Implements and Implemented By folders ......................................................... 4-5
  Manage the change relations in the change object ............................... 4-6
  Relate a solution item to an impacted item ........................................ 4-7
  Create a new revision of impacted items ............................................ 4-8

Update a change .................................................................................... 4-9

Create a BOM change ........................................................................... 4-10

Managing unincorporated changes ....................................................... 4-12
  About incorporating changes ............................................................... 4-12
  Example of incorporating changes ....................................................... 4-12
  Conditions that must be met to set Incorporation status ....................... 4-16
  Set the Incorporation status of an object ............................................. 4-18
  General process for incorporating change items in an ECN .................. 4-19
  General process for incorporating markups in an ECN ......................... 4-23
  Configure a folder to display Incorporation status ............................... 4-26
  Viewing Incorporation status and history ............................................. 4-27
    View Incorporation status and history .............................................. 4-27
    Understanding the columns in the Change History dashboard for an ECN ............................................................................. 4-28
    Understanding the columns in the Change History dashboard for an item .................................................................................... 4-29
    Configure the Change History dashboard ......................................... 4-30

Replacing part instances using Mass Update .......................................... 4-30
  About replacing part instances using Mass Update ............................... 4-30
  Types of part replacements you can perform ........................................ 4-32
  Good part replacement practices ......................................................... 4-35
  Performing part replacement under change management ....................... 4-35
    Authorize part replacements during an ECR ..................................... 4-35
    Search for parts or change objects during part replacement ................ 4-40
    Manage part replacements during an ECR ........................................ 4-41
    Run part replacements during an ECN .............................................. 4-42
    Rerun part replacements during an ECN .......................................... 4-43
    Replacing part instances in a single step .......................................... 4-44
    Replace part instances in a single step ............................................. 4-44
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folders that store the part replacements</td>
<td>4-48</td>
</tr>
<tr>
<td>Configuring part replacement</td>
<td>4-49</td>
</tr>
<tr>
<td>(Recommended) Supressing the Mass Update command</td>
<td>4-49</td>
</tr>
<tr>
<td>Setting up where-used search</td>
<td>4-49</td>
</tr>
<tr>
<td>Configuring the replacement of parts with change management</td>
<td>4-49</td>
</tr>
</tbody>
</table>
Chapter

4 Developing and implementing changes

Managing items related to a change object

Relating items to a change and the properties required

During the change process, you elaborate a change object by relating other objects to it.

For example, you may need to add reference documents to a problem report (PR) or specify which item revisions are impacted by an enterprise change revision (ECR) as shown. When you implement a change, new item revisions must be related as solution items.

Some relations, such as problem item relations, can be optionally propagated from one change object to a derived change object when you create the derived change object, making the same object visible from each change object associated with the change.

Your administrator can configure the types of relations to be propagated when change objects are derived. Because the derivation action can only be performed
on a single selected change object, any relationships you want from other change objects must be manually created.

For example, if one ECR is used to implement multiple PRs, you must add the other PRs to the ECR *Implements* folder as well as add related items to its other folders, such as adding problem items to its *Problem Items* folder.

You create the appropriate relations by adding objects to the folders of the change object. You do this as you would add objects to any folder in Teamcenter.

In addition, you can use other Teamcenter views, including the *Change Home*, *Teamcenter Component*, and *Search Results* views. You can also use the *Summary* view.

For more information, see *Manage the change relations in the change object*. 
### Problem Items

<table>
<thead>
<tr>
<th>Description</th>
<th>Required property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains item revisions with the problems that the change is to address. This could be the parent assembly.</td>
<td>To create a relationship between an item revision and a change object (PR, ECR, or ECN), add the item revision to the change object’s <strong>Problem Items</strong> folder. You can add or delete item revisions if you are an assigned participant and the change object property settings are as follows.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td><strong>Open/None/Elaborating</strong></td>
</tr>
<tr>
<td>Analyst</td>
<td><strong>Open/None/Elaborating</strong> or <strong>Open/Investigate/Reviewing</strong></td>
</tr>
</tbody>
</table>

### Impacted Items

<table>
<thead>
<tr>
<th>Description</th>
<th>Required property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains item revisions that are being changed as a result of the change process.</td>
<td>1. To create a relationship between an item revision that an enterprise change request (ECR) or enterprise change notice (ECN) affects and the ECR or ECN.</td>
</tr>
<tr>
<td></td>
<td>2. To add the item revision to the ECR or ECN’s <strong>Impacted Items</strong> folder.</td>
</tr>
<tr>
<td></td>
<td>You can add or delete item revisions if you are an assigned participant and the ECR or ECN property settings are as follows.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td><strong>Open/None/Elaborating</strong> or <strong>Open/Investigate/Reviewing</strong></td>
</tr>
</tbody>
</table>

### Solution Items
## Description

| Contains item revisions that are generated as a result of the change (for example, the new piece parts and the new revision of the parent assembly to contain them). |

<table>
<thead>
<tr>
<th>Required property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a relationship between an item revision and the ECN that implements the change, add the item revision to the ECN’s <strong>Solution Items</strong> folder.</td>
</tr>
<tr>
<td>You can add or delete item revisions if you are an assigned participant and the ECN property settings are as follows.</td>
</tr>
<tr>
<td><strong>Assigned participant</strong></td>
</tr>
<tr>
<td>Analyst</td>
</tr>
<tr>
<td>For information about relating a solution item revision to an impacted item revision, see <em>Relate a solution item to an impacted item.</em></td>
</tr>
</tbody>
</table>

## Reference Items

| Contains any Teamcenter object, including datasets, that reference related information (such as analysis documents and system logs). |

| To associate related information (such as analysis documents and system logs) with a PR, ECR, or ECN, add any Teamcenter object, including datasets, to the **Reference Items** folder. |
| You can add or delete objects if you are an assigned participant and the property settings for the PR, ECR, or ECN are as follows. |
| **Assigned participant** | **Closure/Disposition/Maturity property settings** |
| Requestor | Open/None/Elaborating |
| Analyst | Open/None/Elaborating |
| or |
| Open/Investigate/Reviewing |
| For information about relating a solution item revision to an impacted item revision, see *Relate a solution item to an impacted item.* |

## Plan Items

| Contains schedules that define tasks in a work breakdown structure. |

<table>
<thead>
<tr>
<th><strong>Assigned participant</strong></th>
<th><strong>Closure</strong></th>
<th><strong>Disposition</strong></th>
<th><strong>Maturity</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open</td>
<td>None</td>
<td>Elaborating</td>
</tr>
<tr>
<td>or</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>Investigate</td>
<td>Reviewing</td>
<td></td>
</tr>
<tr>
<td>For more information about creating and managing workbreakdown structures (schedules), see <em>Scheduling implementation activities.</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Implements
Description | Required property settings
---|---
Contains change object revisions that reference this change object. An ECR implements PRs. An ECN implements ECRs. | **Note** A PR does not have a **Implements** folder because it does not implement a problem, only identifies one.

Usually, the **Implements** folder is automatically populated as part of the change process but you can add to it if you are an assigned participant and the property settings are set as follows:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Reviewing</td>
</tr>
</tbody>
</table>

For more information about the relationships between change objects, see [About viewing relationships using the Implements and Implemented By folders](#).

---

**Implemented By**

Contains change object revisions that are referenced by this change object. A PR is implemented by ECRs. An ECR is implemented by ECNs.

Usually, the **Implemented By** folder is automatically populated as part of the change process but you can add to it if you are an assigned participant and the property settings are set as follows:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Reviewing</td>
</tr>
</tbody>
</table>

For more information about the relationships between change objects, see [About viewing relationships using the Implements and Implemented By folders](#).

---

**About viewing relationships using the Implements and Implemented By folders**

Two change object folders show the relationships between the change objects during the stages of the change process:

- A change object’s **Implements** folder shows the change objects that are addressing the problem that the change object identified.

- A change object’s **Implemented By** folder contains the change objects whose problems the change object is addressing.

For example:

- The enterprise change notices (ECN) **Implements** folder contains the enterprise change request (ECR) whose problem it is addressing, while that ECR’s...
Implementated By folder contains the ECN that is correcting the problem it identified.

- The problem report (PR) Implementated By folder contains the ECRs that correct the problem that the PR identified.

**Note**  A PR does not have a Implements folder because it does not implement a problem, only identifies one.

Usually, the Implements and Implementated By folders are automatically populated as part of the change process but you can add to them if you are an assigned participant and the property settings are set as follows:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Reviewing</td>
</tr>
</tbody>
</table>

For more information about the relationships between change objects, see *Relationship between change objects*.

**Manage the change relations in the change object**

You can add related items to the change folders associated with the change object as you do other Teamcenter folders using standard views, including the Change Home, Teamcenter Component, and Search Results views. You must be an assigned participant and the properties of the object must be set as explained in *Relating items to a change and the properties required*.

You can also use the Summary view in Change Manager to display and manage the change item relations for change objects.

1. In a Change Manager view, select a change object, and click the Summary tab.

   The Summary view displays the Affected Items and Reference tabs, which show the various folders related to the change object as shown for an enterprise change request (ECR). The folders displayed depend on the type of change object or schedule task selected. You can add and remove items as well as create new documents for the Reference and Solutions folder.
2. Click the **Affected Items** or **Reference** tabs, depending on the type of items you want to manage.

3. Use the **Cut**, **Copy**, and **Paste** tools, as appropriate, to add or remove items from the folders. Use the **Add New** tool to create a new document for the **Reference** and **Solutions** folder.

### Relate a solution item to an impacted item

In Change Manager, a solution to an impacted item is not always a revision of the impacted item. It can be a separate item (for example, a markup). In addition, there can be more than one revision of the same item in either or both the **Impacted Items** and **Solution Items** folders.

To create BOM change and supersedure records for a change, there must be an exact correspondence between the solution and impacted item revisions. If the change has a single impacted item revision and a single solution item revision of the same item, the BOM change relationship is created automatically. If not, you must use the **Relate Solution Item to Impacted Item** command to set up the relationship.
If the solution item is not related to an impacted item and you send the solution item to Structure Manager, the **Relate Solution Item to Impacted Item** dialog box appears. You must create the relation before the solution item is sent to Structure Manager.

**Note** Supersede relationships are always created manually. You must copy the old item revision to the **Impacted Items** folder and the new item revision to the **Solution Items** folder.

1. Double-click the ECN revision to open it in the **Open Change** view as shown.

2. Right-click the item revision in the **Solutions Items** folder and choose **Relate Solution Item to Impacted Item**.

Create a new revision of impacted items

A change object can have multiple impacted and solution items. Processing these items one at a time can be inefficient and prone to error. Therefore, you can revise one or more items in the **Impacted Items** folder of an engineering change notice (ECN) and add them as new revisions in the **Solutions Items** folder.

By default, to revise an item in the **Impacted Items** folder, the following properties must be met.
Developing and implementing changes

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Executing</td>
</tr>
</tbody>
</table>

You can also create a BOM change after revising an item.
For more information, see *Create a BOM change*.

To revise an impacted item:

1. Double-click the ECN revision to open it in the **Open Change** view as shown.

2. Select the item or items in the **Impacted Items** folder you want to revise.

3. Choose **Tools**→**Revise Impacted Item(s)**.
   
   A new revision appears in the **Solution Items** folder.

**Update a change**

After a change object is created, you can update its properties depending on your ownership and participant privileges. For example, you might want to enhance the problem report (PR) description to elaborate on the conditions under which a problem occurred.

1. Select the problem report, enterprise change request, deviation request, or enterprise change notice that you want to update.

   You can update these objects only if you are the owner or have checkout and checkin privileges granted by an access control list, Access Manager rules, or another method.

2. Click either the **Summary** or **Viewer** pane.

3. Click the **Check out and edit** button.

4. Edit the properties you want to update.
Chapter 4  Developing and implementing changes

- You cannot edit the ID property.
- You cannot change the participants from the Summary or Viewer pane. Choose Tools→Assign Participants instead.
- You cannot change the Maturity, Disposition, or Closure properties from the Summary or Viewer pane.
  To change these properties, see About setting change states.

5. To save your changes in the Summary pane, click either the Save properties and check in button or the Save and keep checked out button.
To save your changes in the Viewer pane, click the Save button.

6. To discard your changes in the Summary pane, click the Cancel checkout and revert back to original button.
To discard your changes in the Viewer pane, click the Clear button.

7. If you saved your changes, check them in if they are not already checked in.
To check in your changes in the Summary pane, click the Save properties and check in button.
To check in your changes in the Viewer pane, click the Check-In button.

Create a BOM change

1. Double-click the ECN revision to open it in the Open Change view, as shown.

2. Right-click the item revision of the original assembly in the Impacted Items folder of the ECN and choose Revise Impacted Item(s).
   A new revision of the assembly appears in the Solution Items folder.

3. Right-click the item revision in the Solution Items folder and choose Send To→Structure Manager.
4. Make your changes in Structure Manager and click **Save**.

You see the split window showing BOM changes; you have write access to the assembly.

5. In Structure Manager, you can create the supersedure and view the genealogy.

For more information about using Structure Manager, see the *Structure Manager Guide*.

**Note**

- Supersedure relationships are always created manually. You must copy the old item revision to the **Impacted Items** folder and the new item revision to the **Solution Items** folder.

- Be sure the **TC_ValidApprovedStatus** preference is set to a valid status (for example, **TCM Released**). You can then see a visual indication of a potentially superseded component using the **Edit→Show/Hide Superseded** command in Structure Manager when the top line of the assembly is highlighted.

For more information, see the *Preferences and Environment Variables Reference*.

6. After the BOM change is created, you can see it in Change Manager by selecting the change object revision and clicking the **BOM Changes** pane.

7. (Optional) Create a BOM line item form by selecting the BOM line in the **BOM Changes** pane and clicking **Add Form**.

You can use the boxes in the form to document the purpose of the change or other change information.
Managing unincorporated changes

About incorporating changes

An unincorporated change is a change that is approved but not yet incorporated in the design of a product. Usually, changes are not incorporated fully because there is not enough time, importance, or budget to incorporate the changes completely through the development process.

- The unincorporated change functionality is intended to track unincorporated changes to existing designs. It does not support tracking unfinished work of new, unreleased designs.

- Unincorporated changes can only be applied to ECNs.

Example

A designer releases Revision A of Item1 for production, and begins working on a new revision (Revision B). On the shop floor, a minor modification is performed over Revision A and production starts. This changed version needs to be recorded in Teamcenter. Therefore, a new supplemental revision (A01) is created and released. Because the change still needs to be incorporated into the main release, (revision B, in this case), the change is considered partially incorporated.

An ECN can also either partially or fully incorporate markups. However, a markup is considered fully incorporated into all the solution items of the incorporating ECN, which has the change partially incorporated into the same item.

Example

A designer creates a ECN (CN1), with a markup (MU1) as a solution item. The designer sets the Incorporation status of several of the impacted items to Partially Incorporated.

The designer then creates a second ECN (CN2) to incorporate markup MU1. The designer creates an incorporates relation between CN2 and MU1.

CN1/MU1 are now considered fully incorporated into the solution items of CN2 that belong to the impacted items of CN1 and have an Incorporation status of Partially Incorporated.

For a full example of incorporating changes, see Example of incorporating changes.

Example of incorporating changes

The following is an example showing the steps to incorporate changes partially and then fully when an enterprise change notice (ECN) impacts multiple change items.

Step 1 – Create enterprise change notice implementing changes

Company ABC creates an ECN (Change Notice Main) to implement a change needed on two items (Item 1 and Item 2). The item revision of the items in the Solutions folder is Revision b.

The ECN change state is Open, Executing, and Approved.
The following shows the status for the items as it would appear in the **Change History** dashboard.

For more information about the **Change History** dashboard, see **Viewing Incorporation status and history**.

**Note** ECN CN0 in the **Change History** dashboard is not shown in the figures to avoid complexity. CN0 is the ECN that initially created **Item 1**, Revision a, and **Item 2**, Revision a as solution items.

**Step 2 – Make the partially incorporated changes**

On the shop floor, a minor modification is done over Revision a of the two items (**Item 1** and **Item 2**) and production is started. Company ABC needs to immediately incorporate the change into Teamcenter. The items have work-in-process revisions so the change cannot be incorporated into these.

Therefore, a designer creates new revisions to incorporate the shop-floor changes and starts a new change notice (**Change Notice Partial**) to manage the implementation. The designer sets the incorporation status on the items in the **Impacted Items** folder of **Change Notice Partial** to **Partially Incorporated**.

The designer closes **Change Notice Partial** after creating Revision a01 of **Item 1** and **Item 2**.

Work still continues on Revision b in **Change Notice Main**, and it remains open.
The change states of the ECNs are:

- **Change Notice Main** – Open, Executing, and Approved
- **Change Notice Partial** – Closed, Complete, and Approved

**Step 3 – Incorporate changes from Item 1, Revision a01, into Revision b in Change Notice Main**

The designer finishes the work in **Change Notice Main** on Revision b of the items. The designer wants to incorporate the change to **Item 1** in **Change Notice Partial** into Revision b of **Change Notice Main**, but not the change that was done to **Item 2**. To indicate this, the designer creates an **Incorporates this** relation between **Change Notice Main** and Revision a01.
The change states of the ECNs are both Closed, Complete, and Approved.

**Step 4 – Incorporate changes from Item 2, Revision a01, into Revision b in Change Notice Additional**

Much later, more changes are recommended for Item 1 and Item 2. Therefore, Company ABC creates a third change notice (Change Notice Additional). During that change, the designer implements the changes that were in Change Notice Partial for Item 2 into Revision c.

At this point, all change notices are closed.
The change states of the ECNs are all Closed, Complete, and Approved.

**Conditions that must be to met to set Incorporation status**

The following conditions must be met before you can set the Incorporation status of an item revision. By default, all impacted items in the **Impacted Items** folder of an ECN are set to **Unincorporated**. In addition, when an ECN is closed through a workflow, all impacted items with a status of **Unincorporated** are automatically set to **Incorporated**.
Conditions required for a change to be partially incorporated

A change authorized by an ECN revision is considered partially incorporated in an item revision if the following are met:

- The item revision is a solution item of the ECN (in its Solution Items folder). If it is, then it meets the Business Modeler IDE condition CMHasSolutionItem.

- The ECN has an impacted item in its Impacted Items folder and its Incorporation status is set to Partially Incorporated.

  The CMHasImpactedItem relation object has the ECN revision as its primary object and an item revision of the same item as its secondary object. In addition, the value of the property Cm0IncorporationStatus on the CMHasImpactedItem relation object is set to Partially Incorporated.

Conditions required for fully incorporating a change

A change previously partially incorporated into an item revision, (for example, Revision a01) is considered fully incorporated into another item revision (for example, Revision b) of the same item if all the following are met:

- The ECN authorizing the item revision (in this example, Revision b) is a primary object of a Cm0Incorporates relation object and the previous revision (for example, Revision a01) is the secondary object.

- The ECN has an impacted item in its Impacted Items folder and its incorporation status is set to Incorporated.

  The CMHasImpactedItem relation object has the ECN as the primary object and an item revision of the same item as its secondary object. In addition, the value of the property Cm0IncorporationStatus on the CMHasImpactedItem relation object is set to Incorporated.

- The ECN revision authorizing the item revision (in this case, Revision b) is closed.

Conditions required for incorporating markups

An ECN incorporates a markup partially or fully in the same way it does item revisions, as explained in the two earlier sections. However, a markup is considered fully incorporated into all the solution items of the incorporating ECN that has the change partially incorporated into the same item.

Example

A markup (MU1) is a solution item of an ECN (CN1) and the incorporation status of a few of the impacted items of CN1 is set to Partially Incorporated.

A designer later creates an Incorporates relation between a new ECN (CN2) and the markup MU1.

Now CN1 and MU1 are considered fully incorporated into the solution items of CN2, which belong to the impacted items of CN1 with the Incorporation status set to Partially Incorporated.
Set the Incorporation status of an object

Before you can set the Incorporation status of an item revision, the item revision must be related to an enterprise change notice (ECN) as an item that it impacts. For more information about:

- Setting relations of change objects, see the *Relating items to a change and the properties required*.
- The conditions that must be met to set the Incorporation status of item revisions, see *Conditions that must be met to set Incorporation status*.

**Note** By default, the Incorporates relation is not displayed as a folder under the ECN revision.

For information about displaying a folder with this relation under the ECN, see *Configure a folder to display Incorporation status*.

1. In My Teamcenter or Change Manager, right-click the item revision and choose **Properties on Relation**.

2. In the Properties dialog box, scroll to **Incorporation Status** and set it to one of the following:

- **Unincorporated**
  The change has not been incorporated.

- **Partially Incorporated**
  The change as defined has been partially incorporated. It may or may not already be fully incorporated by a subsequent change.

- **Incorporated**
  The change as defined has been fully incorporated. No subsequent changes are required to fully incorporate the defined change.
• **Cancelled**

The change as defined is not incorporated in any way. This value indicates that an item has been identified as an impacted item, but the change as defined is not applied to that item. This status can be applied before a change solution definition or change execution has begun, or it can be updated after the change execution has begun.

3. Click **OK**.

**General process for incorporating change items in an ECN**

The following shows the general process for incorporating change items in an enterprise change notice (ECN). It is followed by a summary of the steps.

1. Create the ECN to completely incorporate the item revision.
   a. Create the ECN.
   b. Add the item revision to be incorporated to its **Impacted Items** folder.

[Diagram: Create an incorporation ECN → Create a new revision → Create partially incorporated ECN → Set Incorporation status and make change → Add solution item to incorporation ECN → Closed incorporation ECN]

**Note** The examples use primary revisions. We recommend that you use secondary revisions when partially incorporating change items. For example, use A01 or A02 and not A, B, and C.
c. Assign participants and start a workflow.

2. Create the new item revision.
   a. Use the **Revise Impacted Items(s)** command to create a new revision of the item revision and add it to the **Solutions Items** folder.

   The following properties must be met:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Executing</td>
</tr>
</tbody>
</table>

   For more information about revising an impacted item, see the **Create a new revision of impacted items**.
3. Create the second ECN that is to incorporate the item revision partially (the partially incorporated ECN).
   a. Create the partially incorporated ECN.
   
   b. Assign participants and start a workflow.

4. Set the Incorporation status and make the change.
   a. Use the Properties on Relation command to set the Incorporation status of the item revision to **Partially incorporated**
   
   b. Use the **Revise Impacted Items(s)** command to create a new revision of the item revision and add it to the **Solutions Items** folder.

The following properties must be met:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Executing</td>
</tr>
</tbody>
</table>
5. Add solution item to incorporation ECN.
   a. Add the item revision from the Solutions Items folder of the second ECN to the Incorporates folder of the first ECN that will incorporate all changes.

   The following properties must be set to add the item revision to the Incorporates folder:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Elaborating</td>
</tr>
</tbody>
</table>

   For information about displaying the Incorporates folder, see Configure a folder to display Incorporation status.

6. Close the incorporation ECN.
   a. Close the first ECN that incorporates the solution item. Closing the ECN automatically sets the Incorporated status of the solution item to Incorporated as shown in the Change History dashboard.
For more information about the Change History dashboard, see Viewing Incorporation status and history.

General process for incorporating markups in an ECN

The following provides the general process for incorporating change items in an enterprise change notice (ECN) when the solution item is a markup of the impacted item (they are different items; not revisions of each other).

**Note**  The examples use primary revisions. We recommend that you use secondary revisions when partially incorporating change items. For example, use A01 or A02 and not A, B, and C.

1. Create the ECN to completely incorporate the change.
   
   ![ECN diagram]

   a. Create the ECN.

   b. Add the item revision to be incorporated to its **Impacted Items** folder.

   ![ECN diagram]
c. Assign participants and start a workflow.

d. Use the **Revise Impacted Items(s)** command to create a new revision of the item revision and add it to the **Solutions Items** folder.

The following properties must be met:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Executing</td>
</tr>
</tbody>
</table>

For more information about revising an impacted item, see the *Create a new revision of impacted items*.

2. Create a second ECN that is to incorporate the item revision partially and make the partial change. The following shows the completed ECN with different impacted and solution items.

<table>
<thead>
<tr>
<th>ECN-000020-PartialCN2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECN-000020</td>
</tr>
</tbody>
</table>

a. Create the second ECN.
b. Add the item revision to be partially incorporated to its **Impacted Items** and **Solutions Items** folders. In this case, they are different items that are unrelated.

![ECN-000020-PartialCN2](image1)

ECN-000020

![ECN-000020/A1-PartialCN2](image2)

ECN-000020/A1

- Impacted Items
  - 000140/A1-itemABC
- Implements
- Incorporates
- Plan Items
- Problem Items
- Reference Items
- Solution Items
  - 000141/A1-NewSolution

ECN-000020/A

---

c. Assign participants and start a workflow.

d. Use the **Properties on Relation** command to set the Incorporation status of the item revision in the **Impacted Items** folder to **Partially incorporated**.

For more information about setting the Incorporation status of a change item, see *Set the Incorporation status of an object*.

e. Use the **Relate Solution Item to Impacted Item** command to relate the solution item to the impacted item, which creates a link between them, as shown in the **Change History** dashboard.

For more information about the **Change History** dashboard, see *Viewing Incorporation status and history*.

f. Make the change and close the ECN.

3. Add the item revision from the **Solutions Items** folder of the second ECN to the **Incorporates** folder of the first ECN that will incorporate all changes.

The following properties must be set to add the item revision to the **Incorporates** folder:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Elaborating</td>
</tr>
</tbody>
</table>
Chapter 4  Developing and implementing changes

4. Close the first ECN that incorporates the solution item. Closing the ECN automatically sets the Incorporated status of the solution item to Incorporated as shown in the Change History dashboard.

For more information about the Change History dashboard, see Viewing Incorporation status and history.

Configure a folder to display Incorporation status

By default, the Incorporation status Incorporates is not displayed as a folder under an enterprise change notice (ECN) revision.

Use the Options dialog box to specify that the Incorporates property should be displayed for an ECN.

1. Choose Edit→Options.
2. In the list on the left, select **General** and then select **Item Revision**.

3. Click the **Related Object** tab.

4. Set **Select Item revision type** to **Change Notice Revision**.

![Image of software interface]

5. In the **Available Relations** list, double-click **Incorporates**. **Incorporates** moves to the **Shown Relations** list.

6. Now click the **General** tab, and set up that the same relations be shown following Steps 4 and 5.

7. Click **OK**.

For more information, see the *Rich Client Interface Guide*.

**Viewing Incorporation status and history**

**View Incorporation status and history**

You can view the incorporation status of an enterprise change notice (ECN) or an item revision using the **Change History** dashboard of the **Summary** tab.

**Note** The **Change History** dashboard must be configured.

For more information, see *Configure the Change History dashboard*.

1. In My Teamcenter or Change Manager, select an item or ECN.

2. Click the **Summary** tab.
3. Click the **Change History** tab.

The following shows the **Change History** dashboard when an item revision is selected.

Each row in the dashboard represents one revision of the item or the ECN authorizing the revision (no two rows represent the same revision). The columns in the dashboard change depending on whether you selected to view the incorporation history of an item revision or ECN.

For more information about the columns in the **Change History** dashboard, see:

- *Understanding the columns in the Change History dashboard for an ECN*
- *Understanding the columns in the Change History dashboard for an item*

### Understanding the columns in the Change History dashboard for an ECN

When you select to view the Incorporation status of an enterprise change notice (ECN) in the **Change History** tab of the **Summary** tab, the **Change History** dashboard appears with the following columns.

<table>
<thead>
<tr>
<th>The column</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solution Item</strong></td>
<td>The name of the solution item of the ECN.</td>
</tr>
<tr>
<td><strong>Impacted Item</strong></td>
<td>The name of the Impacted Item in the ECN.</td>
</tr>
<tr>
<td><strong>Incorporates Changes of</strong></td>
<td>The names of the item revisions or markups that the ECN is incorporating.</td>
</tr>
<tr>
<td><strong>Incorporated by</strong></td>
<td>The name of the ECN revision that is incorporating the object listed in <strong>Solution Item</strong> column.</td>
</tr>
</tbody>
</table>
Developing and implementing changes

The column | Displays
---|---
Incorporated into | The Incorporation property of the ECN revision.
Incorporation Status | The Incorporation status of the impacted item, except if the Incorporation status is set to Partially Incorporated. Then, this indicates that another ECN has incorporated the change fully.

Understanding the columns in the Change History dashboard for an item

When you select to view the Incorporation status of an item in the Change History tab of the Summary tab, the Change History dashboard appears with the following columns.

<table>
<thead>
<tr>
<th>The column</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revision/Solution Item</td>
<td>The ID and name of the solution item.</td>
</tr>
<tr>
<td>Impacted Item</td>
<td>The ID and name of the impacted item.</td>
</tr>
<tr>
<td>Markup</td>
<td>The name and ID of any markup.</td>
</tr>
<tr>
<td>Authorizing Change Notice</td>
<td>The name of the ECN revision.</td>
</tr>
<tr>
<td>Closure</td>
<td>The Closure of the ECN.</td>
</tr>
<tr>
<td>Maturity</td>
<td>The Maturity of the ECN revision.</td>
</tr>
<tr>
<td>Disposition</td>
<td>The Disposition of the ECN revision.</td>
</tr>
<tr>
<td>Incorporates Changes of</td>
<td>IDs of the item revision or the name of the markup being incorporated by the ECN revision.</td>
</tr>
<tr>
<td>Incorporated by</td>
<td>The name of the incorporating ECN revision.</td>
</tr>
<tr>
<td>Incorporated into</td>
<td>The ID of the revision the change was incorporated into.</td>
</tr>
<tr>
<td>Incorporation Status of Change</td>
<td>Shows the Incorporation status set on the impacted item, except if the Incorporation status is set to Partially Incorporated. Then, this indicates that another ECN has incorporated the change fully.</td>
</tr>
</tbody>
</table>
Configure the Change History dashboard

- Associate the **Change History** tab with more workspace objects.

  Change Manager associates the **Change History** tab with all standard workspace objects involved in a change management process, such as item revisions and change objects. If you want to display the **Change History** dashboard for other workspace objects, such as document revisions, you can modify the style sheet for the **Summary** view of the object by adding the following code.

```xml
<page titleKey="tc_xrt_ChangeHistory" title="Change History" visibleWhen="{pref:CM_Change_History_Enable}==true">
  <section titleKey="tc_xrt_ChangeHistory" title="Change History" initialstate="expanded">
    <customPanel java="com.teamcenter.rac.cm.views.ItemChangeHistoryPanel" js="displayItemCustomPanel" />
  </section>
</page>
```

**Note** If you have modified the style sheet of a subtype of **Item/ItemRevision**, the **Change History** would not appear in its **Summary** view, and you need to add the code shown.

For more information about using style sheets, see the *Client Customization Programmer's Guide*.

- Turn on and off the display of **Change History** dashboard.

  Use the **CM_Change_History_Enable** preference to turn on or off the display of the **Change History** dashboard.

  For more information, see the *Preferences and Environment Variables Guide*.

- Change the columns in the dashboard and their order.
  
  o **CM_Item_ChangeHistory_Columns**
    
    Changes the columns displayed for an item revision.

  o **CM_CNR_ChangeHistory_Columns**

    Changes the columns displayed for an enterprise change notice.

    For more information, see the *Preferences and Environment Variables Guide*.

---

**Replacing part instances using Mass Update**

**About replacing part instances using Mass Update**

You can make bulk updates to multiple assemblies as part of a change management process or in a single step using the Mass Update wizard. For example, you can identify and automatically replace every occurrence of an impacted part with its solution item.
The Mass Update wizard automates the check-out/check-in process and the creation of the necessary revisions of assemblies. It also tracks the assemblies that you cannot edit (for example, because they belong to another group). You view the results of the mass update as a report.

Updates associated with a change management process are performed in two phases:

- **Authorization of the mass update** during an enterprise change request (ECR).
- **Running the updates** during an enterprise change notice (ECN).

You can replace parts in nine different ways, including replacing, removing, adding, and manually updating (revising parts that are released). You can also add, modify, and remove updates associated with the change object during the ECR and ECN processes before they are executed.

The updates are stored in the folders of the associated change object or in the Newstuff folder if you perform the update without a change object. For example, new assembly revisions are automatically added to the Solution Items folder.

For more information about change folders, see *Relating items to a change and the properties required*.

**Note**

- By default, the **Mass Update** command is available to all users. Siemens PLM highly recommends that you suppress access to this command using the Command Suppression application. It controls the suppression of the **Mass Update** menu option based on a user's group or role.

  To learn how to suppress the **Mass Update** menu option, see the *Application Administration Guide*.

- Mass updates are only performed on data in a local database. The updates do not span globally to other site databases.

- Mass updates are only structural replacements. If you have additional data, such as torque information, you need to update it manually.

- You must have the necessary permissions to perform a mass update and Change Manager must be configured for mass updates.

  For more information about permissions and other configurations that are necessary for mass update in a change management process, see *Configuring part replacement*. 
The Teamcenter change management process does not support displaying substitutes on separate BOM lines in Structure Manager. Turn off the substitutes display (set PSEShowSubstitutesPref to 0) when working with change-management related features.

Types of part replacements you can perform

Nine operations are available from the Mass Update wizard for replacing part instances as listed in the examples. The operations allow you to replace parts, make substitutes, or manually update the assembly.

For more information about substitutes, see Getting Started with Product Structure.

The examples show the assemblies released in the end state. However, the state of the assemblies depends on the workflows of the enterprise change notice (ECN) at the time the replacement occurs.

• Replace Part
Replaces the target part in a structure if the target part has no substitutes or if it is the preferred substitute.

  o If the target part is an alternate substitute, it is not replaced.

  o If the target part is a preferred substitute, all the alternate substitutes are retained with the replacement part.

<table>
<thead>
<tr>
<th>Example</th>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the replacement is</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Asm123/A P1/A</td>
<td>P1/A</td>
<td>P2/C</td>
<td>Asm123/B P2/C</td>
</tr>
</tbody>
</table>

• Replace Part and Keep as Substitute
Replaces the target part in a structure if the target part has no substitutes or it is a preferred substitute. If the target part is an alternate substitute, it is not replaced. The target part is added as an alternate substitute after the target part has been replaced.

<table>
<thead>
<tr>
<th>Example</th>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the replacement of the part as a substitute is</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Asm123/A P1/A</td>
<td>P1/A</td>
<td>P2/C</td>
<td>Asm123/B P2/C</td>
</tr>
</tbody>
</table>
**Replace Substitute**

Replaces the target part in a structure if the target part is an alternate substitute. If the target part has no substitutes or the target part is a preferred substitute, it is not replaced.

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the replacement of the substitute is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A P1/A</td>
<td>P1/A</td>
<td>P2/C</td>
<td>Asm123/B P1/A P2/C</td>
</tr>
</tbody>
</table>

**Add Part**

Adds a part to a structure that contains the target part, regardless of whether or not the target part has substitutes or whether the target part is the preferred or alternate substitute. The part is added to the structure and you must reposition the component within the structure.

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the addition is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A P1/A</td>
<td>P1/A</td>
<td>P2/C</td>
<td>Asm123/B P1/A P2/C</td>
</tr>
</tbody>
</table>

**Add Part as Substitute**

Adds a part to a structure as an alternate substitute to the target part, regardless of whether or not the target part has substitutes or if the target part is the preferred or alternate substitute. The part is added as an alternate substitute to the target part and you must reposition the component within the structure.

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the addition is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A P1/A</td>
<td>P1/A</td>
<td>P2/C</td>
<td>Asm123/B P1/A P2/C</td>
</tr>
</tbody>
</table>

**Remove Part and Substitute**

Removes the target part in a structure if the target part has no substitutes or it is a preferred substitute.

- If the target part is an alternate substitute, it is not removed.
If the target part is a preferred substitute, all the alternate substitutes are removed with the target part.

**Example**

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the removal is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A PX/A P1/A</td>
<td>PX/A</td>
<td>None</td>
<td>Asm123/B</td>
</tr>
</tbody>
</table>

- **Remove Part and Keep Substitute**
  - Removes the target part in a structure if the target part has no substitutes or it is a preferred substitute.
  - If the target part is an alternate substitute, it is not removed.
  - If the target part is a preferred substitute, the first alternate substitute becomes the preferred substitute.

**Example**

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the removal is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A P1/A P2/C P3/C</td>
<td>P1/A</td>
<td>None</td>
<td>Asm123/B P2/C P3/C</td>
</tr>
</tbody>
</table>

- **Remove Substitute**
  - Removes the target part in a structure if the target part is an alternate substitute. If the target part is not a substitute or is the preferred substitute, it is not removed.

**Example**

<table>
<thead>
<tr>
<th>If the assembly is</th>
<th>And the target is</th>
<th>And the replacement is</th>
<th>Then the result of the removal is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asm123/A P1/A P2/C P3/C</td>
<td>P2/C</td>
<td>None</td>
<td>Asm123/B P1/A P2/C P3/C</td>
</tr>
</tbody>
</table>

- **Manual Update**
  - Revises structures that contain the target part and does not make any structural changes. It does this regardless of whether or not the target part has substitutes or whether the target part is a preferred or alternate substitute. You must manually make the changes to the revised structures.
Good part replacement practices

- By default, the Mass Update command is available to all users. Siemens PLM highly recommends that you suppress access to this command using the Command Suppression application. It controls the suppression of the Mass Update menu option based on a user's group or role.

  To learn how to suppress the Mass Update menu option, see the Application Administration Guide.

- Be sure to select Propagate relations when deriving the enterprise change notice (ECN) from the enterprise change request (ECR) to include the mass updates in the Problem Items and Impacted Items folders of the ECR.

- If you want to make a series of updates within the same change management process, select Manage Update to display the Manage Updates dialog box and add or remove updates.

  For more information, see Manage part replacements during an ECR.

- If no single user in your organization has permission to update all the assemblies in one mass update, rerun the mass update and attempt any updates that failed the first time. You could also use workflow access controls to grant permission to the user at the appropriate step in the mass update.

- When performing updates under a change management process, you can automatically submit all the updates to workflow as a single package.

Performing part replacement under change management

Authorize part replacements during an ECR

During an enterprise change request (ECR) change process, you can authorize the updates to be made to an assembly. Authorizing the updates is the first step in the two-step change management process. The second step is running the updates, which can be done in the enterprise change notice (ECN) that is derived from the ECR.

After the authorization of the update in the ECR, an authorization report appears. The authorization report is attached to the change object, along with all the operational data that tells what mass update changes are to be performed during the ECN.

Before the update is run, you can validate and fix any synchronization issues with the update. You can also add or remove updates.

For more information, see Manage part replacements during an ECR.
Note You must have write access to add items to the **Problem Items** and **Impacted Items** folders of the change object.

For more information, see *Configuring the replacement of parts with change management*.

1. If necessary, **create an ECR** to track the updates and **submit it to workflow**.

2. In My Teamcenter or Change Manager, select the part on which to base the change (an item revision) or the ECR.

3. Choose **Edit→Mass Update**.

   The Mass Update wizard appears.

4. From the **Operation** list, select the type of operation you want performed during the mass update.

   For more information about the types of operations you can perform, see *Types of part replacements you can perform*.

5. In the appropriate boxes of the Mass Update wizard, **search for the parts and change objects** to be included in the authorization. If you selected a change object or a target part when you started the mass update, the object or part is already entered. If you selected to remove a part or perform a manual update, you do not select a replacement or additional part.
• **Target**
  The part on which to base the change. The target part is used to identify the assemblies that are impacted by the mass update.

• **Change object**
  The change object in which to store the parts, the requested updates, and the results of the mass updates.
  
  **Note** The change object that you select must be in an ECR workflow and have no updates associated with it. If the change object you select contains an update, select a different change object or select Manage Update to manage the updates associated with the change object.
  
  For more information, see Manage part replacements during an ECR.

• **Replacement/Add**
  The part to be replaced or added to the target part, depending on the operation selected for the mass update. Defining a replacement part is not required if you are removing a part or performing a manual update.
  
  **Note** The boxes that appear depend on the operation selected.

A thumbnail of the parts appear in the Mass Update wizard.

6. Choose the following options beneath the parts:

   - Click **Add to Problem folder** to store the target part in the change object’s Problem folder.

   - Click **Add to Solution folder** to store the replacement part in the change object’s Solution folder.

     **Note** The labels of these options is Add to Newstuff folder until you select a change object.

7. Click **Next**.

8. On the **Select the impacted Parts to update** page, in the Select column, select the impacted assemblies you want to update. You can only select assemblies to which you have write permission.
Tip

- If you cannot edit an assembly, an X appears in the Updateable column.

There are many reasons why you cannot edit an assembly, including not having write access to it, the assembly does not belong to you, or the mass update operation does not perform that type of replacement or substitution (for example, the part already has an alternate substitute or it is the preferred substitute). Review the operations for any limitations on substitutes.

- To help make the selection process easier, enter a keyword in the Where Target is used box to filter the table and reduce the amount of information being displayed.

- To remove all table keyword filters in the Where Target is used box, click Erase.

- To select all assemblies, click Select All and to clear the selection, click Deselect All.

9. Click Next.

The Review the Mass Update and Execute, Save or Cancel page appears.
10. Confirm the selection and select **Save As Update**.

   The results of the update appears.

11. Review the results of the mass update, and select **Close**.

   **Note** You can also select **Manage Update** to display the **Manage Updates** dialog box and add or remove updates. This is particularly helpful if you want to make a series of updates within the same change management process.

   For more information, see **Manage part replacements during an ECR**.

   The Mass Update wizard updates the **Problem** and **Impacted** folders of the change object. It also adds the results of the update to the ECR.
Search for parts or change objects during part replacement

1. In the Mass Update wizard, in the **Target, Add/Replacement** or **Change object** box, enter the search criteria for the part or change object and click the **Search** tool, as shown in the figure. The figure shows the Mass Update wizard when adding a part.

**Note**
Entering a change object is optional when performing a mass update in a single step using My Teamcenter.
2. In the **Search** dialog box that appears, enter additional search criteria and click **Search**.

   **Tip** To clear the search criteria, click **Clear**.

3. From the table, select the part or change object.

   **Tip** The table displays a maximum of 10 items. Use the buttons along the bottom to navigate through the table. You can also click a number to go to that page.

4. Click **OK**.

**Manage part replacements during an ECR**

You can manage the updates to an enterprise change request (ECR) while they are still under the control of the ECR process (they have been authorized but not run). For example, you can add additional updates or remove an update.

1. In My Teamcenter or Change Manager, select either a part or the ECR with the authorized update.

2. Choose **Edit → Mass Update**.

   The updates that have already been added appear.
3. Do one of the following:

   - To remove an update, select the update and to the right of the table, click X.

   - To add updates, click Add As Update to display the Mass Update wizard. To authorize another update, see Authorize part replacements during an ECR.

   Note: You cannot change the change object selection. The change object is locked because the update is associated with that change object.

Run part replacements during an ECN

After the enterprise change request (ECR) authorizing a mass update is approved, start an enterprise change notice (ECN) to run the mass update.

The process updates the Solution Items folder of the ECN.

Note: You must have write access to add items to the Solution Items folder of the ECN.

1. Derive an ECN from an ECR that contains an authorized mass update and submit it to workflow.

   Note: Be sure to select Propagate relations when deriving the ECN from the ECR to include the mass updates in the Problem Items and Impacted Items folders of the ECR.

2. In My Teamcenter or Change Manager, select either a part (item revision) or the ECN with the authorized update.


   The Manage Update dialog box appears showing the updates to be run.
4. Click **Execute**.

A **Mass Update Execution** report appears with the results of the mass update.

5. Review the report, and if necessary, fix any problems and run the parts replacement again.

The mass update creates a new revision for all the released assemblies, checks out all the assemblies to which you have write access, and adds the results in the **Mass Update Execution** report to the ECN.

---

**Rerun part replacements during an ECN**

During an open enterprise change notice (ECN), you can run a mass update again to replace parts if there were failures during the original run that you have corrected.

**Note**  
Rerunning a mass update only performs updates on changes that did not run or failed. Successful updates are not run again.

1. In My Teamcenter or Change Manager, select an ECN with an authorized update.

2. Choose **Edit→Mass Update**.  
The remaining updates to run appear.
3. Click **Execute**.

   A **Mass Update Execution** report appears with the results of the mass update.

4. Review the report.

   The mass update creates a new revision for all the released assemblies, checks out all the assemblies to which you have write access, and adds the results in the **Mass Update Execution** report to the ECN.

   ![Mass Update Execution Report](image)

**Replacing part instances in a single step**

Replace part instances in a single step

Using My Teamcenter, you can replace parts in an assembly in one step. After the update, an authorization report appears, explaining the results of the update. You can optionally select a change object in which to store the updates. If you do not select a change object, the updates are stored in your **Newstuff** folder.

For more information about the folders, see *Folders that store the part replacements*.

**Note** You must have write access to the assemblies to be updated.

1. In My Teamcenter, select the part on which to base the update.
2. Choose **Edit→Mass Update**.
   The Mass Update wizard appears.

3. From the **Operation Type** list, select the type of operation you want performed during the mass update.
   For more information about the types of operations you can perform, see **Types of part replacements you can perform**.

4. In the appropriate boxes of the Mass Update wizard, **search for the parts** to be included in the mass update.
   - **Target**
     The part on which to base the change. The target part is used to identify the assemblies that are impacted by the mass update.
   - **Replacement/Add**
     The part to be replaced or added to the target part, **depending on the operation selected for the mass update**. Defining a replacement part is not required if you are removing a part or performing a manual update.
   - **Change object**
     The change object in which to store the parts, the requested updates, and the results of the mass updates.
Note

- The boxes that appear depend on the operation you selected.
- Selecting a change object is optional when performing a single-step process. If you do not select a change object, the updates are stored in your **Newstuff** folder.

Thumbnails of the parts appear in the Mass Update wizard.

5. Beneath each part, click **Add to Newstuff folder** to store the results of the update in the **Newstuff** folder.

Note

Select the **Add to Newstuff folder** to ensure you have an update history. You can use Audit Manager to view who performed the operation.

6. Click **Next**.

7. In the **Select** column of the **Select the impacted Parts to update** dialog box, select the impacted assemblies you want to update. You can only select assemblies to which you have write permission.

Tip

- If you cannot edit an assembly, an X appears in the **Updateable** column.

There are many reasons why you cannot edit an assembly, including not having write access to it, the assembly does not belong to you, or the mass update operation does not perform that type of replacement or substitution (for example, the part already has an alternate substitute or it is the preferred substitute).

Review the operations for any limitations on substitutes.

- To help make the selection process easier, type a keyword in the **Where Target is used** text box to filter the table and reduce the amount of information being displayed.
• To remove all table keyword filters in the Where Target is used text box, click **Erase**.

• To select all assemblies, click **Select All** and, to clear the selection of all assemblies, click **Deselect All**.

8. Click **Next**.

The **Review the Mass Update and Execute, Save or Cancel** page appears.

![Review the Mass Update and Execute, Save or Cancel](image)

9. Confirm the selection and select **Execute**.

The results of the update appears.

![Results](image)

10. Review the results of mass update, and select **Close**.

For more information about the folders, see *Folders that store the part replacements*. 

---

PLM00140 G  
Change Manager Guide  4-47
Folders that store the part replacements

You can optionally store the results of a mass update that you perform in a single step in the **Newstuff** folder, as shown in the figure. The results appear under the subfolder **Mass Update Results** with the actual update stored under a folder with the date of the update. Under the date folder are folders containing the results, which are the same types of folders used to manage a change. A report of the results is also stored in the folder.

- **Problem Item**
  The target item (the item revision that was added or replaced).

- **Impacted Items**
  The assemblies that were impacted by the update.

- **Solution Items**
  The additional or replacement part (the item revision that was added or that replaced the target).
Configuring part replacement

(Recommended) Suppressing the Mass Update command

By default, the Mass Update command is available to all users. Siemens PLM Software highly recommends that you suppress access to this command using the Command Suppression application. It controls the suppression of the Mass Update menu option based on a user's group or role.

To learn how to suppress the Mass Update menu option, see the Application Administration Guide.

Setting up where-used search

For users to be able to see the assemblies that are impacted by the mass update, you must set the MassUpdateDefaultRevRule preference to define the revision rule that is used to perform a where-used search on the target part of a mass update. By default, the rule is Latest Working.

For more information about setting up where-used searches, see the Rich Client Interface Guide.

Configuring the replacement of parts with change management

An administrator must configure the following for users to be able to perform mass updates during a change management process using Change Manager:

- Install Change Manager
  Mass updates use the CM_Massupdate_Support_Change preference to activate change object support. The preference is automatically installed when Change Manager is installed. By default, it is set to true, indicating that Change Manager is installed.

  If the preference does not exist (that is, Change Manager is not installed) or it is set to false, mass updates do not work with a change object, but they do work outside of Change Manager using the single-step process in My Teamcenter.

  For more information, see Replacing part instances in a single step.

- Configure Change Manager to allow access to change objects and their folders
  Mass update relies on the Business Modeler IDE conditions and rules being used in Change Manager to determine what change objects and folders it can access. Therefore, the change states of the change object (Closure, Maturity, and Disposition) must be set so mass update can access the folders associated with the object and change the item revisions.

  In addition, users performing a mass update must be in the correct group and be participants of the change management process. Otherwise, the conditions prevent the users from adding objects to the Problem, Impacted Items, and Solution folders.

  Because you could easily collect so many assemblies that no single user in your organization has permission to update them all, Mass Update wizard is set up to allow you to rerun updates and attempt any updates that failed the first time.
You could also use workflow access controls to grant permission to the user at the appropriate step.

The following shows the default conditions set for all change objects: problem report, enterprise change request, and enterprise change notice.

- To add item revisions to the Problem Items or Referenced Items folders:
  - Must be Analyst or Requestor
  - AND
    - Disposition: None  Maturity: Elaborating (Default) (until the Reviewing stage)
  - OR
    - Analyst
  - AND
    - Disposition: Investigate  Maturity: Reviewing (once in Review, but only if Investigate (that is, rework)

- To add item revisions to the Impacted Items folder:
  - Must be Analyst
  - AND
    - Disposition: None  Maturity: Elaborating (Default) (Before Review, first time round)
  - OR
    - Disposition: Investigate  Maturity: Reviewing (Default) (after review rework required – second time round)

- To add item revisions to the Solution Items folder:
  - Must be Analyst
  - AND
    - Disposition: Approved  Maturity: Executing (Only when running an approved change)
  - OR
    - Disposition: Investigate  Maturity: Reviewing (Default) (after review rework required – second time round)

For more information about setting change states using Business Modeler IDE conditions, see About configuring conditions to control the actions of participants.

- Specify objects that can be added to folders

Use the following preferences to define the Generic Relationship Management (GRM) rules to use when adding item revisions to the Problem, Impacted Item, and Solution folders. GRM rules limit what objects can be pasted to other objects.
Developing and implementing changes

For more information about GRM rules, see Business Modeler IDE Guide.

- **CM_Massupdate_Problem_PseudoFolder**
  Specifies the GRM rule to use when adding problem parts to a change object.

- **CM_Massupdate_Impacted_PseudoFolder**
  Specifies the GRM rule to use when adding impacted parts to a change object.

- **CM_Massupdate_Solution_PseudoFolder**
  Specifies the GRM rule to use when adding solution parts to a change object.

- **Set the types of change objects**
  Use the following preferences to specify the types of change objects with which the mass updates can be performed:

  - **CM_massupdate_allowed_ECN_types**
    Change Manager change object revision types that are used for ECN operations. By default, it is set to ChangeNoticeRevision.

  - **CM_massupdate_allowed_ECR_types**
    Change Manager change object revision types that are used for ECR operations. By default, it is set to ChangeRequestRevision.
Chapter 5  

Scheduling implementation activities

About scheduling implementation activities ......................... 5-1
Example of a schedule work breakdown ................................. 5-3
Work Breakdown Schedule Manager view ............................. 5-4
Create a work breakdown using Schedule Manager .................. 5-6
Roll up objects associated with a change object .................... 5-7
Display a schedule work breakdown .................................... 5-8
Managing change items associated with a schedule task .......... 5-9
  About managing change items associated with schedules ........ 5-9
  Display the change items associated with a schedule .......... 5-10
  Manage the change items associated with a schedule using the Open Task view .................................................. 5-11
  Manage the change items associated with a schedule using the Change Details view .............................................. 5-12
Propagating change items to schedules ............................... 5-13
  About propagating change items to schedules ..................... 5-13
  Example of propagating change items to a schedule .......... 5-14
  Configuring who can propagate change items to schedules .... 5-16
  Propagate change items to schedules ............................... 5-17
  Propagate change items to selected schedule tasks .......... 5-19
  Propagate change items to schedules through a workflow .... 5-22
Chapter

5  Scheduling implementation activities

About scheduling implementation activities

Schedule Manager is integrated into Change Manager so you can use it to schedule implementation activities (work breakdowns) associated with a change. The Plan Items folder stores the work breakdowns. Creating work breakdowns are useful to:

- Analyze the impact of the change to determine the amount and scope of the work required for the change. It can also identify the parts and documents impacted by the change.

- Plan the implementation of the change to specify the actions, or tasks, that address the change.
Example of a schedule work breakdown

Whether you create a work breakdown and define tasks depends on the complexity of the change and the conventions at your site. A simple change request, for example, may require relationships only to affected parts, affected documents, and supporting information, while a more complex change requires information about subassemblies or other components that only becomes clear after detailed analysis. In addition, during the change creation, you may not know what other items must be added until the tasks are built and executed.

Schedules can be created in an ad-hoc manner to meet the requirements of each individual change object, or they can be created (copied) from a schedule template. A schedule template is a pre-defined schedule of tasks that is established for changes of a specific type. When you plan the implementation for such a change, you start with the corresponding schedule template. Any number of schedules can be defined and related to a change object.

The schedule can have tasks for each discipline or user to create new revisions or items and then make the changes to implement the proposed solution. Depending on the change work to be done, you could have one task per assignee that covers the changes for any number of items assigned to that user, or you could have one task per problem item or impacted item, or any other style of work breakdown you choose.

Because schedule tasks are not routed to users, it is good practice to have a simple one-step workflow task associated with each schedule task, as shown in the figure.
The workflow routes the schedule task to the assignee’s inbox and manages the implementation of the task. The resource associated with the schedule task is automatically assigned as the user to perform the workflow task. If more than one user is assigned to the schedule task, the single privileged user is assigned to the workflow. The workflow could include tasks to approve the changes made to each item revision, or this type of validation can be left to a later step (a later task in the schedule or a later workflow task in the ECN workflow). This would apply a status (for example, Pre-Released).

**Flexibility of schedules**

The advantage of a schedule is its flexibility. A schedule can easily be made larger or smaller, depending on the need. By contrast, workflows are much more rigid as they control the process and decision-making authority. Workflows should be kept simple, and schedules used when more complexity is required. Typically schedule templates are used to make defining the schedule for a particular ECR or ECN much quicker.

An analyst usually creates a work breakdown schedule, but another type of user can create it, and the analyst can then relate the schedule to the change object through the Plan Items or Work Breakdown relationship.

**Example of a schedule work breakdown**

The following is a simple example of a work breakdown for an enterprise change notice (ECN 123). The work breakdown was created based on a standard schedule template (shown in the figure with dashed lines). The schedule was then modified to meet the ECN’s requirements, creating copies of the Update Mechanical Piece Parts task for the two designers involved (Bill and Laura). Each of those tasks has the same small workflow template attached, which routes the task to the assignee (for example, Bill), then routes it for review of the changed and new items, and finally adds a status to them.
Work Breakdown Schedule Manager view

You use the **Work Breakdown Schedule Manager** view to display the structure of the schedule and task breakdown or modify or create a new one. Schedule Manager must be installed to see this view.
1 Schedule Manager view  Lists all the work breakdown tasks created in the schedule.

2 Open Task view  Displays the change folders associated with the task:
- **ImpactedItems**
- **ProblemItems**
- **ReferenceItems**
- **SolutionItems** (ECN only)

You can add items to the change folders and quickly propagate the folders.

After a task is complete, you can roll the change items in the task folders to the change object folders.

3 Roll Up view  Provides viewing of the entire work breakdown structure at a glance, letting users see the contributions from the tasks.

You can then roll these tasks up to the change object, saving you from having to relate them manually. For example, you can roll up the item revisions in your task folders to the change object folders. Once the change is complete, you can make the rolled-up objects permanent by committing them.
Create a work breakdown using Schedule Manager

For more information on work breakdowns, see About scheduling implementation activities.

Note  You can copy an existing schedule but it can only be associated with one change object.

1. Select the Plan Items folder of the enterprise change request (ECR) or enterprise change notice (ECN) for which you want to create a work breakdown.

   For an ECR or ECN, you can add objects to the Plan Items folder if you are an assigned participant and the change object property settings are as follows.

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure</th>
<th>Disposition</th>
<th>Maturity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open</td>
<td>None</td>
<td>Elaborating</td>
</tr>
<tr>
<td>or</td>
<td>Open</td>
<td>Investigate</td>
<td>Reviewing</td>
</tr>
</tbody>
</table>

2. Choose File→New→Schedule.

   This starts the New Schedule wizard in Schedule Manager where you create your work breakdowns.

   You can create several schedules to help you analyze the change.

   For more information about creating schedules, see the Schedule Manager Guide.

   Note  You must be an Author user to create schedules.

3. In the Open Change view, select the schedule in the Plan Items folder and click the Open Schedule button.

   The Schedule Manager view appears.

4. Add tasks to your schedules.

   For more information about adding tasks, see the Schedule Manager Guide.

5. Assign resources to tasks, including selecting responsible people using the Membership button.

   For more information about managing resources and assigning resources to tasks, see the Schedule Manager Guide.

6. In the Schedule Manager view, click the View Task folders button.

   Change Manager displays the Open Task view.
7. Add change items to be associated with the tasks, as necessary.
   For more information about adding change items, see Managing change items associated with a schedule task.

8. (Optional) Roll up the item revisions in your task folders to the change object folders.
   For more information about rolling up objects, see the Roll up objects associated with a change object.

### Roll up objects associated with a change object

The Roll Up view displays all objects in the folders of the selected change and its associated work breakdown tasks at one level, eliminating the need to look through multiple levels of the work breakdown structure. This view is static and the related objects are not moved. You can also roll up the objects to the change object and commit the changes.

For more information about rolling up objects, see About scheduling implementation activities.

1. Double-click the change object in the Change Home view and select the change object in the tab that just opened.

2. Click the Rollup button.

The Roll Up view displays the objects, its folders, and tasks.

3. In the Roll Up view, click the list button of the Commit Rollup button and select the relations to commit.
Chapter 5  

*Scheduling implementation activities*

A message appears asking you if you want to commit the changes.

4. **Click OK.**

5. To commit the rollup, click the **Commit Rollup** button in the view.

The objects committed appear with a check next to their names and the objects appear in the change folders.

---

**Display a schedule work breakdown**

- In the **Open Change** view, select the schedule in the **Plan Items** folder you want to display, and click the **Open Schedule** button 📊.
The schedule appears in the **Schedule Manager** view.

**Managing change items associated with a schedule task**

**About managing change items associated with schedules**

A complex change can have dozens or hundreds of problems, impacted, and solution items. It is more efficient to manage these under a single change object with the assistance of one or more change plan items (schedules).
When you create a schedule task associated with a change object, you can add the change items to be worked on to the task so users can quickly access them. The items associated with a schedule task appear in the Open Task view.

You can quickly add and remove items from the change. In addition, you can work on multiple items at once and also propagate change items to a schedule task.

Note For more information, see *Propagating change items to schedules*.

**Display the change items associated with a schedule**

- In the Schedule Manager view in Change Manager, click the View Task folders button.
  
  The Open Task view appears.
Manage the change items associated with a schedule using the Open Task view

You can manually add change items to the folders of a schedule.

**Note** You can also propagate change items to the folders of a schedule task. For more information, see [Propagating change items to schedules](#).

1. In the Schedule Manager view, click the View Task folders button to display the Open Task view.
2. Select a task folder, such as the **Solution Items** folder, as shown above.

3. Paste the item revision (for example, **New Lens**) into the folder. You also see the item revision appear in the **Roll Up** view.

**Manage the change items associated with a schedule using the Change Details view**

You can use the **Change Details** view to add and remove change items associated with a schedule task. In addition, you can add multiple items at once.

**Note** You can also propagate change items to a schedule task.

For more information, see *Propagating change items to schedules***.

1. In the **Schedule Manager** view in Change Manager, right-click a schedule task and choose **Change Details**.

The **Change Details** view displays the change associated with the task (the Parent Change). It also displays each folder (problem, impacted, reference, and, if applicable, solution items) associated with the tasks and its contents.
2. Use the **Cut**, **Copy**, and **Paste** tools, as appropriate, to add or remove items from the folders of the schedule task.

### Propagating change items to schedules

#### About propagating change items to schedules

You can selectively propagate the items related to a change object (problem, impacted, solution, and reference items) to related plan items (schedule tasks) associated with the change object, as shown. This allows you to quickly associate the change items to be worked on during a task with the task so a user can easily access them. For example, you can propagate the assembly with the problem bumper to the scheduled task so the user can replace the bumper with a new one.

You can choose to associate all the items in a folder or just individual items. You can initiate the propagation from a change object (change notice, change request, and deviation request) or from a schedule. Your workflow administrator can also set up a workflow to propagate change items to a schedule through a workflow process.
Example of propagating change items to a schedule

Company ABC has a problem with the bearing in a compressor assembly. In addition, the vibration sensor needs to be changed. It is a large change, and Company ABC will use a schedule to plan and implement all the tasks.

Enterprise change notice (ECN)

Company ABC creates an enterprise change notice to manage the change.
Scheduling implementation activities

The change analyst creates two separate schedules, one for the mechanical designer and one for the electrical. These schedules require different items for each user. For example, the mechanical designer requires the mechanical items (bearing, housing, shaft, and the compressor assembly), while the electrical designer requires the electrical items (bearing vibration sensor and the compressor monitoring system). The change specialist propagates the items as appropriate to the different schedules.

Participants

- **Change specialist**: Manages change items, including the propagation of the items to the schedules.

- **Change analyst**: Creates and manages the high-level plan.

- **Team leader**: Creates and manages the detailed plan.

- **Team members**: Execute the work. Change Manager automatically updates their work status.
Propagation

Using the Change Manager propagate capability, a change specialist relates the objects attached to the ECN (problem and impacted items) to the two schedule tasks in the plan.

Completion

After creating new revisions of the impacted items in the Solutions items folder of the schedule, the designer who created them, pastes them in the Solution items folder of the ECN.

Configuring who can propagate change items to schedules

By default, a change specialist or the user assigned to a task can propagate change items in change folders to schedule folders. In earlier versions of Teamcenter, this was hard-coded in the conditions. Now, you can use Business Modeler IDE conditions.
that begin with Cm0 to control how the propagation is handled and they must be met for the propagation to be successful. These conditions call the Teamcenter conditions that had hard-coded the propagation. Therefore, if you have used those conditions, you still receive the configurations defined in them.

<table>
<thead>
<tr>
<th>The condition</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cm0isCMHasImpactedItemCreatableForTask</td>
<td>isCMHasImpactedItemCreatableForTask</td>
</tr>
<tr>
<td>Cm0isCMHasProblemItemCreatableForTask</td>
<td>isCMHasProblemItemCreatableForTask</td>
</tr>
<tr>
<td>Cm0isCMHasSolutionItemCreatableForTask</td>
<td>isCMHasSolutionItemCreatableForTask</td>
</tr>
<tr>
<td>Cm0isCMReferencesCreatableForTask</td>
<td>isCMReferencesCreatableForTask</td>
</tr>
</tbody>
</table>

The following shows the expression for Cm0isCMHasImpactedItemsCreatableForTask calling in isCMHasImpactedItemCreatableForTask:

\[
\begin{align*}
\text{(Condition::isAnalyst(c, u)} & \quad \text{OR} \\
\text{t.fnd0isTaskAssigneed()) AND Condition::isCMHasImpactedItemCreatableForTask(c,u)}
\end{align*}
\]

For more information about configuring Change Manager conditions, see Configuring conditions to control the actions of participants and the Business Modeler IDE Guide.

### Propagate change items to schedules

You can propagate the items related to a change object in its Solution, Problem, Impacted, or References folders to selected schedules.

The change items are propagated to the lowest tasks in the selected schedules (those with no children, referred to as leaf-level tasks). For example, when you select to propagate the change items to the ECN–Sched1 schedule, the items are propagated to the highlighted leaf-level tasks:

1. In the Change Home, My Open Changes, or the Open Change view, display the change object.
2. Do one of the following:
   - To select all the schedules associated with the change object, select the **Plan Items** folder.
   - To select one or more schedules, expand the **Plan Items** folder and select one or more schedules, as shown for selecting **ECN-Sched1** in the **Open Change** view.

3. From Change Manager, choose **Tools**→**Propagate Folder Contents**. Change Manager validates that the propagation can be performed, and if it can, it displays the **Propagate Folder Contents** box.

4. (Optional) Click the link next to the change object to view its properties.
5. In the **Select Items to Propagate** tree, do one of the following:
   - To include all the items in a folder, select the check box next to the folder.
   - To select one or more items in a folder, expand the folder and select the individual items.

6. Click **Finish**.

   If you do not have access to create any of the relationships, access to one or more selected objects, or the conditions are not met, Change Manager processes all the actions that are allowed. It displays a message indicating what relationships were not created. It does not report on successes. It also ignores that an item might have already been propagated.

   ![Propagate Folder Contents Information](image)

   **Note** You may need to refresh Teamcenter to view the propagated change items.

**Propagate change items to selected schedule tasks**

You can propagate the items related to a change object in its **Solution**, **Problem**, **Impacted**, or **References** folders to the related schedule tasks.

The following explains how to initiate the propagation from a schedule. When you initiate the propagation from the schedule, you can select the individual tasks to which you want the items to be propagated.
1. In the Schedule Manager view in Change Manager, select the schedule or schedule tasks to which you want to propagate the change items.
   - If you select a schedule, the change items are propagated to the lowest tasks in the schedule (those with no children, referred to as leaf-level tasks). For example, if you select to propagate the change items to ECN-Sched1, the items are propagated to the following tasks:
     ![Schedule Manager view](image)
     - If you select a schedule summary task, Change Manager propagates the change items to all leaf-level tasks change folders but not to the schedule summary task.
     - If you select a summary task (task with sub-tasks), Change Manager propagates the change items to all leaf-level tasks change folders under the selected summary task but not to the summary task itself.
     - If you select a leaf-level task (task with no sub-tasks), Change Manager propagates the change items to the selected leaf-level tasks change folders.

   **Note**
   - The selected schedules must have the same parent change object.
   - A proxy task does not have change folders, so it is grayed and you cannot select it.
   - A milestone task does have change folders, and you can propagate change items to it.

2. From Change Manager, choose Tools → Propagate Folder Contents.
   Change Manager validates that the propagation can be performed, and if it can, it displays the Propagate Folder Contents box. The following shows the Propagate Folder Contents box when one schedule task is selected.
• The schedule or tasks you selected appear in the **Propagate To** list. The change items are propagated to them.

• The items associated with the change object appear in the **Select Items to Propagate** list.

3. (Optional) Click the link next to the associated change object to view its properties.

4. In the **Select Items to Propagate** tree, do one of the following:
   • To include all the items in a folder, select the check box next to the folder.
   • To select one or more items in a folder, expand the folder and select the individual items.

5. Click **Finish**.

   If you do not have access to create any of the relationships, access to one or more selected objects, or the conditions are not met, Change Manager processes all the actions that are allowed. It displays a message indicating what relationships were not created. It does not report on successes. It also ignores that an item might have already been propagated.
Chapter 5  

Scheduling implementation activities

Propagate change items to schedules through a workflow

A workflow designer can include the workflow handler **CSI-propagate-folder-contents** as part of a workflow template to propagate change items to all the change folders or the related schedule tasks. The designer can use the arguments to **CSI-propagate-folder-contents** to define:

- Which folders to propagate (problem, impacted, reference and, if applicable, solution).

You need to create a **CSI-propagate-folder-contents** handler for each relation you want propagated. For example, if you want to propagate the change items to all folders, you would create four handlers. The **CSI-propagate-folder-contents** arguments shown are for problem items.
• Types of objects to include or exclude.

• Status of objects to allow or not allow.

• Whether condition checking should be bypassed.

For more information, see the *Workflow Designer Guide*. 
Chapter

6 Managing a change

About managing a change .................................................. 6-1
Initiate a workflow process .................................................. 6-1
View the status of a workflow in Change Manager .................. 6-3
View workflow assignments and their status ......................... 6-4
About classifying changes .................................................... 6-5
Managing the participants of a change ................................. 6-6
   About the participants in the change process ...................... 6-6
   Types of participants .................................................... 6-7
   About dynamic participants .......................................... 6-9
   Assign participants ..................................................... 6-11
About setting change states ................................................. 6-12
About setting change effectivities ....................................... 6-12
   Assign effectivity ....................................................... 6-13
About managing a change

Using Change Manager, you can propose a change to a product, and then manage the entire cycle of investigation, elaboration, review, approval, and implementation of the change. These tasks are typically controlled by workflows that flexibly guide the change through the four phases of the change process. Once selected and configured, the workflow guides each participant through the steps of the process by adding tasks to the My Worklist folder of each participant directing them to perform necessary actions, such as assigning reviewers, reviewing document changes, or entering data.

The work required to manage the change process is:

- Begin the change process.
- Assess the change’s impact on any managed business items, such as parts or documents.
- Assign and modify participants.
- Initiate any workflows and monitor the progress and completion.

Initiate a workflow process

1. Select the change object, and do one of the following:
   - Choose File→New→Workflow Process.
   - Click the Summary view and select New workflow process,

   The New Process Dialog dialog box appears.

2. Type a name for the process in the Process Name box.

3. Type a description to identify the process in the Description box.

4. Click the Process Template list to view process templates and make a selection.

5. Select a Process Template Filter option.
   - (Optional) Select the Show Under Construction Templates check box.
   - To view all available process templates, select the All option.
   - To view only those process templates assigned to your group, select the Assigned option.
The CR_allow_alternate_procedures preference determines whether this property is displayed and whether you can select alternate workflow processes from the New Process Dialog dialog box using the Process Template Filter list.

6. Click the Attachments tab to view or assign target and reference attachments.

It is not necessary to assign target data at the initiation of a process.
- If necessary, generate a list of objects from several sources, including search results, Structure Manager, and other active Teamcenter applications, that can be pasted as references or attachments.
  For more information about pasting objects, see Advanced Paste to generate a list of objects as target or reference attachments.

7. Click the Process Template tab to view the process template selected as the basis of the new process.

8. (Optional) Assign all tasks in the process.
   a. Click the Assign All Tasks tab.
      The system displays the assignment list information.
   b. Select a list from the Assignment Lists list.
      Teamcenter applies the assignment list to the tasks in the process. Users are displayed as nodes in the process tree and the action assigned to the user is displayed to the right of the tree under the Actions heading.
      The select-signoff-team and perform-signoffs subtasks associated with Route, Review, and Acknowledge tasks are not displayed in the tree.
   c. (Optional) Assign responsible parties:
      A. Select the task node in the tree.
      B. Use the Resource Pool Options criteria and search capabilities to select the responsible party.
      C. Click Add (+).
         The system displays the user information and action assigned to that user beneath the task node in the process tree.
      D. Repeat the previous steps to assign a responsible party for other tasks in the process.
   d. (Optional) Assign users:
      A. Expand the task node in the tree to begin to assign users to review, acknowledge, or receive notification of a task.
         The system displays either the Users node or Profiles node.
         - The Users node allows you to assign resources using an ad hoc selection process.
Managing a change

- Profiles limit the pool of users that can be assigned to the task.
  The system displays the Profiles node when user profiles were defined as part of the process template.

B. Select the Users or Profiles node.

C. Use the Group, Role, and User lists to select a user.

D. Select an action from the list.
  The system displays the actions in this list based on the task template type. For example, if a Route task is selected, the Review, Acknowledge, and Notify actions are displayed. If a Review task is selected, only the Review action is available; if an Acknowledge task is selected, only the Acknowledge action is available.

E. Click Add (+).
  The system displays the user information and action assigned to that user beneath the task node in the process tree.

F. Repeat the previous steps to assign users to review, acknowledge, or receive notification of other tasks in the tree.

  Tip You can copy user nodes and paste them in to another task using the Copy and Paste buttons located beneath the tree.

  e. (Optional) Modify or set the quorum value for Review and Acknowledge tasks in the Rev Quorum and Acknow Quorum boxes.

  f. (Optional) To save modifications to the process assignment list, select the Save Modifications Back to List check box.
  
  Note You can only save modifications to personal process assignment lists. Shared lists can be modified, but the changes cannot be saved.

9. Click OK to initiate the process.
  
  Note Click Cancel at any time to cancel the operation without initiating a process.

View the status of a workflow in Change Manager

Within Change Manager, you can view the tasks in a workflow associated with a change object or schedule using the Workflow Viewer as shown. It provides a task view representation of the workflow to which the selected change object or schedule task is submitted.

For more information about the Workflow Viewer, see the Workflow Viewer Guide.

- In a Change Manager view, such as Change Home, right–click a change object or schedule with a workflow submitted, and choose Workflow View.
  The workflow tasks appear in the Workflow Viewer tab.
To learn more about the Workflow Viewer, see the Workflow Viewer Guide.
View workflow assignments and their status

Using the **Summary** view in Change Manager, you can view the tasks in a workflow associated with a change object or schedule, their status, and the assigned participants, as shown for an enterprise change request (ECR). You can also start a new workflow process.
1. In a Change Manager view, such as Change Home, select a change object or schedule with a workflow submitted.

2. Click the Summary tab.
   View the workflow status and assignments.

About classifying changes

Changes are classified to determine the level of approval required.

- **Fast track**
  In a fast track classification, an engineer uses an enterprise change request (ECR) followed by an enterprise change notice (ECN) to develop a solution for a change and implements the change without going through a formal review process. Fast track changes meet prescribed criteria, such as low risk or low cost. Typically, the majority of changes are processed through fast track.

- **Standard track**
  A standard track classification follows a formal change process including change and implementation review boards. They are for changes that do not meet the fast track criteria (for example, for high-risk, high-cost, complex changes). It
requires an ECR, separate ECNs, and an approval process to manage the change implementation and approval. Because of the cost and length of time to make such a change, schedules are typically used to plan and manage the solution development and implementation.

Teamcenter provides an Is Fast Track? property on the ECR that directs changes down one of these two tracks during workflow.

For more information about editing the properties of a change object, see Update a change.

Managing the participants of a change

About the participants in the change process

Different types of users are involved in various phases of the change process.

For example, at the start of the change process, a requestor creates a change object. During the life of the change object, analysts review it, provide input, and implement the change; and change specialists (change administrators) facilitate its movement through the change process. Members of a change review or change implementation board may review and approve or disapprove the change.

The terms requestor, analyst, specialist (administrator), implementation board, and review board refer to roles that participants perform at different steps of the change process. Depending on the complexity of a change, the same person may perform many roles, or many people may perform the same role.

A change specialist assigns users for each participant type used in the change object (for more information, see Assign participants). A change management workflow can then be configured to automatically assign workflow tasks to the appropriate users based on their participant type on the change object.

For example, the workflow can automatically assign the analyst to perform the Implement Change workflow task. These users are referred to as dynamic participants.

Note

- See your workflow administrator for information about how your company’s change management workflows are configured.
  
  For information about extending the dynamic participant types, see the Business Modeler IDE Guide.

- Rules that control who can perform what and at what stage of the change process are defined as Change Manager conditions.
  
  For a general overview of Change Manager conditions, see About configuring conditions to control the actions of participants.

  The set of Change Manager conditions available are listed in the Business Modeler IDE Guide.

- You can also set participants programmatically using the Integration Toolkit (ITK).
For more information, see *Setting participants programatically using ITK*.

### Types of participants

<table>
<thead>
<tr>
<th>Participants</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>Creates a change object or is delegated a change object by another requestor. The requestor is responsible for elaborating the definition of a change and for providing as much detail as possible to define the problem or request at hand. A requestor may perform the elaboration, or a change specialist may delegate responsibility for elaborating a change to another user (an analyst or requestor). When you create a change object, you are its requestor. If responsibility is delegated to another user, that user becomes the current requestor and you are no longer the requestor.</td>
</tr>
<tr>
<td>Analyst</td>
<td>Assesses the technical feasibility of a change or the technical feasibility of implementing the low-level details of a change. An analyst elaborates the details of a change by providing a technical recommendation, performing an impact analysis, and planning the implementation. The analyst may perform the implementation or delegate the work to others. During the implementation phase, the analyst monitors the change execution and is ultimately responsible for ensuring the implementation is performed correctly and according to the plan. This person is generally a senior technical person with knowledge of technical issues and a site’s products and business goals.</td>
</tr>
</tbody>
</table>
| Change specialists (change administrators) | Facilitates and manages movement of a change or deviation through the appropriate processes at a site. Change specialists also work to continuously improve the change process itself: They have an understanding of product definitions and a site’s change process. There can be three levels of change specialists:  
  - Change specialist I is responsible for coordinating the flow of problem reports, deviation requests, and ECRs through the analysis phase, preparing cost estimates for complex ECRs, and creating the agenda for change review board meetings. Change specialist I also chairs those meetings. |
### Participants Description

- Change specialist II prepares ECNs for implementing approved ECRs by identifying those that can be grouped and implemented with one ECN. The item and document impact matrix within the ECN form provides an ideal road map for the change implementation board to develop a detailed implementation plan. Change specialist II strives to minimize the cost of implementing approved ECRs while also achieving end-item traceability. ECNs are released to the change implementation board on the basis of the ECR priorities and available capacity.

  Change specialist II does not initially appear in Change Manager by default. Modify the `isChangeSpecialist2Assignable` condition so a user can be assigned as change specialist II. For more information, see the *Business Modeler IDE Guide*.

- Change specialist III audits ECN packages to assure continuity between superseded and superseding documentation, records, and data. ECNs and detailed implementation plans are used as checklists of audit requirements. Change specialist III releases documents, records, and data that conform to these requirements. Change specialist III is essentially an inspection function, and the objective is to streamline the process and eliminate the need for inspection.

  Change specialist III does not initially appear in Change Manager by default. Modify the `isChangeSpecialist3Assignable` condition so a user can be assigned as change specialist III. For more information, see the *Business Modeler IDE Guide*.

| Change review board | Reviews, approves, and authorizes enterprise change requests and deviation requests. The review board makes a business decision about whether a change or deviation request should proceed. Review board members are generally senior individuals from various functional areas within a site or individuals who have expertise in some aspect of a change or deviation. |
### Participants Description

| Change implementation board | Reviews, approves, and authorizes change notices. This group reviews the detailed implementation plan for an enterprise change notice and makes a technical decision about whether to implement the planned change. The group also makes an implementation plan.  
  
The membership of the implementation board generally includes both people with technical knowledge and managers with control of resources and schedules. Membership may vary depending on the complexity, cost, and other characteristics of a change. |

#### About dynamic participants

Dynamic participants are workflow handlers that automatically assign users to perform different workflow tasks based on the participant types assigned to a change object that has been submitted to workflow. The default participant types include **Analyst**, **ChangeSpecialist1**, and **Requestor**, as well as others. (For more information about participant types, see *Types of participants*.)

A change specialist uses the **Assign Participants** command to assign participants for a change object. Then, when the workflow that is configured for dynamic participants reaches a task and needs to determine who the participants are, the workflow looks at the current assignee for the participant type (for example, **Reviewer** for a **Review** task) and sends it to that user’s inbox. If the user assigned to a participant type changes after the workflow starts, the workflow automatically recognizes the new user for any tasks that have not started.

---

**Participants**
- Change implementation board

**Description**
- Reviews, approves, and authorizes change notices. This group reviews the detailed implementation plan for an enterprise change notice and makes a technical decision about whether to implement the planned change. The group also makes an implementation plan.
- The membership of the implementation board generally includes both people with technical knowledge and managers with control of resources and schedules. Membership may vary depending on the complexity, cost, and other characteristics of a change.

---

*About dynamic participants*

Dynamic participants are workflow handlers that automatically assign users to perform different workflow tasks based on the participant types assigned to a change object that has been submitted to workflow. The default participant types include **Analyst**, **ChangeSpecialist1**, and **Requestor**, as well as others. (For more information about participant types, see *Types of participants*.)

A change specialist uses the **Assign Participants** command to assign participants for a change object. Then, when the workflow that is configured for dynamic participants reaches a task and needs to determine who the participants are, the workflow looks at the current assignee for the participant type (for example, **Reviewer** for a **Review** task) and sends it to that user’s inbox. If the user assigned to a participant type changes after the workflow starts, the workflow automatically recognizes the new user for any tasks that have not started.
If a workflow is not set up to have dynamic participants, the participants are determined explicitly by selecting users. Those participants are fixed and cannot change.

**Caution** A user is assigned as a participant with a specific group and role. The user’s session context must be set to the same group and role they are assigned as to satisfy any Change Manager conditions that are applied.

**Note** You can set the participants using the Integration Toolkit (ITK). For more information, see *Setting participants programmatically using ITK*. 
Assign participants

Note

• To use the Assign Participants command to assign review members based on their roles, a workflow must be configured to use dynamic participants.

See your workflow administrator for information about how your company’s change management workflows are configured or for information about designing a workflow with dynamic participants, see the Business Modeler IDE Guide.

• You must have permission to assign participants.

1. Select the change object that you want to assign participants to.

2. Choose Tools→Assign Participants.

3. In the Assign Participants dialog box, select the participant type (for example, Change Specialist I).

4. Click either the Organization or Project Teams tab and select a user to assign to the participant type.

   You can search for a group, role, or user in the box below the tabs.

   Use Resource Pool Options to assign a set of group or role members as participants instead of individual users. When a group or role is selected, additional options become available.

   • If you select a group, you can click Any Member so any member of the group can be the participant for that type.

   • If you select Proposed Reviewers, Change Review Board, or Change Implementation Board, and then select a group, you can click All Members to assign all members of the group.

   • If you select a role under a group, you can click Any Member and choose Specific Group to assign any member of the combined group and role as the participant type or choose Any Group to assign any member of any group and the selected role as the participant type.

5. To remove a user as a participant, select the user under the participant type and click Remove.

6. To change a participant, select the user under the participant type, select the new user in the Organization or Project Teams tab, and click Modify.

7. Click Add.

8. When you are finished assigning participants, click OK.
About setting change states

To set change states of a change, use the EPM-set-property workflow handler on your workflow process. (For more information about change states, see What are change states?.)

For example, if you want to change the value of the Disposition property to Approved, set the handler to the following on the appropriate task in your workflow process:

```
EPM-set-property -props=CMDisposition -values=Approved
  -to_att_type=TARGET -bypass
```

**Note** You must use the -bypass argument to change the property value.

The EPM-set-property handler requires a list of explicit classes as explained below for each of the change objects.

<table>
<thead>
<tr>
<th>For the change object</th>
<th>The class is</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem reports</td>
<td>-include_types=ProblemReportRevision</td>
</tr>
<tr>
<td>Change requests</td>
<td>-include_types=ChangeRequestRevision</td>
</tr>
<tr>
<td>Change notices</td>
<td>-include_types=ChangeNoticeRevision</td>
</tr>
</tbody>
</table>

For more information, see About managing the change process through a workflow and the Workflow Designer Guide.

About setting change effectivities

Revision effectivities specify the actual timing of when an enterprise change notice (ECN) takes effect. Effectivities state the implementation point for the change in the product structure, and they can be stated in a variety of ways. The product structure can be configured for a particular date or unit (serial) number by applying a revision rule.

For more information about revision effectivities, see Getting Started with Product Structure.

<table>
<thead>
<tr>
<th>Effectivity type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Specifies the range of dates for which the results of a change take effect. You can assign a date effectivity to an ECN.</td>
</tr>
<tr>
<td>Unit</td>
<td>Specifies the range of item units or serial numbers for which the results of a change take effect. You can assign a unit effectivity to an ECN.</td>
</tr>
</tbody>
</table>
Effectivities can only be applied to an ECN after it is reviewed and approved, but before it has been implemented. The ECN revision must have a release status added to it.

- The change notice must have a release status.
- The change notice **Disposition** state must be set to **Approved**.
- The change notice **Maturity** state must be set to **Reviewing**.

The effectivity must be applied manually to the **Solution Items** assemblies so the product structure can be configured using effectivity. The effectivity is not automatically propagated from the ECN.

**Assign effectivity**

1. Select the change notice revision that you want to assign an effectivity to. To set an effectivity, the change notice must have the following:
   - You must be assigned as a change specialist for the change notice.
   - The change notice revision must have a release status.
   - The change notice **Disposition** state must be set to **Approved**.
   - The change notice **Maturity** state must be set to **Reviewing**.

2. Click the **Change Effectivity** pane.

3. Click **Create**.

4. Click **Units** or **Dates** effectivity, as appropriate, and define the range.

   If defining a unit effectivity range, type the desired effectivity range in the **Units** box. Use the - character within a continuous range and the , character to separate discontinuous ranges. For example, the unit range 1-5,7-9 defines effectivity for units 1 through 5 and 7 through 9 (but not effective for unit 6).

   If defining a date effectivity range, select a date from the calendar (and optionally enter a time), and click **Set Date** to place that date in the **From Date** cell. Select another date (and optionally enter a time), and click **Set Date** to place that date in the **To Date** cell. Repeat these steps for additional date ranges until you enter all the desired date ranges. Click the **Clear Date** button to remove a date from the currently selected cell.

   - Click the **UP** button to add the **and up** (open-ended effectivity) condition to the end of the unit or date effectivity range.

   - Click the **SO** button to add the **stock out** condition to the end of the unit or date effectivity range.

   - If you use effectivity mapping, select the **Shared Effectivity** check box.

   - Select the **Apply Access Manager effectivity protection** check box to apply the predefined Access Manager rules to this effectivity.
Chapter 6  Managing a change

**Note**  Teamcenter interprets **UP** and **SO** conditions as open-ended for revision configuration purposes. The revision is considered effective for any value greater than or equal to the unit or date value immediately preceding the **UP** or **SO**. **Stock out** indicates that existing stocks of a component revision should be used up before the next revision.

5. For unit effectivity, define an end item to qualify the effectivity range. You must use this with the unit effectivity range to specify a product, module, or subsystem that carries the unit number to which this effectivity refers. You can select an end item in one of the following ways:

   - Click **Open by Name** adjacent to the **End Item** box and search for an item by identifier and/or name.
   - Copy an item to the clipboard and click **Paste** adjacent to the **End Item** box.
   - Click **MRU** adjacent to the **End Item** box.

**Note**  If you want to remove the entered end item, click **Clear** adjacent to the **End Item** box.

Once you select the end item, select the revision from the list to the right of the **Clear** button.

6. When you are finished, click **OK**.
Chapter

7 Administering the change management process

About administering the change management process ....................... 7-1
Migrating to Change Manager ....................................................... 7-1
Setting Change Manager preferences ............................................. 7-2
Setting up users ........................................................................... 7-2
  About setting up users ................................................................. 7-2
  Setting participants programmatically using ITK ............................ 7-4
  Configure a group to create change requests and change notices .... 7-4
Defining custom change management objects ................................. 7-5
Configuring conditions to control the actions of participants .......... 7-6
  About configuring conditions to control the actions of participants 7-6
  Examples of Change Manager conditions .................................... 7-6
  Summary of default Change Manager conditions ......................... 7-9
  Listing of Change Manager conditions ........................................ 7-10
Managing the change process through a workflow ....................... 7-13
  About managing the change process through a workflow ............... 7-13
  Problem report workflow example .............................................. 7-14
  Enterprise change request workflow example ............................... 7-18
  Enterprise change notice fast track workflow example .................. 7-23
  Managing change management folders through a workflow .......... 7-28
Chapter

7 Administering the change management process

About administering the change management process

Because change management processes differ from company to company, you can configure and customize Change Manager to meet your business needs and help you follow your documented process.

- Set Change Manager options.
- Set up groups and roles for users to be involved in the change process.
- (Optional) Define custom change management objects.
- Configure conditions to control the actions of participants.
- Create workflows for the change process.

Migrating to Change Manager

If you used Change Viewer in the past, when you upgrade to the latest version of Teamcenter, existing Change Viewer classic change objects are not upgraded; in other words, their database storage is not changed. You will need to create a Change Manager object and link the Change Viewer classic object to it.

Existing Change Viewer classic objects are likely moving through an active workflow. You cannot migrate these objects without disrupting the workflow. You must determine which milestones are important to check and accommodate in the workflow if you want to start a Change Manager object at the point in the workflow where the corresponding Change Viewer classic object stopped. If you have Change Viewer classic objects, you must develop a process and ensure workflow contributors are aware of the migration to Change Manager.

Therefore, we recommend that you:

1. At a given milestone, create a Change Manager object and link the Change Viewer classic object using the Reference Items folder.

2. Either allow the Change Viewer classic object to continue through its workflow or terminate the current workflow and start a new workflow for the Change Manager object. You can add conditional evaluations in the workflow to forward the new change object to the correct step in the workflow process.

3. Create all new change objects using Change Manager.
Setting Change Manager preferences

You can set the following Change Manager preferences:

- To view Change Manager, set *HiddenPerspectives* (make sure Change Manager is removed from the list of hidden perspectives and *CMViewerClassic* is in the list (hidden).

- To enable the Change Manager menu commands in the thin client, set the *WEB_Enable_Create_Change* preference to *true*.

- The Teamcenter change management process does not support displaying substitutes on separate BOM lines in Structure Manager. Turn off the substitutes display (set *PSEShowSubstitutesPref* to 0) when working with change-management related features.

- In addition, see the Change Manager preferences in the *Preferences and Environment Variables Reference*.

Setting up users

About setting up users

You will want to set up rules to restrict change management actions to authorized users. For example, you may want to define rules to limit the creation of enterprise change requests (ECR) and enterprise change notices (ECN) to change specialists who are members of the *Change Management* group.

- Use the Organization application to define groups and roles and associate the roles with the participant types. A typical approach is to create a change management group to contain the change specialists.

- Use the Business Modeler IDE to define the conditions that drive access rules used to manage object permissions. In the example shown here, the business rule for creating ECRs is limited to those who are members of the *Change Management* group:

  ```
  isChangeRequestCreatable
  OR u.group_name = "Change Management"
  ```

It is recommended that you create the roles with a similar name to the participant types to avoid confusion. For example, create the *Change Specialist* role to match the *ChangeSpecialist1* participant type. If you want to use different change specialists, create roles, such as *Change Specialist 1*, *Change Specialist 2*, and so on.

Change analysts can be selected from anywhere in the organization, but it might be useful to identify those users who can perform the technical input for changes in an *Analyst* role. A sample of a typical organization tree is shown in the figure.
Example of configuring groups to create change requests and change notices.

For more information about defining groups and roles, see the Organization Guide.

For more information about defining access rules, see the Access Manager Guide and Security Administration Guide.

**Note**

Users need a Teamcenter Change Management license level that enables authoring to use all Change Manager functionality. If they do not have a higher level license, they are limited to the following functionality:

- Creating a problem report (PR).
- Checking in a PR and submitting it to a workflow process.
- Adding business items to the PR Problem Items and Reference Items folders.
- Searching for and viewing change objects: PRs, enterprise change requests (ECRs), enterprise change notices (ECNs), and deviation requests (DRs).
- Receiving and acting on workflow assignments and tasks.
Chapter 7  Administering the change management process

Setting participants programmatically using ITK

You can set the participants of a workflow using the Integration Toolkit (ITK). The following example shows how you can set participants using the ITK.

```c
TCTYPE_find_type("ChangeSpecialist1", "ChangeSpecialist1", &participant_type);
EPM_create_participant(group_member, participant_type, participant_tag);
GRM_find_relation_type("HasParticipant", &relation_type);
GRM_create_relation(cn_rev_tag, participant_tag, relation_type, NULLTAG, &relation);
GRM_save_relation(relation);
```

**Note**  For more information about using the ITK, see the *Integration Toolkit Function Reference*.

The *Integration Toolkit Function Reference* is available only in the Teamcenter HTML Help Collection. It is not available in the PDF collection.

Configure a group to create change requests and change notices

1. In Organization, create a group that contains users who work with change objects and add those users to the group. For example, create the Change Management group.
   
   For more information about creating groups and adding users, see the *Organization Guide*.

2. Open the Business Modeler IDE.

3. Access the Advanced perspective by choosing Window→Open Perspective→Other→Advanced.

4. In the Extensions view, select the project in which you want to create the condition. Right-click the project and choose Organize→Set active extension file. Select the file where you want to save the data model changes.

5. Expand the project and the Rules→Conditions folders.

6. Double-click the isChangeRequestCreatable condition.

7. In the Expression box, type the following after the existing text:

   ```c
   OR u.group_name = "new-group"
   ```

   If you use the example group from step 1, type the following:

   ```c
   OR u.group_name = "Change Management"
   ```

8. Double-click the isChangeNoticeCreatable condition.

9. In the Expression box, type the following after the existing text:

   ```c
   OR u.group_name = "new-group"
   ```

   If you use the example group from step 1, type the following:

   ```c
   OR u.group_name = "Change Management"
   ```
10. To save the changes to the data model, choose File→Save Data Model, or click the Save Data Model button on the main toolbar.

11. Deploy the data model to the database.

   Users in the Change Management group can create change requests and change notices.

For more information about using the Business Modeler IDE to set these conditions, see the Business Modeler IDE Guide.

### Defining custom change management objects

Use the Business Modeler IDE to create custom change management objects representing the change objects for your change process. The custom objects you create are templates of the different change processes to be used at your site. End users create instances of these change objects, such as change requests, and use them in their workflow processes. Also, to enable users in the change process to create the custom business objects, make new conditions allowing the creation.

List of standard change management business objects.

For more information, see the Business Modeler IDE Guide.

In addition to creating the custom change management objects, you can also:

- Configure Change Manager pseudofolders in which to store objects related to the created objects and which automatically appear when a user creates an object of that type.
  - For information about custom pseudofolders, see the My Teamcenter Guide.
  - For information about defining a relationship, see the Business Modeler IDE Guide.

- Create new forms as needed in which to hold custom information about the change management object.
  - For more information, see the Business Modeler IDE Guide.

- Add properties, such as change type, to existing change management objects.
  - If you want to add persistent properties to change objects, you can extend business classes directly using the Business Modeler IDE. You can also create a dialog box definition by specifying the required and optional properties for an instance creation. Subclasses that do not have their own dialog box definition inherit the dialog box definition of their parent class. To display new properties, you must add them to the style sheets defined for the change object.
  - For more information, see the Business Modeler IDE Guide.

**Note** Before working with Change Manager objects, you must install the Change Management template (cm_template.xml file) to your project. During installation, select Change Management in the Business Modeler IDE Templates panel in Teamcenter Environment Manager.

For instructions about how to add a template to your project, see the Business Modeler IDE Guide.
Configuring conditions to control the actions of participants

About configuring conditions to control the actions of participants

Use the Business Modeler IDE to configure Change Manager to fit your business process by setting specific conditions or rules. They control which participants can perform specified actions under certain Maturity, Disposition, and Closure change states.

Conditions generally apply to all types of change objects (PRs, ECRs, and ECNs).

- **Summary of default Change Manager conditions**
- **Examples of Change Manager conditions.**
- **Working with conditions when adding a custom naming rule to standard Change Manager objects.**
- **List of Change Manager conditions.**

For more information about configuring Change Manager conditions, see the Business Modeler IDE Guide.

Examples of Change Manager conditions

- **Restrict who can add item revisions to the Solution Items folder and when**
- **Restrict who can add item revisions to the Problem Items folder and when**
- **Restrict who can assign the analyst and when**

Restrict who can add item revisions to the Solution Items folder and when

Use the following condition to allow only an analyst to add item revisions to the Solutions Items folder when the following states are met:

- **Closure is Open**
- **Disposition is Approved**
- **Maturity is Executing**

\[
\text{isCMHasSolutionItemCreatableForPrimary} \left( \text{ChangeItemRevision } o, \text{ UserSession } u \right)
\]

Then, define the following expression:

\[
(\text{Condition::isAnalyst} \left( o, u \right) \ \text{AND} \ o.\text{CMClosure} = \text{"Open"} \\
\text{AND} \ o.\text{CMDisposition} = \text{"Approved"} \ \text{AND} \ o.\text{CMMaturity} = \text{"Executing"} )
\]

If this condition is not met, the analyst cannot add the solution item and an error message appears.

Restrict who can add item revisions to the Problem Items folder and when

Use the following condition to restrict when a requestor or analyst can add item revisions to the Problem Items folder. It sets one combination of required states for the requestor and a different combination for the analyst. Such restrictions
ensure that the requestor can no longer add problem items after completing the elaboration phase and the analyst can no longer add problem items after completing the review phase.

\[\text{isCMHasProblemItemCreatableForPrimary (ChangeItemRevision o, UserSession u)}\]

Then, define the following expression:

\[(\text{Condition::isRequestor(o, u) AND o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating"}) \text{ OR } (\text{Condition::isAnalyst(o, u) AND ((o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating") OR (o.CMClosure = "Open" AND o.CMDisposition = "Investigate" AND o.CMMaturity = "Reviewing")))}\]

The expression does the following:

- First, it sets the restrictions for when the requestor (isRequestor) can add item revisions:

\[(\text{Condition::isRequestor(o, u) AND o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating"})\]

It only allows the requestor to add items revisions to the Problem Items when:

- Closure is Open (o.CMClosure = "Open")
- Disposition is None (o.CMDisposition = "None")
- Maturity is Elaborating (o.CMMaturity = "Elaborating")

- Next, it sets the same restrictions for the analyst (isAnalyst):

\[\text{Condition::isAnalyst(o, u) AND ((o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating"}) \]

- Closure is Open (o.CMClosure = "Open")
- Disposition is None (o.CMDisposition = "None")
- Maturity is Elaborating (o.CMMaturity = "Elaborating")

- Then, it sets a second case for when the analyst can add item revisions:

\[\text{OR ( o.CMClosure = "Open" AND o.CMDisposition = "Investigate" AND o.CMMaturity = "Reviewing"))}\]

The second case allows the analyst to add item revisions to the Problem Items folder when:

- Closure is Open (o.CMClosure = "Open")
- Disposition is Investigate (o.CMDisposition = "Investigate")
- Maturity is Reviewing (o.CMMaturity = "Reviewing")
Restrict who can assign the analyst and when

Use the following condition to set that either the analyst or the change specialist can assign or reassign the analyst and when.

\[ \text{isAnalystAssignable ( ChangeItemRevision o, UserSession u) } \]

Then, define the following expression, so both the analyst and change specialist can assign the analyst during the elaboration phase, but only the analyst can assign (that is, reassign) the analyst during the review phase:

\[(\text{u.user_id} = \text{o.change_analyst_user_id}) \]
\[\text{AND (o.CMClosure = "Open" AND o.CMDisposition = "None"}
\[\text{AND o.CMMaturity = "Elaborating")}
\[\text{OR (o.CMClosure = "Open" AND o.CMDisposition = "Investigate"}
\[\text{AND o.CMMaturity = "Reviewing")})}
\[\text{OR (u.user_id = o.change_specialist1_user_id) }
\[\text{AND (o.CMClosure = "Open" AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating")})\]

The expression does the following:

- First, it checks if the user logged into the session is the analyst assigned to the change object:

\[(\text{u.user_id} = \text{o.change_analyst_user_id}) \]

If the user is the analyst, it sets when that user can reassign the change object:

\[(\text{o.CMClosure = "Open" AND o.CMDisposition = "None"}
\[\text{AND o.CMMaturity = "Elaborating")}
\[\text{OR (o.CMClosure = "Open" AND o.CMDisposition = "Investigate"}
\[\text{AND o.CMMaturity = "Reviewing")})\]

The change states for when the analyst can reassign the change object are:

- **Closure** is Open (o.CMClosure = "Open")
- **Disposition** is None (o.CMDisposition = "None")
- **Maturity** is Elaborating ((o.CMMaturity = "Elaborating")

And:

- **Closure** is Open (o.CMClosure = "Open")
- **Disposition** is Investigate (o.CMDisposition = "Investigate"
- **Maturity** is Reviewing (o.CMMaturity = "Reviewing")

- If the user is not the analyst but the change specialist:

\[(\text{u.user_id} = \text{o.change_specialist1_user_id}) \]

If the user is the change specialist, it sets when that user can assign or reassign the change object:

\[\text{AND (o.CMClosure = "Open"}
\[\text{AND o.CMDisposition = "None" AND o.CMMaturity = "Elaborating")})\]
o Closure is Open (o.CMClosure = "Open")

o Disposition is None (o.CMDiPosition = "None")

o Maturity is Elaborating (o.CMMaturity = "Elaborating")

Summary of default Change Manager conditions

The default rules generally apply to all types of change objects: problem report, enterprise change request (ECR), and enterprise change notice (ECN):

• To add item revisions to the Problem Items folder:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td>Analyst</td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Open/Investigate/Reviewing</td>
</tr>
</tbody>
</table>

• To add any object to the Referenced Items folder:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor</td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td>Analyst</td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Open/Investigate/Reviewing</td>
</tr>
</tbody>
</table>

• To add item revisions to the Impacted Items folder:

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/None/Elaborating</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Open/Investigate/Reviewing</td>
</tr>
</tbody>
</table>

• To add item revisions to the Solution Items folder (applies to ECN only):

<table>
<thead>
<tr>
<th>Assigned participant</th>
<th>Closure/Disposition/Maturity property settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst</td>
<td>Open/Approved/Executing</td>
</tr>
</tbody>
</table>

• To add a schedule to the Plan Items folder (applies to ECR or ECN only):
## Administering the change management process

### Assigned participant | Closure/Disposition/Maturity property settings
---|---
Analyst | None/Elaborating (default)/Reviewing or None/Investigate/Reviewing

- To propagate a change item to a schedule task folder:

### Assigned participant | Closure/Disposition/Maturity property settings
---|---
Analyst or Task owner | None/Elaborating (default)/Reviewing or None/Investigate/Reviewing

### Listing of Change Manager conditions

Change Manager conditions control different aspects of the change process. For example, each change management business object has a corresponding condition that makes it creatable.

The following conditions are installed with Change Manager. They are listed by the objects they control.

- **Controlling schedules**
  - For more information about using the conditions that end in `ForTask`, see *Configuring who can propagate change items to schedules.*
  - Cm0isCMHasWorkBreakdownCreatable

- Cm0isCMHasWorkBreakdownCreatableForSecondary
- Cm0isCMHasImpactedItemCreatableForTask
- Cm0isCMHasProblemItemCreatableForTask
- Cm0isCMHasSolutionItemCreatableForTask
- Cm0isCMReferencesCreatableForTask
- isCMHasWorkBreakdownCreatable
- isCMHasWorkBreakdownCreatableForPrimary
- isCMHasWorkBreakdownCreatableForSecondary

### Controlling participant assignment

- isAnalystAssignable
See example.

- isRequestorAssignable
- isChangeImplementationBoardAssignable
- isChangeReviewBoardAssignable
- isChangeSpecialist1Assignable
- isChangeSpecialist2Assignable
- isChangeSpecialist3Assignable

**Checking users**

- isAnalyst
- isAuthor
- isChangeSpecialist1
- isChangeSpecialist2
- isChangeSpecialist3
- isRequestor

**Controlling impacted item creation**

- Cm0isCMHasImpactedItemCreatable
- Cm0isCMHasImpactedItemCreatableForSecondary
- isCMHasImpactedItemCreatable
- isCMHasImpactedItemCreatableForPrimary
- isCMHasImpactedItemCreatableForSecondary
- isCMHasImpactedItemCreatableForTask
- isImpactedItemRevisableForChange
- isImpactedItemRevisableForTask

**Controlling problem item creation**

- Cm0isCMHasProblemItemCreatable
- Cm0isCMHasProblemItemCreatableForSecondary
- isCMHasProblemItemCreatable
- isCMHasProblemItemCreatableForPrimary
  
  See example.
• isCMHasProblemItemCreatableForSecondary
• isCMHasProblemItemCreatableForTask

Controlling solution item creation
• Cm0isCMHasSolutionItemCreatable
• Cm0isCMHasSolutionItemCreatableForSecondary
• isCMHasSolutionItemCreatable
  See example.
• isCMHasSolutionItemCreatableForPrimary
• isCMHasSolutionItemCreatableForSecondary
• isCMHasSolutionItemCreatableForTask
• isChangeExecutionAllowed

Controlling implements items creation
• isCMImplementsCreatable
• isCMImplementsCreatableForPrimary
• isCMImplementsCreatableForPrimary

Controlling references creation
• isCMReferencesCreatable
• isCMReferencesCreatableForPrimary
• isCMReferencesCreatableForSecondary
• isCMReferencesCreatableForTask

Controlling creation of change objects
• isChangeNoticeCreatable
• isChangeRequestCreatable
• isCm0DevRqstCreatable
• isProblemReportCreatable

Controlling effectiveness and rollup
• isEffectivityCreatableForChange
• isRollUpCommittable

Checking item revision
• isActiveSequence
Setting incorporation status

- Cm0isCm0IncorporatesCreatable
- Cm0isCm0IncorporatesCreatableForPrimary
- Cm0isCm0IncorporatesCreatableForSecondary
- Cm0isIncorporationStatusEditable

Managing the change process through a workflow

About managing the change process through a workflow

Workflows guide a change through the different phases of a change process: authoring, review and approval, execution, and closure. These phases are modeled as states of the change. For example, a workflow process moves the Disposition attribute of a change from Investigate to Approve. (Change states cannot be manually updated.) Using Change Manager with Workflow Designer, therefore, tracks the evolution of changes through your organization according to a controlled, repeatable process. In addition, you can:

- Tie a workflow to a scheduled task so as tasks are worked on and updated in Teamcenter workflow, the information is sent to Schedule Manager where the corresponding information is updated. You can also configure a Teamcenter scheduled task so the associated workflow can be initiated when certain conditions are met.

- Set up a workflow to automatically assign review members from assigned participants by configuring the workflow for dynamic participants.

To do this, you need to use the following workflow action handlers:

- The **EPM-set-property** handler to set the change state properties when they change during the workflow.

- The **EPM-auto-assign** handler to assign the appropriate participant on the change object as the responsible party for the current task.

The following are three examples of workflows for a problem report, enterprise change request, and enterprise change notice:

- **Problem report workflow example**

- **Enterprise change request workflow example**

- **Enterprise change notice fast track workflow example**
Chapter 7  Administering the change management process

Note • For more information about creating your own workflows, see the Workflow Designer Guide.

• For a tutorial that steps you through creating an ECR workflow, see Getting Started with Workflow.

• For more information about setting change states, see About setting change states.

• For information about initiating a workflow from a schedule task, see the Schedule Manager Guide.

• For information about dynamic participants, see About the participants in the change process and the Business Modeler IDE Guide.

Problem report workflow example

The following problem report (PR) workflow steps through the process of verifying that participants are assigned to the workflow, identifying the root cause, and determining if a change is required. If a change is required, an enterprise change request (ECR) is derived from the PR. This process does not define a solution.

The process flow of the example Change Manager workflow process for a PR is:

• Start the workflow and assign participants

• Reproduce the problem

• Analyze the root cause

• Determine the resolution

• Derive ECR and complete
The workflow example is a simplified version of a change. If you were to implement it in Teamcenter, you would want to add more complex functions, such as backward branching.

For more information about backward branching, see Workflow Designer Guide.

The workflow starts with the Is Specialist Assigned verification task, which determines if a change specialist has been assigned, as shown in the next figure. If the change specialist has not been assigned, the workflow sends the Assign Specialist do task to the members of the Change Management group to assign the change specialist. It then verifies that the analyst has been assigned, and if not, sends the Assign Analyst do task to the change specialist to assign the analyst.

A Business Modeler IDE condition specifies that only the change specialist can assign the analyst, so that assignment must be completed first. You can edit the condition to enable other users to assign the analyst, as appropriate for your company’s business requirements. For more information about Business Modeler IDE rules, see About configuring conditions to control the actions of participants.

- Workflow handlers
  - The **EPM-check-object-properties** action handler checks that the value for ChangeSpecialist1 or Analyst is not null values.
  - The **EPM-auto-assign** handler assigns the participants.

For the Assign Change Specialist task, the **EPM-auto-assign** handler sends the Assign Specialist task to a resource pool of members of the Change Management group who hold the Manager role, and who can assign change specialists:

-assignee=resourcepool:Change Management::Manager

For the Assign Analyst task, the **EPM-auto-assign** handler assigns the task automatically to the specialist.

The assigned analyst determines if the problem can be reproduced (Reproduce the Problem condition task) to validate it.
The analyst can choose the following paths, as shown in the figure below:

- **Cannot reproduce the problem**
  
  If the analyst cannot reproduce the problem, the workflow sends the Inform Requestor acknowledge task to the requestor. This task records the requestor's acknowledgement.
  
  The Closure property is set to Cancelled on the Or task that follows the Set PR Cancelled task.

- **Analysis requires more information**
  
  If the analyst requires more information, the requestor is informed (More Info do task). At this point, the requestor can decide there is no problem or that he or she cannot provide the required information. Therefore, the requestor can choose to close the problem report (Set PR Cancelled). Normally, the requestor provides the needed information and the analysis can proceed.

- **Problem can be reproduced**
  
  If the problem can be reproduced, the analyst can choose to request more information or move the request to the next step to analyze the root cause (Analyze Root Cause, Determine Severity do task).

- **Workflow handlers**

  - The EPM-auto-assign handler assigns the tasks automatically to the analyst or requestor.

  - The EPM-set-property handler in the Or task sets the Closure property to Cancelled.

**Analyze the root cause**

At the Analyze Root Cause, Determine Severity do task, the analyst determines what the cause of the problem is. The analyst may add problem and impacted items to the change object folders. The business objects need to be related to the PR as item revisions in the Problem Items folder. If any items are already related as problem items, the relationships can be retained but only if the items truly need to be replaced. The items should be removed if they do not need to be replaced.
Those items that need to be revised to enable the replacement of the problem items (impacted items) are identified during the change request (ECR) process during the where-used search of the impact analysis and are not identified here.

The workflow moves to the next step to determine what the resolution of the problem should be (Determine Resolution condition task).

- **Workflow handlers**
  - The EPM-auto-assign handler assigns the Analyze Root Cause, Determine Severity task automatically to the analyst.

**Determine the resolution**

The change specialist performs the Determine Resolution condition task. The change specialist can decide the following based on the analysis, as shown in the figure:

- **Approve the problem**
  - The change specialist can approve the problem resolution (Resolve). The Resolve task sets the Disposition property to Approved and notifies the requestor and analyst.

- **Send it back for rework**
  - If the change specialist determines more work is required (Investigate), the workflow returns to the Investigate PR task for more research.
  - The task sets the Disposition property to Investigate, allowing the analyst to add items to the change folders (Problem Items and Reference Items) or update the PR properties.

- **Reject it**
  - If the change specialist rejects the PR (Reject), the workflow moves to the Notify PR Rejected task. The requestor and analyst are notified that the PR has been rejected. They do not acknowledge the notification.
  - The following properties are set:
    - The Disposition property is set to Disapproved.
    - The Closure property to Cancelled on the following Or task.

- **Defer it**
  - If the change specialist is undecided and wants to leave the decision for later (Deferred), the workflow moves to the PR Deferred task, which sets the Disposition property to Deferred. Then it branches back to the Determine Resolution task so it remains in the change specialist’s inbox as a reminder.
  - It also notifies the requestor and analyst that the PR is deferred.
• **Workflow handlers**
  
The **EPM-auto-assign** handler automatically assigns the tasks to the required participants.

• **EPM-set-property** sets the states noted in the task descriptions.

**Derive ECR and complete**

If the change specialist resolves the problem report, a change request is derived from the PR (**DeriveCR**).

At the beginning of this task, the **Maturity** property is set to **Reviewing**, which is required for the CR to be derived. The following Business Modeler IDE rule controls this:

```
isCMImplementsCreatableForSecondary (ChangeItemRevision o, UserSession u)
o.CMClosure = "Open" AND o.CMDisposition = "Approved" AND o.CMMaturity = "Reviewing"
```

After the ECR has been derived and starts its processing, the **Maturity** property is set to **Executing** to indicate to observers that the PR is being resolved.

• **Workflow handlers**
  
The **EPM-auto-assign** handler automatically assigns the task to the change specialist.

• **EPM-set-property** sets the states noted in the task descriptions.

**Enterprise change request workflow example**

**Note**

• For a tutorial that steps you through creating a simple enterprise engineering request (ECR) workflow, see *Getting Started with Workflow*.

• The workflow example is a simplified version of a change. If you were to implement it in Teamcenter, you would want to add more complex functions, such as backward branching.

For more information about backward branching, see *Workflow Designer Guide*.

The following ECR workflow steps through the process of verifying that participants are assigned to the workflow, identifying the impacted items, and generating and
recommending a solution. The ECR can follow either a fast or standard track. You can set a cost or other criteria threshold separately to determine which track the ECR follows.

- If the change falls below the set threshold, the change follows a fast track.
  Changes that follow a fast track are those with limited cost, typically requiring only revision changes, with no interchangeability issues, and requiring little review. The abbreviated ECR process is followed by an abbreviated ECN process to implement the change, which no change implementation board review. The abbreviated ECR process is followed by an abbreviated ECN process to implement the change with no change implementation board review.

- If the change exceeds the set threshold, the change follows a standard track and is reviewed by the change review board.
  Changes that follow a standard track use both a full ECR process with a review by the change review board and a full ECN process with review by the change implementation board. The change also requires an implementation plan.

An ECN is always derived to implement a solution, even for an ECR that went through a fast track process. However, the workflow for the fast track ECN is very short, with a minimal number of steps, as shown in this example. It is necessary to create an ECN so the analyst can add solution items, which is not possible in the ECR, whose purpose is only to define a proposed solution. For example, a Solution Items folder is not even associated with an ECR.

**Note** It is technically feasible to configure an ECR to display the Solution Items folder and, therefore, use it to implement a solution. However, this exposes the Solution Items folder for all ECRs, which would not be applicable to standard track changes and would confuse users.

If after the workflow ends, an ECR is approved, a new or existing change notice (ECN) is derived.

The process flow of the Change Manager example workflow process for an ECR is:

- **Start the workflow and assign participants**
- **Identify impacted items, propose a solution, and estimate costs**
- **Determine if the planning is complete and which track to follow**
- **Review the solution (standard track)**
• Approve change and derive the change notice (fast and standard track)

**Note** For a complete explanation of the change states an ECR goes through, see *Example of the state changes in a fast track enterprise change request (ECR)* and *Example of the state changes in a standard track enterprise change request (ECR).*

### Start the workflow and assign participants

Participant assignments are *not* carried over from the change object to the derived change. Therefore, the change specialist needs to be assigned for each new change object (either an ECR or ECN). Typically, the change specialist derives or creates the ECR or ECN, and so would assign themselves as change specialists. They can do this because they have write access as owners of the object. However, the Business Modeler IDE conditions also must be met (for example, the creator must be in the Change Management group).

The workflow starts by verifying whether this assignment has been completed using the **Is Specialist Assigned** verification task, as shown in the figure. If the change specialist has not been assigned, the workflow sends the **Assign Specialist do task** to the resource pool of members of the Change Management group who hold the Manager role and can assign change specialists.

It then verifies that the analyst and change review board have been assigned (**Is Analyst and CRB Assigned?**), and if not, sends the **Assign Analyst and CRB do task** to the change specialist to assign the analyst and the change review board.

### Workflow handlers

- The **EPM-check-object-properties** action handler checks that the values for **ChangeSpecialist1, Analyst,** or **ChangeReviewBoard** are not null values.

- The **EPM-auto-assign** handler assigns the participants.

  For the **Assign Change Specialist** task, the **EPM-auto-assign** handler sends the **Assign Specialist** task to a resource pool of members of the Change Management group who hold the Manager role, and who can assign change specialists:

  `-assignee=resourcepool:change Management::Manager`

  For the **Assign Analyst and CRB** task, the **EPM-auto-assign** handler assigns the task automatically to the analyst and change review board.
Identify impacted items, propose a solution, and estimate costs

The analyst assigned to the next task (Identify Impacted Items, Propose Solution, Estimate Cost do task) identifies the impacted items and generates and determines a solution. The analyst elaborates the change object by adding related objects to it, including creating markups on documents, Word documents, presentations, and so on.

The analyst determines whether new objects (items) or simply new revisions are required with cost and interchangeability implications. This must be clear to the engineer who later makes the changes. The change review board can amend the solution.

Determine if the planning is complete and which track to follow

Once the analyst determines a solution, the workflow moves to the Planning Complete? condition task, which is assigned to the change specialist who evaluates if the ECR is ready to move forward and on which track (fast or standard).

The task has three possible outcomes or exit paths, as shown in the figure:

- **The plan is not complete**
  
  The change specialist chooses this branch (Plan Not OK) if the analyst needs to add more definition to the solution. The workflow returns to Identify Impacted Items, Propose Solution, Estimate Cost task through the Or task. The analyst performs additional impact or other analyses as required to fully define the proposed solution. The workflow returns the ECR to the change specialist at the Planning Complete? task for another verification.

- **The plan is complete but needs review**
  (Plan OK – Standard Track)

  The change specialist chooses this branch if the planning is complete and now can be reviewed by the change review board. It moves to the CRB Review proposed solution task.

  The ECR’s change states are updated to lock the ECR and its folders against change while it is being reviewed:

  - **Disposition** of None

  - **Maturity** of Reviewing.

  If all members of the change review board do not approve, the workflow moves to the Set Change Review Board Result condition task.

- **The plan is complete and does not need review**

  The change specialist chooses the Plan OK – Fast Track branch if the change meets the fast track criteria and is ready for implementation.

  The workflow moves to the Derive CN, Start CN Fast Track task, where the change specialist derives an ECN from the ECR and initiates the ECN fast track workflow process.

  While an ECR may fit the fast track criteria, it is considered a best practice to follow it with an ECN, especially for new or updated product data. In addition,
at the ECN stage, it may be combined with other changes for implementation. The result may or may not be a fast track ECN.

Review the solution (standard track)

If the change specialist chose a standard track for the change, the solution goes to the Change Review board for approval (CRB Review proposed solution task). The Change Review board can approve the solution, send it back for rework, or reject it, as shown in the figure.

If not allow members of the change review board approve the solution, the workflow moves to the Set Change Review Board Result condition task. The change specialist records the change review board’s desired outcome and sets the path accordingly. This can be done by reviewing the signoff comments, phone or email survey, or convening a meeting with change review board to identify the desired outcome, or other means, as required.

Approve change and derive the change notice (fast and standard track)

For either a fast track or standard track, the change specialist derives an ECN from the ECR and initiates the ECN workflow process. For a standard track, the creation occurs after the Change Review board has approved the ECR (Derive CN). For a fast track, the creation occurs after the change specialist has approved that the ECR follow a fast track (Derive CN, Start CN, Fast Track).

At the beginning of either task, the ECR state is updated so the ECN can be derived:

- **Maturity of Reviewing**
- **Disposition of Approved**.

At the end of the process, the ECR state is updated to indicate to others that the ECR is being implemented: **Maturity of Executing**.
• Workflow handlers

The **EPM-set-property** action handler sets the change request states.

**Enterprise change notice fast track workflow example**

The following example enterprise change notice (ECN) workflow steps through the process of verifying that participants are assigned to the workflow, implementing the change, and verifying its implementation through an audit. When the implementation is complete, the workflow closes the ECNs, associated problem reports (PRs), and enterprise change requests (ECRs).

![Workflow Diagram]

A fast track ECN provides a quick, controlled, and auditable change process. An analyst usually performs this when the cost of the change is below a company’s set threshold. Therefore, you should have a preceding ECR process and object whose purpose is to define the cost and the proposed solution, and determine the appropriate processing track.

The analyst typically owns the items requiring change (in CMII terms, the analyst is the creator), and can modify and release them without additional approval (CMII rules for a fast track process).

The change specialist monitors the fast track process and performs the final audit.
The fast track ECN process does not include setting a planned effectivity. If you need to set effectivity, use a standard track process. The actual effectivity is set as-needed at the **Set Status Released** task.

The workflow example is a simplified version of a change. If you were to implement it in Teamcenter, you would want to add more complex functions, such as backward branching.

For more information about backward branching, see *Workflow Designer Guide*.

The process flow for the Change Manager example workflow process for an ECN fast track is:

- Start the workflow and assign participants
- Implement design changes
- Release the design changes and set the status
- Audit the plan
- Set the release status
- Close the change

For a complete explanation of the change states an ECN goes through, see *Example of the state changes in an enterprise change notice*.

The workflow example is a simplified version of a change. If you were to implement it in Teamcenter, you would want to add more complex functions, such as backward branching.

For more information about backward branching, see *Workflow Designer Guide*.

**Start the workflow and assign participants**

Participant assignments are *not* carried over from the change object to the derived change. Therefore, the change specialist needs to be assigned for each new change object (either an ECR or an ECN). Typically, the change specialist derives or creates the ECR or ECN, and therefore, would assign themselves as change specialists. They can do this because they have write access as owners of the object. However, the Business Modeler IDE conditions must also be met (the creator must be in the Change Management group).

The workflow starts by verifying whether this assignment has been completed using the **Is Specialist Assigned** verification task, as shown in the figure. If the change specialist has not been assigned, the workflow sends the **Assign Specialist** do task to the resource pool of members of the Change Management group who hold the Manager role and can assign change specialists.

It then verifies that the analyst has been assigned (**Is Analyst Assigned**?), and if not, sends the **Assign Analyst do task** to the change specialist to assign the analyst.
Workflow handlers

- The **EPM-check-object-properties** action handler checks that the value for `ChangeSpecialist1` or `Analyst` is not a null value.

- The **EPM-auto-assign** handler assigns the participants.

  For the **Assign Change Specialist** task, the **EPM-auto-assign** handler sends the **Assign Specialist** task to a resource pool of members of the Change Management group who hold the Manager role, and who can assign change specialists:

  `assignee=resourcepool:change Management::Manager`

  For the **Assign Analyst** task, the **EPM-auto-assign** handler assigns the task automatically to the analyst.

Implement design changes

The analyst is assigned the **Execute Design Changes** task, and creates solutions items or revises impacted items. The analyst may make the changes or delegate the task.

The analyst can choose the **Unable to Complete** path, which sends the workflow to the **Revise the ECR** task, as shown in the figure. This lets the analyst stop the ECN process if the scope has become larger than expected. In this case, the change returns to the ECR process for reprocessing as standard track. Revising the ECR retains the related items and any work completed to this point, while allowing additional elaboration and definition.
• **Workflow handlers**

  The **EPM-set-status** handler removals any status objects from the ECN that were carried into this task from an earlier loop through this workflow process, or from an earlier workflow process. If this is the first time through this task, this handler has no affect.

  The **EPM-remove-objects** handler removes all workflow attachments that were carried into this task from an earlier loop through this workflow process or from an earlier workflow process, leaving only the ECN. If this is the first time through this task, this handler has no affect.

• The **EPM-auto-assign** handler assigns the task to the analyst.

• The **EPM-set-property** sets the Maturity to Executing and the Disposition to Approved so items can be added to the Solution Items folder.

• The **EPM-set-rule-based-protection** handler is required to enable the analyst to sign off the task, triggering the attachment of the related items. The related items are actually modified by the attachment to the workflow. Therefore, write access is required. It also requires an appropriate ACL.

  After the change has been executed, the solution items and any other items related to the ECN are attached to the workflow task to enable easy management of status objects and effectivity.

• The **EPM-attach-related-objects** handler attaches related objects to the ECN in the Complete action portion of the task. For example:

  - `relation=IMAN_specification`
  - `attachment=target`

  Or
-relation CMHasSolutionItem
-attachment target

Therefore, when the status is applied in the next task (Audit Change), it is added to the solution items.

**Note** The same status object is shared with the ECN and all of its resulting items. This means any effectivity added to the status object applies to all of the resulting items equally. In addition, if the status object is changed or deleted, all of the resulting items are affected equally, as shown in the figure.

Therefore, all the solution items share the same status and effectivity, and are implemented at the same point. Also, any updates to the effectivity on the ECN automatically apply to all the solution items.

**Release the design changes and set the status**

After the execution of the plan is complete, the workflow moves to the **Release design changes, set status pre-released** task, which is assigned to the analyst. The analyst checks the implementation.

**Workflow handlers**

- The task is auto-assigned to the analyst at the select-signoff-team sub-task. It uses the EPM-adhoc-signoffs handler because no profile is wanted so the assigned analyst can come from any group or role.

  If you would like more control, use the EPM-fill-in-reviewers handler to create the appropriate group or role profile to ensure the assigned analyst meets the required qualification.

- The **EPM-set-status** handler is used with the -action=replace argument to attach the status object currently attached to the workflow to all target items. If the target item (for example, the ECN) already has the status object, it is updated. If the target item does not have a status object, it is attached.
Audit the plan

The Audit plan task is assigned to the change specialist. The specialist checks to ensure that the change should have been solved through a fast track process. This is in addition to the safety checks against the inappropriate use of the fast track process provided in the ECR process where the change specialist validates the criteria before the change review board review, and when the change specialist derives the fast track ECN from the ECR.

- **Workflow handlers**
  The task is auto-assigned to the change specialist at the select-signoff-team sub-task. It uses the EPM-adhoc-signoffs handler because no profile is wanted so the assigned change specialist can come from any group or role.

  If you would like more control, use the EPM-fill-in-reviewers handler to create the appropriate group or role profile to ensure the assigned change specialist meets the required qualification.

Set the release status

The Set Status release on CN and SI's task is assigned to the change specialist who has the option of setting the effectivity, as well as the status of the ECN and its solution items.

- The EPM-set-status handler renames the existing status from Pre-Released to Released, indicating that the change has been audited and approved.

  rename
  -status=B2PreReleased
  -new_status=B2Released

  **Note** The handlers must use the internal schema names for the release status (for example, XXXReleased), not the display name.

- The EPM-set-status handler can also automatically set the effectivity on the status object using the -set_effectivity argument. It sets the effectivity as an open-ended date effectivity with the start date set to the time of execution. If you use it with the -retain_release_date argument, the original release data of the target object is retained and also used as the start date for the effectivity.

- The EPM-set-property handler sets the Maturity to Complete.

Close the change

At the completion of the workflow, the Close the change task is assigned to the change specialist, who manually closes the implemented ECRs and PRs.

Managing change management folders through a workflow

Folders under change objects (such as enterprise change notices, problem reports, and enterprise change requests) hold items that are related to the objects of that type.

For a listing of the folders and the objects in them, see Relating items to a change and the properties required.
The relation | Does the following
--- | ---
CMHasImpactedItem | Relates the ChangeItem object (such as ProblemReport, ChangeRequest, and ChangeNotice) to impacted item revisions.
CMHasProblemItem | Relates the ChangeItem object (such as ProblemReport, ChangeRequest, and ChangeNotice) to problem item revisions.
CMHasSolutionItem | Provides for the traceability of the deliverable that results from the execution of the product plan by relating ChangeNotice objects to a solution item.
CMHasWorkBreakdown | Provides for work breakdown relations.
CMImplements | Allows ProblemReport objects to be implemented by ChangeRequest objects, and ChangeRequest objects to be implemented by ChangeNotice objects. It is used for navigating change resolutions.
CMReferences | Allows problem reports, change requests, and change notices to reference items and datasets.
 | Relates the ChangeItem object (such as ProblemReport, ChangeRequest and ChangeNotice) to impacted item revisions.

During a workflow process, use the **EPM-attach-related-objects** handler is used to add the items and takes a **-relation** argument.

- **-relation=CMHasSolutionItem**
- **-attachment=target**

See *Enterprise change notice fast track workflow example* for how to add objects to an ECN using **EPM-attach-related-objects**.

For information about defining a relationship, see the *Business Modeler IDE Guide*. 
Appendix

A  Glossary
Appendix

A Glossary

A

analyst
Issue Manager user who assesses the technical feasibility of an issue or the technical feasibility of implementing the low-level details of an issue. An analyst also participates in the execution of an issue by carrying out the tasks identified in the implementation plan for the issue.

B

Business Modeler IDE
Teamcenter application that enables a customer to define data model objects such as business objects, classes, attributes, lists of values, and rules.

C

cchange
Process that controls changes to items and determines when those changes are implemented.

cchange administration
Process of managing change objects as they move through the appropriate processes. The significant activities associated with change administration occur after the authoring phase. In the administration phase, an administrator coordinates the activities involved with executing and closing a change and manages the change through its closure.

Change Implementation Board
Group of users who review, approve, and authorize a change in the implementation stage. For a standard track change, this board is assigned to a change notice.

change initiation
Creation of change objects, identification of the impacted items, and submission of these items to the life cycle.

Change Manager
Teamcenter application used to track changes to a product throughout its life cycle. The user proposes a change to a product and then manages the entire cycle of review, approval, and implementation of the change. The user can articulate the work required to implement a change, assess its impact on any managed business items, and notify life cycle participants about proposed and authorized changes. Before and after product configurations can also be compared.
change objects
Problem reports (PRs), enterprise change requests (ECRs), and enterprise change notices (ECNs) that address problems or enhancements.

change phase
In the change process, the change initiation, change administration, and change execution are key phases that can be identified in a change management system.

change planning
Portion of the change process when the change request is being created, defined, and elaborated. All planning and authoring takes place prior to an approval decision by a Change Review Board (CRB) or empowered user, or after a CRB decision that requires investigation.

Change Review Board (CRB)
Group of users who review and authorize a change in the proposal (planning) stage. A review board provides a checkpoint for determining whether a change should proceed. In a standard track change, a CRB is assigned to a change request.

Change Specialist I
(Formerly known as Change Administrator I.) User who manages the processing of problem reports and change requests from their initiation until their final disposition. The Change Specialist I also compiles recurring and nonrecurring cost estimates for more complex change requests, prepares the CRB agenda, and chairs the CRB meeting.

Change Specialist II
(Formerly known as Change Administrator II.) User who receives approved change requests for standard track changes from the CRB and prepares change notices for implementation. The Change Specialist II also provides change notice numbers for fast track changes approved by individual analysts for implementation and sorts approved change requests into similar groups on the basis of their impact matrix.

Change Specialist III
(Formerly known as Change Administrator III.) User who audits change notice packages to assure continuity between superseded and superseding information. The Change Specialist III also verifies that each document has been validated by its assigned analyst and one or more designated users; releases documents, data, and revision records that conform to the change notice requirements; and is responsible for compiling metrics of audit findings and initiating corrective action to reduce those findings.

Change Viewer
Teamcenter application used to manage the process of controlling changes to a product's definition and configuration. Change Viewer provides an auditable history of the objects used in a process, making an object's uses traceable. A site can use Change Viewer to propose, incorporate, review, and approve changes. Change Viewer can also be used to track and report change history and to notify members of changes to their organization.

Closure
Status of the change object. Change objects have an open status until the change is complete, unless a decision is made to defer or cancel the change. After an approved change is executed, a user authorizes the work and the change is incorporated. The
Closure change state can be one of the following: open, closed, on hold, canceled, and suspended.

condition
Conditional statement that resolves to true or false based on the evaluation of an expression.

D

deviation request
Request that seeks consent to deviate from a solution in production to resolve a set of problems to initiate improvements. Typically, it either requests a deviation or a waiver.

disposition (change management)
Decision about how to proceed with a change object. A disposition may reflect a business implementation or technical decision about a change object (None, Investigate, Approved, Disapproved, Deferred).

dynamic participant
Participant who is automatically assigned to perform workflow tasks based on the participant type, such as Analyst or ChangeSpecialist. Dynamic participants are assigned through workflow handlers.

E
effectivity
Specifies the proposed and actual timing of when a change takes effect. There are two types of change effectivities:

- Unit effectivity specifies the range of item units or serial numbers for which the change takes effect.

- Date effectivity specifies the range of dates for which the change takes effect. This is also known as an incorporation point.

elaboration
Division of a change request into a number of manageable tasks.

enterprise change notice (ECN)
Provides a detailed work plan to resolve one or more enterprise change requests (ECRs) or a portion of one ECR. An ECN identifies all items and documents affected by a change and authorizes the actions that address a change.

enterprise change request (ECR)
Initiates proposals that recommend changes and capture business decisions associated with the change. Change requests state the cost estimates and benefits of a change and provide recommended actions. Change requests are sometimes responses to problem reports.

execution
Process of implementing the change (change request and tasks) once the change is authorized.
Appendix A  Glossary

F

fast track change
Change process in which the user can plan a change, approve it, and begin execution without the review or approval by a separate Change Review Board. Fast track is normally designated for changes that meet prescribed criteria such as low risk or low cost.

G

genealogy
History, or supersedure trail, of a part.

I

impacted item
Item revision to be changed as a result of the change process. It may be a detailed part or an assembly. A release status is attached by the workflow process the change is put through.

implemented by
Change notice that corrects the problem addressed by the change request or the change request that addresses the problem in the problem report. They are stored in the Implemented By folder of the implemented object in Change Manager. For example, the change request’s Implemented By folder contains the change notice.

implements item
Problem report that is addressed by a change request or a change request that is addressed by a change notice. They are stored in the Implements folder of the implementing object in Change Manager. For example, the change notice’s Implements folder contains the change request.

item
Workspace object generally used to represent a product, part, or component. Items can contain other workspace objects including other items and object folders.

item revision
Workspace object generally used to manage revisions to items.

M

maturity state
Defines the degree of completion of the open change object. The states are elaborating, reviewing, executing, and complete.

O

Organization
Teamcenter application that enables a system administrator to create and manage critical Teamcenter files and database entries. It is the point of access for creating a company’s virtual organization and for performing system administration activities such as volume creation, maintenance, and site administration. Organization enables creation and management of person, user, role, and group definitions;
definition of the hierarchical structure of the Teamcenter organization; management of data volumes; and establishment and maintenance of Teamcenter sites.

P

participant (workflow)
Different types of users involved in various phases of the change process, such as requestor, analyst, change specialist, change review board, and change implementation board.

perspective
Container in the rich client user interface for a set of views and editors collected to accomplish specified tasks. See also view.

problem item
Item revision that the impacted item revision is replacing, typically the latest released revision of the impacted item. The problem item is compared with the impacted item to generate the changes (BOM change objects) when the edits to the impacted item are saved. This item is displayed in the Structure Manager right-hand pane to show removed components (highlighted in red).

problem report
Change object that defines a problem or enhancement. One or more problem reports can be the basis for a change request.

pseudofolder
Special container in Teamcenter that stores and displays item and item revision relations in My Teamcenter. See also smart folder.

R

reference item
Teamcenter object that contains information related to the problem report, change request, or change notice. For example, it can be an analysis document or system log. Any Teamcenter object, including a dataset, can be a reference item.

requestor
User who creates a change object or is delegated a change object by another requestor. The requestor is responsible for elaborating the definition of a change.

rich client
Java-based user interface to Teamcenter installed on user workstations. The rich client accesses Teamcenter databases using a remote or local server. Compare to thin client.

S

smart folder
Pseudofolders configured in a hierarchical structure used to apply hierarchical levels of filtering to project data. See also pseudofolder.

solution item
New item revision released with the change that has a release status attached. The item revision may be a new component part which replaces the old component in the parent impacted item. It may also be a new assembly that is being released.
Appendix A  Glossary

standard track change
Fine-grained change process with the ability to support the process for problem reports, change requests, change notices, implementation plans, and tasks. The process also manages the entire cycle of review, approval, and implementation of a change.

state vector
Combination of a change object’s maturity state, disposition (level of approval), and closure status.

status (change management)
Implementation status of a change object. It can be started, in progress, completed, or deferred.

Structure Manager
Teamcenter application that enables creation of generic product structures that can be configured to show the product structure that is in production, effective on a certain date, used by a particular customer, and so forth. Structure Manager enables creation and modification of a product structure and its associated occurrence data, display of a product structure in a multilevel indented format, and viewing graphics tightly coupled to the structure for easy identification of a component by location in the structure or in the embedded viewer.

supersedure
Manually created relation that graphically displays deleted components and the components that replace them. A supersedure is always created in the context of a parent assembly. Therefore, a single component can be used in more than one supersedure if it is used in different parent assemblies. A supersedure can be created for changes of part number or of quantity, but not for changes in a part revision.

T

task
Change object that specifies an action that addresses a change. Tasks are defined in the context of a change request. In a fast track change, there is a single-level hierarchy of tasks.

thin client
Teamcenter user interface that provides a streamlined browser-based view of product information stored in a Teamcenter database. The thin client is configured in the Web tier, which creates and serves its Web pages to the client. Compare to rich client.

U

unincorporated change
Change that has been incorporated into one revision of an item but still must be incorporated into another revision. For example, the change has been incorporated into a supplemental revision (Revision A01) but still must be incorporated into the main revision (Revision B).
V

view
Software element in a rich client user interface perspective. It provides the ability to navigate hierarchies of information, display information about selected objects, open an editor, or display properties. See also perspective.

W

workflow
Automation of the concept that all work flows through one or more business processes to accomplish an objective. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process.

Workflow Designer
Teamcenter application that enables administrators to graphically design workflow process templates, incorporating company business practices and procedures into the templates. Teamcenter users initiate workflow processes using these templates.
# Index

## A

Activities
- Planning ........................................... 5-1
Add Part as Substitute operation
- About .............................................. 4-33
Add Part operation
- About .............................................. 4-33
Analyst ............................................... 1-5
- About .............................................. 6-7
Assigning ............................................ 6-6
Approved state ....................................... 40, 1-5
Assigning
- Effectivity ........................................ 6-13
- Participants ....................................... 6-11
Authorize part replacements during an ECR .......... 4-35

## B

Basic tasks ......................................... 27
BOM change
- Creating ......................................... 4-10
BOM Changes tab ................................... 48
Buttons
- Commit Rollup .................................... 5-7
- Create BOM line item form ..................... 49
- Delete BOM line item form ..................... 49
- Load Item Revision into Supersedure .......... 49
- Manage saved searches ......................... 49, 2-1–2-2
Performs rollup for the current change object ............. 49
Relate Solution Item to Impacted Item ..................... 49
- Rollup ............................................. 5-7

## C

Cancelled state ...................................... 39
Change administrator
- About, see Change specialist
- Assigning, see Change specialist
Change Effectivy tab .................................. 48, 6-13
Change Home view ................................... 47, 2-1–2-2, 5-7
Change implementation board
- About ................................................ 6-7
- Assigning .......................................... 6-6
Change management
- In Teamcenter ................................... 11
- Process ............................................. 29
Change Manager
- About configuring .................................. 7-1
- Basic tasks ........................................ 27
- Conditions ......................................... 7-10
- Defining custom change objects for ............. 7-5
- Enabling ........................................... 8
- Migrating to from Change Viewer ................ 7-1
- Overview of ........................................ 9
- Overview of change objects ...................... 15
- Preferences ........................................ 7-2
- Prerequisites for ................................... 7
- Process ............................................. 29
- Starting ............................................ 8
Change notices, see Enterprise change notices
Change objects
- About managing .................................... 6-1
- Defining custom .................................... 7-5
- Explanations of .................................... 15
- Managing through workflow ....................... 7-13
- Properties of ....................................... 18
- Relationship between .............................. 17
- Types of ........................................... 25
- Ways to create ..................................... 1-1
Change requests, see Enterprise change requests
Change review board
- About .............................................. 6-7
- Assigning .......................................... 6-6
Change specialist
- About .............................................. 6-7
- Assigning .......................................... 6-6
Change states
- Examples of ....................................... 41, 43–44
- Setting .............................................. 6-12
- Types of ........................................... 37
Change Viewer .......................................... 7-1
- Migrating from ..................................... 7-1
Changes
- Classifying ......................................... 6-5
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing</td>
<td>6-1</td>
</tr>
<tr>
<td>Relating items to</td>
<td>4-1</td>
</tr>
<tr>
<td>Reviewing</td>
<td>3-1</td>
</tr>
<tr>
<td>Classifying changes</td>
<td>6-5</td>
</tr>
<tr>
<td>Closed state</td>
<td>39</td>
</tr>
<tr>
<td>Closure change state</td>
<td>37</td>
</tr>
<tr>
<td>Cancelled</td>
<td>39</td>
</tr>
<tr>
<td>Closed</td>
<td>39</td>
</tr>
<tr>
<td>On hold</td>
<td>39</td>
</tr>
<tr>
<td>Open</td>
<td>39, 1-5</td>
</tr>
<tr>
<td>Setting</td>
<td>6-12</td>
</tr>
<tr>
<td>CMII change model</td>
<td>13</td>
</tr>
<tr>
<td>CN, see Enterprise change notices</td>
<td>5-7</td>
</tr>
<tr>
<td>Commit Rollup button</td>
<td></td>
</tr>
<tr>
<td>Complete state</td>
<td>39</td>
</tr>
<tr>
<td>Conditions</td>
<td></td>
</tr>
<tr>
<td>Configuring</td>
<td>7-6</td>
</tr>
<tr>
<td>Examples of</td>
<td>7-6</td>
</tr>
<tr>
<td>Listing of</td>
<td>7-10</td>
</tr>
<tr>
<td>Summary of default</td>
<td>7-9</td>
</tr>
<tr>
<td>Configuring</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td>7-1</td>
</tr>
<tr>
<td>Change Manager</td>
<td>8</td>
</tr>
<tr>
<td>Conditions</td>
<td>7-6</td>
</tr>
<tr>
<td>Replacement of parts with change management</td>
<td>4-49</td>
</tr>
<tr>
<td>CR, see Enterprise change requests</td>
<td>49</td>
</tr>
<tr>
<td>Create BOM line item form button</td>
<td>1-3</td>
</tr>
<tr>
<td>Creating</td>
<td></td>
</tr>
<tr>
<td>Deviation requests</td>
<td>1-3</td>
</tr>
<tr>
<td>Enterprise change notices</td>
<td>1-4</td>
</tr>
<tr>
<td>Enterprise change requests</td>
<td>1-2</td>
</tr>
<tr>
<td>Problem reports</td>
<td>1-2</td>
</tr>
<tr>
<td>Searches</td>
<td>2-1</td>
</tr>
<tr>
<td>Work breakdowns</td>
<td>5-6</td>
</tr>
</tbody>
</table>

**D**

| Date effectivity       | 6-12 |
| Default conditions      | 7-9  |
| Deferred state          | 40   |
| Defining               |       |
| Custom change management objects | 7-5 |
| Delete BOM line item form button | 49 |
| Deleting searches       | 2-2  |
| Details tab             | 48   |
| Deviation requests      |       |
| About                   | 25   |
| Creating                | 1-3  |
| Relationships to other objects | 17 |
| Updating                | 4-9  |
| Disapproved state       | 40   |
| Displaying              |       |
| Searches                | 2-2  |
| Task view               | 5-10 |
| Work breakdowns         | 5-8  |
| Disposition change state| 37   |
| Approved                | 40, 1-5 |
| Deferred                | 40   |
| Disapproved             | 40   |
| Investigate             | 40, 1-5 |
| None                    | 40, 1-5 |
| Setting                 | 6-12 |
| Dynamic participants    |       |
| About                   | 6-9  |

**E**

| ECN, see Enterprise change notices |       |
| ECR, see Enterprise change requests |       |
| Effectivity                       |       |
| About                              | 6-12 |
| Assigning                          | 6-13 |
| In overall process                 | 29   |
| Elaborating                        |       |
| Change objects                      | 4-1  |
| Elaborating state                  | 39, 1-5 |
| Enabling Change Manager            | 8    |
| Enterprise change notices          |       |
| About                              | 25   |
| Configuring group for              | 7-4  |
| Creating                           | 1-4  |
| Example change states              | 44   |
| Example process                    | 34   |
| Example workflow                   | 7-23 |
| Relating items to                  | 4-1  |
| Relationships to other objects     | 17   |
| Rerunning part replacements during | 4-43 |
| Reviewing                          | 3-1  |
| Running part replacements during   | 4-42 |
| Updating                           | 4-9  |
| Ways to create                     | 1-1  |
| Enterprise change requests         |       |
| About                              | 25   |
| Authorizing part replacements      |       |
| during                             | 4-35 |
| Configuring group for              | 7-4  |
| Creating                           | 1-2  |
| Example change states in fast track | 41  |
| Example change states in standard track | 43  |
| Example process                    | 31-32|
| Example workflow                   | 7-18 |
| Managing part replacements         |       |
| during                             | 4-41 |
| Relating items to                  | 4-1  |
| Relationships to other objects     | 17   |
## Index

<table>
<thead>
<tr>
<th>Setting</th>
<th>6-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menus</td>
<td>48</td>
</tr>
<tr>
<td>Migrating to Change Manager</td>
<td>7-1</td>
</tr>
</tbody>
</table>

### N

| None state                  | 40, 1-5 |

### O

<table>
<thead>
<tr>
<th>On hold state</th>
<th>39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Change view</td>
<td>47</td>
</tr>
<tr>
<td>Open state</td>
<td>39, 1-5</td>
</tr>
<tr>
<td>Open Task view</td>
<td>47</td>
</tr>
<tr>
<td>Operations you can perform to replace parts</td>
<td>4-32</td>
</tr>
<tr>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Defining</td>
<td>7-2</td>
</tr>
</tbody>
</table>

### P

| Participants                |      |
|                            |      |
| Analyst                     | 1-5  |
| Assigning                   | 6-6, 6-11 |
| Configuring conditions to control the actions of | 7-6 |
| Dynamic                     | 6-9  |
| Example of assigning in a PR workflow | 7-15 |
| Example of assigning in an ECN workflow | 7-24 |
| Example of assigning in an ECR workflow | 7-20 |
| Requestor                   | 1-5  |
| Setting programmatically    | 7-4  |
| Types of                    | 6-7  |
| Performs rollup for the current change object button | 49 |
| Perspectives                |      |
| In general                  | 50   |
| Planning implementation activities | 5-1 |
| PR, see Problem reports     |      |
| Preferences                 |      |
| Setting Change Manager      | 7-2  |
| Prerequisites for Change Manager | 7  |

### R

<p>| Relate Solution Item to Impacted Item button | 49   |
| Relating items to a change                 | 4-1  |
| Relationship between change objects        | 17   |
| Remove Part and Keep Substitute operation  |      |
| About                                      |      |
| Remove Part and Substitute operation       |      |
| About                                      |      |
| Remove Substitute operation                |      |
| About                                      |      |
| Replace Part and Keep as Substitute operation |      |
| About                                      |      |
| Replace Part operation                     |      |
| About                                      |      |
| Replace Substitute operation               |      |
| About                                      |      |
| Replacing part instances                   |      |
| About                                      | 4-30 |
| Configuring for use with change management | 4-49 |
| During an ECR                              | 4-35 |
| Folders for                                | 4-48 |
| Good practices                             | 4-35 |
| In a single stem                           | 4-44 |
| Managing during an ECR                     | 4-41 |
| Re-running part replacements during ECR    | 4-43 |
| Running part replacements during ECR       | 4-42 |
| Search for part/change object              | 4-40 |
| Setting up where-used search               | 4-49 |
| Suppressing                                | 4-49 |
| Ways                                       |      |
| Replacing part instances in a single step  | 4-44 |
| Requestor                                  | 1-5  |
| About                                      | 6-7  |
| Assigning                                  | 6-6  |
| Re-running part replacements during an ECR | 4-43 |
| Reviewing changes                          | 3-1  |
| About                                      | 3-1  |
| Reviewing state                            | 39, 1-5 |
| Rich client perspectives and views         | 50   |</p>
<table>
<thead>
<tr>
<th>Roll Up view</th>
<th>5-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running ECN</td>
<td>5-7</td>
</tr>
<tr>
<td>Running part replacements during an ECN</td>
<td>4-42</td>
</tr>
<tr>
<td>Running searches</td>
<td>2-2</td>
</tr>
</tbody>
</table>

**S**

<table>
<thead>
<tr>
<th>Schedule Manager</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding items to the Solution Items folder</td>
<td>5-11</td>
</tr>
<tr>
<td>Creating work breakdowns using</td>
<td>5-6</td>
</tr>
<tr>
<td>Displaying Task View</td>
<td>5-6</td>
</tr>
<tr>
<td>Example of work breakdown</td>
<td>5-10</td>
</tr>
<tr>
<td>Rolling up objects in</td>
<td>5-7</td>
</tr>
<tr>
<td>Using with Change Manager</td>
<td>5-1</td>
</tr>
<tr>
<td>Displaying</td>
<td>5-8</td>
</tr>
<tr>
<td>Work Breakdown Schedule Manager view</td>
<td>5-4</td>
</tr>
<tr>
<td>Working with</td>
<td>5-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Schedules</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding items to</td>
<td>5-11</td>
</tr>
<tr>
<td>Creating</td>
<td>5-6</td>
</tr>
<tr>
<td>Displaying</td>
<td>5-8</td>
</tr>
<tr>
<td>Example of work breakdown</td>
<td>5-3</td>
</tr>
<tr>
<td>Rolling up objects in</td>
<td>5-7</td>
</tr>
<tr>
<td>Using with Change Manager</td>
<td>5-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scheduling implementation activities</th>
<th>5-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searches</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td>2-1</td>
</tr>
<tr>
<td>Creating</td>
<td>2-1</td>
</tr>
<tr>
<td>Deleting</td>
<td>2-2</td>
</tr>
<tr>
<td>Displaying</td>
<td>2-2</td>
</tr>
<tr>
<td>Running</td>
<td>2-2</td>
</tr>
<tr>
<td>Showing</td>
<td>2-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Searching</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>For part/change objects during part replacement</td>
<td>4-40</td>
</tr>
<tr>
<td>Setting up where-used for part instance replacement</td>
<td>4-49</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Change states</td>
<td>6-12</td>
</tr>
<tr>
<td>Users</td>
<td>7-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signoff tasks</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delegating</td>
<td>3-2</td>
</tr>
<tr>
<td>Reassigning</td>
<td>3-1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Solution Items folder</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding items to in Schedule Manager</td>
<td>5-11</td>
</tr>
</tbody>
</table>

| Standard track                                                             |     |

| About                                                                      | 6-5 |
| Example process                                                            | 32  |
| Overview                                                                   | 29  |
| Starting Change Manager                                                   | 8   |
| Summary tab                                                                | 48  |
| Supersedeure                                                               |     |
| Creating                                                                   | 4-7 |
| Suppressing the Mass Update command                                       | 4-49|
| System-defined searches                                                   | 2-1 |

<table>
<thead>
<tr>
<th>T</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tabs</td>
<td></td>
</tr>
<tr>
<td>BOM Changes</td>
<td>48</td>
</tr>
<tr>
<td>Change Effectivity</td>
<td>48</td>
</tr>
<tr>
<td>Details</td>
<td>48</td>
</tr>
<tr>
<td>Impact Analysis</td>
<td>48</td>
</tr>
<tr>
<td>Summary</td>
<td>48</td>
</tr>
<tr>
<td>Viewer</td>
<td>48</td>
</tr>
<tr>
<td>Work Breakdown</td>
<td>48</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task view</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying</td>
<td>5-10</td>
</tr>
<tr>
<td>Types of change objects</td>
<td>25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit effectivity</td>
<td>6-12</td>
</tr>
<tr>
<td>Updating</td>
<td></td>
</tr>
<tr>
<td>Change objects</td>
<td>4-9</td>
</tr>
<tr>
<td>User-defined searches</td>
<td>2-1</td>
</tr>
<tr>
<td>Users</td>
<td></td>
</tr>
<tr>
<td>Setting up</td>
<td>7-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer tab</td>
<td>48</td>
</tr>
<tr>
<td>Views</td>
<td></td>
</tr>
<tr>
<td>Change Home</td>
<td>2-1–2-2, 5-7</td>
</tr>
<tr>
<td>Roll Up</td>
<td>5-7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>W</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Where-used search</td>
<td></td>
</tr>
<tr>
<td>Setting up for part replacement</td>
<td>4-49</td>
</tr>
<tr>
<td>Work Breakdown Schedule Manager view</td>
<td>5-4</td>
</tr>
<tr>
<td>Work Breakdown tab</td>
<td>48</td>
</tr>
<tr>
<td>Work breakdowns</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td>5-1</td>
</tr>
<tr>
<td>Creating</td>
<td>5-6</td>
</tr>
<tr>
<td>Displaying</td>
<td>5-8</td>
</tr>
<tr>
<td>Example of</td>
<td>5-3</td>
</tr>
<tr>
<td>Rolling up objects in</td>
<td>5-7</td>
</tr>
</tbody>
</table>
Understanding ................................ 5-1
Workflow
   About managing changes through ... 7-13
   Example of ECN ...................... 7-23
   Example of ECR ...................... 7-18
   Example of PR ....................... 7-14
   review changes ..................... 3-1
Workflow handlers
   EPM-adhoc-signoffs .............. 7-27–7-28
   EPM-attach-related-objects .... 7-26
   EPM-auto-assign ................. 7-15–7-18, 7-20, 7-25–7-26
   EPM-check-object-properties .... 7-15, 7-20, 7-25
   EPM-remove-objects ............. 7-26
   EPM-set-property ................. 6-12, 7-16, 7-18, 7-23, 7-26, 7-28
   EPM-set-rule-based-protection ... 7-26
   EPM-set-status ................. 7-27–7-28
   set-status ......................... 7-26